Intellectual property notices

© 2005–2006 Palm, Inc. Palm, Treo, the Palm and Treo logos, and Palm Powered are among the trademarks or registered trademarks owned by or licensed to Palm, Inc. Microsoft, ActiveSync, Excel, Outlook, PowerPoint, MSN, Windows Mobile, Windows Media, and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. All other brand and product names are or may be trademarks of, and are used to identify products or services of, their respective owners.

This product is protected by one or more of the following United States patents:

6,976,226; 6,975,304; 6,965,375; 6,961,567; 6,961,029; 6,957,397; 6,952,571; 6,950,988; 6,947,975; 6,947,017; 6,943,667; 6,940,490; 6,924,752; 6,907,233; 6,906,701; 6,906,741; 6,901,276; 6,850,780; 6,845,408; 6,842,628; 6,842,335; 6,831,662; 6,819,552; 6,804,699; 6,795,710; 6,788,285; 6,781,824; 6,781,575; 6,766,490; 6,745,047; 6,744,451; 6,738,852; 6,732,105; 6,724,720; 6,721,892; 6,712,638; 6,708,280; 6,697,639; 6,687,839; 6,685,328; 6,665,803; 6,618,044; 6,590,588; 6,539,476; 6,532,148; 6,523,124; 6,519,141; 6,516,202; 6,490,155; 6,480,146; 6,457,134; 6,456,247; 6,442,637; 6,441,824; 6,437,543; 6,429,625; 6,425,087; 6,389,572; 6,388,877; 6,381,650; 6,363,082; 6,344,848; 6,317,085; 6,241,537; 6,222,857; 6,185,423; 6,147,314; 6,115,248; 6,064,342; D421,251; D429,252; D466,128; D478,091. Patent pending.

This product also is licensed under United States patent 6,058,304.

MPEG Layer-3 audio decoding technology is licensed from Fraunhofer IIS and Thomson. http://www.iis.fraunhofer.de/amm/. Palm, Inc. is an authorized licensee of the MultiMediaCard trademark.

All rights reserved.

Disclaimer and limitation of liability

Palm, Inc. and its suppliers assume no responsibility for any damage or loss resulting from the use of this guide. Palm, Inc. and its suppliers assume no responsibility for any loss or claims by third parties that may arise through the use of this software. Palm, Inc. and its suppliers assume no responsibility for any damage or loss caused by deletion of data as a result of malfunction, dead battery, or repairs.

Be sure to make backup copies of all important data on other media to protect against data loss.

End user notice

Microsoft® Voice Command Version 1.5 for Windows Mobile®

IMPORTANT Do not become distracted from driving safely if operating a motor vehicle while using Device Software.

Operating certain parts of this Device requires user attention. Diverting attention away from the road while driving can possibly cause an accident or other serious consequences. Even occasional, short diversions of attention can be dangerous if your attention is diverted away from your driving task at a critical time. Do not change system settings or enter data nonverbally (using your hands) while driving. Stop the vehicle in a safe and legal manner before attempting these operations. This is important since while setting up or changing some functions you might be required to distract your attention away from the road and remove your hands from the wheel.

Microsoft makes no representations, warranties, or other determinations that ANY use of the Software Product is legal, safe, or in any manner recommended or intended while driving or otherwise operating a motor vehicle.

General Operation

Voice Command Control: Many of the functions of the Device Software can be accomplished using only voice commands. Using voice commands while driving allows you to initiate the command with a button and then operate the Device mostly without removing your hands from the wheel.

Prolonged Views of Screen: If you are driving, do not access any function requiring a prolonged view of the screen. Pull over in a safe and legal manner before attempting to access a function of the system requiring prolonged attention. Even occasional short scans to the screen may be hazardous if your attention has been diverted away from your driving task at a critical time.

Volume Setting: Do not raise the volume excessively. Keep the volume at a level where you can still hear outside traffic and
emergency signals while driving. Driving while unable to hear these sounds could cause an accident.

**Let Your Judgment Prevail:** The Device Software is only an aid. Make your driving decisions based on your observations of local conditions and existing traffic regulations. The Device Software is not a substitute for your personal judgment.

**Use of Speech Recognition Functions:** Speech recognition software is inherently a statistical process which is subject to errors. It is your responsibility to monitor the speech recognition functions and address any errors.

PN: 406-10827-00
v. 1.0
# Contents

Welcome .......................................................... 1  
  What’s in the box? ................................................. 1  
  What do I need to get started? ............................... 2

## Chapter 1: Setting up ........................................ 3  
  Treo 700wx smartphone overview ............................... 5  
  Installing the battery ............................................. 7  
  Charging the battery ............................................. 8  
  Making your first call ........................................... 10  
  Setting up synchronization .................................... 12

## Chapter 2: Moving around on your smartphone ........... 13  
  Navigating around the screen ................................ 15  
  Using the keyboard .............................................. 21  
  Opening and closing applications ............................ 25  
  Using your Today screen .................................... 26

## Chapter 3: Your Phone ....................................... 29  
  Turning your smartphone on/off .............................. 31  
  Phone overview .................................................. 32  
  Making calls from the Today screen ......................... 32  
  Other ways of making calls ................................... 36  
  Receiving calls .................................................... 38  
  Using voicemail .................................................. 39  
  What can I do during a call? .................................. 40  
  Defining speed-dial buttons ................................... 45  
  Using a phone headset ......................................... 49
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone settings</td>
<td>51</td>
</tr>
<tr>
<td>What are all those icons?</td>
<td>58</td>
</tr>
<tr>
<td>Chapter 4: Synchronizing information</td>
<td>61</td>
</tr>
<tr>
<td>How do I synchronize?</td>
<td>64</td>
</tr>
<tr>
<td>What can I synchronize?</td>
<td>65</td>
</tr>
<tr>
<td>Setting up your computer for synchronization</td>
<td>67</td>
</tr>
<tr>
<td>Synchronizing using the sync cable</td>
<td>70</td>
</tr>
<tr>
<td>Setting up wireless synchronization</td>
<td>71</td>
</tr>
<tr>
<td>Other ways to synchronize</td>
<td>75</td>
</tr>
<tr>
<td>Setting synchronization options</td>
<td>77</td>
</tr>
<tr>
<td>Chapter 5: Your email and other wireless services</td>
<td>79</td>
</tr>
<tr>
<td>Sending and receiving messages and email</td>
<td>81</td>
</tr>
<tr>
<td>Using Pocket MSN</td>
<td>102</td>
</tr>
<tr>
<td>Browsing the web</td>
<td>103</td>
</tr>
<tr>
<td>Connecting to devices using Bluetooth wireless technology</td>
<td>109</td>
</tr>
<tr>
<td>Beaming information with IR</td>
<td>114</td>
</tr>
<tr>
<td>Using your smartphone as a wireless modem</td>
<td>116</td>
</tr>
<tr>
<td>Chapter 6: Your photos, videos, and music</td>
<td>121</td>
</tr>
<tr>
<td>Pictures &amp; Videos</td>
<td>123</td>
</tr>
<tr>
<td>Windows Media Player Mobile</td>
<td>131</td>
</tr>
<tr>
<td>Chapter 7: Your personal information organizer</td>
<td>139</td>
</tr>
<tr>
<td>Contacts</td>
<td>141</td>
</tr>
<tr>
<td>Calendar</td>
<td>143</td>
</tr>
<tr>
<td>Tasks</td>
<td>149</td>
</tr>
<tr>
<td>Notes</td>
<td>151</td>
</tr>
<tr>
<td>Calculator</td>
<td>154</td>
</tr>
<tr>
<td>Chapter 8: Your Microsoft Office tools</td>
<td>157</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Synchronizing your Microsoft Office files</td>
<td>159</td>
</tr>
<tr>
<td>Word Mobile</td>
<td>159</td>
</tr>
<tr>
<td>PowerPoint Mobile</td>
<td>165</td>
</tr>
<tr>
<td>Excel Mobile</td>
<td>167</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 9: Your application and info management tools</th>
<th>177</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Find</td>
<td>179</td>
</tr>
<tr>
<td>Installing applications</td>
<td>180</td>
</tr>
<tr>
<td>Removing applications</td>
<td>183</td>
</tr>
<tr>
<td>Sharing info</td>
<td>183</td>
</tr>
<tr>
<td>Using expansion cards</td>
<td>184</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 10: Your personal settings</th>
<th>189</th>
</tr>
</thead>
<tbody>
<tr>
<td>Today screen settings</td>
<td>191</td>
</tr>
<tr>
<td>System sound settings</td>
<td>192</td>
</tr>
<tr>
<td>Display and appearance settings</td>
<td>194</td>
</tr>
<tr>
<td>Application settings</td>
<td>196</td>
</tr>
<tr>
<td>Locking your smartphone and info</td>
<td>200</td>
</tr>
<tr>
<td>Using Auto-Keyguard and touchscreen lockout</td>
<td>201</td>
</tr>
<tr>
<td>System settings</td>
<td>204</td>
</tr>
<tr>
<td>Connection settings</td>
<td>210</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 11: Common questions</th>
<th>217</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transferring info from another device</td>
<td>219</td>
</tr>
<tr>
<td>Trouble installing the desktop software?</td>
<td>219</td>
</tr>
<tr>
<td>Resetting your smartphone</td>
<td>220</td>
</tr>
<tr>
<td>Performance</td>
<td>224</td>
</tr>
<tr>
<td>Screen</td>
<td>225</td>
</tr>
<tr>
<td>Network connection</td>
<td>226</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Synchronization (ActiveSync software)</td>
<td>229</td>
</tr>
<tr>
<td>Email</td>
<td>233</td>
</tr>
<tr>
<td>Web</td>
<td>236</td>
</tr>
<tr>
<td>Camera</td>
<td>237</td>
</tr>
<tr>
<td>Third-party applications</td>
<td>238</td>
</tr>
<tr>
<td>Making room on your smartphone</td>
<td>239</td>
</tr>
<tr>
<td>Voice quality</td>
<td>240</td>
</tr>
<tr>
<td>Where to learn more</td>
<td>241</td>
</tr>
<tr>
<td>Terms</td>
<td>243</td>
</tr>
<tr>
<td>Important safety and legal information</td>
<td>247</td>
</tr>
<tr>
<td>Specifications</td>
<td>253</td>
</tr>
<tr>
<td>Index</td>
<td>257</td>
</tr>
</tbody>
</table>
Welcome

Congratulations on the purchase of your Palm® Treo™ 700wx smartphone. In one compact and indispensable device, you now have all of the following:

- An advanced mobile smartphone
- A Windows Mobile® organizer with portable expansion capability (MultiMediaCard/SD/SDIO)
- High-speed web browsing with NationalAccess and BroadbandAccess support
- A 1.3-megapixel digital camera
- Mobile email
- Text and multimedia messaging
- A media player
- Microsoft Office Mobile suite

This guide helps you set up your smartphone and quickly learn to use it.

NOTE Phone and text messaging services require a service contract with Verizon Wireless. Web, email, and messaging services require a service contract and high-speed data service from Verizon Wireless. Data speeds vary based on network availability.

What’s in the box?

You should have received all of the following items in the Treo 700wx smartphone box:

**Hardware**
- Treo 700wx smartphone
- Rechargeable battery
- AC charger
- USB sync cable
- Stereo headset

**Documentation and software**
- *Read This First* setup poster
- *Quick Reference*

**TIP LOOK HERE:** Don’t miss the helpful tips and cross-references given in these shaded boxes.
• Your Palm® Treo™ 700wx Smartphone User Guide (this guide)
• Getting Started CD, which includes the following:
  • Microsoft® Office Outlook® 2002
  • ActiveSync® desktop synchronization software
  • Additional software for your smartphone
  • Palm warranty

What do I need to get started?

As you read through the instructions in this guide, you need all the items that came in the Treo 700wx smartphone box (see What’s in the box?), as well as the following:

• An activated Verizon Wireless account with a data service plan
• A location with wireless coverage for your smartphone
• An electrical outlet
• The computer you want to synchronize your personal information with

NOTE If you want to use email, web browsing, or multimedia messaging features, your Verizon Wireless service plan must include data services.
Setting up

You’re about to discover the many ways your Palm® Treo™ 700wx smartphone can help you to better manage your life and to have fun, too.

As you become more familiar with your smartphone, you’ll want to personalize the settings and add applications to make it uniquely yours. But first, follow these few easy steps to set up your smartphone and get it running.

Benefits

- Know where your smartphone controls are located
- Start using your smartphone right away
In this chapter

Treo 700wx smartphone overview ................................. 5
Installing the battery .................................................. 7
Charging the battery .................................................... 8
Making your first call .................................................... 10
Setting up synchronization ........................................... 12
Treo 700wx smartphone overview

Front view

Indicator light (phone and charge indicator)
Earpiece
5-way navigator and Center button
Right action key
Power/End
OK
Volume button
Side button
Left action key
Phone/Send
Start
Option
Microphone
Multi-connector
Headset jack

**TIP** Be careful not to scratch or crush your smartphone screen. Do not store it in a place where other items might damage it. Visit www.palm.com/mytreo700wxVerizon to find a variety of useful accessories, including carrying cases that protect the screen.
**IMPORTANT** Your smartphone’s speaker includes a large magnet, so be sure not to store your smartphone near credit cards or other items that could be demagnetized.

**DID YOU KNOW?** The Ringer switch silences all sounds, including music, at once; you don’t need to hunt for “off” or “mute” settings in individual applications.
Installing the battery

1. Use one hand to press the **battery door release** and use the other hand to slide the **battery door** downward to remove it from your smartphone.

2. Align the **battery** contacts with the phone contacts inside the battery compartment.

3. Insert the **battery** into the compartment at a 45-degree angle and then press it into place.

4. Slide the **battery door** onto the back of the smartphone until it clicks into place. Your smartphone screen turns on and the Treo screen appears. Wait for the progress bar on the Treo screen to fill and the Windows Mobile® screen to appear.

5. Follow the onscreen instructions to finish the installation.

**TIP** If your smartphone does not turn on after you insert the battery, you need to connect it to the **AC charger** to charge it. If it still doesn’t start, do a soft reset. See **Performing a soft reset**.

**TIP** You can buy an extra battery as a spare for long plane trips or periods of heavy data use. Be sure to use batteries from Palm only.
Charging the battery

Before using your smartphone, you need to charge the battery. For tips on maximizing the life of your smartphone’s battery, see Maximizing battery life.

**IMPORTANT** Charge the battery for 3.5 hours, or until the indicator light is solid green.

1. Plug the **AC charger** into a wall outlet. If necessary, connect an adapter.
2. With the arrow on the connector facing up (toward your smartphone screen), connect the **charger cable** to the bottom of your smartphone.
3. Check the indicator light to confirm that your smartphone is charging.

**Solid red**: Indicates that your smartphone is charging.

**Solid green**: Indicates that your smartphone is fully charged.

**TIP** If the indicator light does not turn on when you connect your smartphone to the AC charger, double-check the cable connection and the electrical outlet to which it is connected.

When your smartphone is on (see **Turning your smartphone on/off**), the onscreen battery icon displays the charging status:

- A solid lightning bolt indicates that the battery is connected to a wall outlet and is charging.
- A shaded lightning bolt indicates that the battery is connected to a wall outlet and is fully charged.
- A partial battery without a lightning bolt indicates that the battery is not connected to a wall outlet and it has some power.
An exclamation point (!) indicates that the battery needs to be charged immediately.

- Charge your smartphone whenever you’re at your desk, or charge it overnight each day. The battery in your smartphone has a much longer useful life when it is topped off frequently, versus charging it after it is fully drained.
- If you spend a lot of time using the camera, games, media players, eBooks, or other applications, keep an eye on the battery icon and charge when necessary.
- Your smartphone’s wireless features (phone, email, messaging, and web) generally consume more power than the organizer features. If you don’t plan to use the wireless features on your smartphone for a while, turn off your wireless services (see Turning wireless services on/off). You can forward calls to a different number or let all calls be picked up by voicemail (see Forwarding calls). To see if other wireless services, such as Bluetooth® wireless technology, are on, tap the phone-off icon, and then select Wireless Manager.
- Turn off your smartphone’s Bluetooth feature when you do not need to make a Bluetooth connection.

DID YOU KNOW? Tapping the battery icon opens a window showing a percentage level of charge left in the battery.

DID YOU KNOW? If your battery ever becomes fully drained, your info is stored safely on your smartphone until you recharge the battery or connect your smartphone to a power source.

Maximizing battery life
Battery life depends on how you use your smartphone. You can maximize your smartphone’s battery life by following a few easy guidelines:
• As with any mobile phone, if your phone is turned on while you are in an area with no wireless coverage, your smartphone continues to search for a signal, and that consumes power. If you cannot move to an area with better coverage, temporarily turn off your phone (see Turning your smartphone on/off).

• Turn down the screen brightness (see Adjusting the brightness).

• Set your screen to turn off automatically after a shorter period of inactivity (see Viewing and optimizing power settings).

• Keep your battery away from direct sunlight and other sources of heat. Temperatures over 120 degrees Fahrenheit (50 degrees Celsius) can permanently reduce the capacity and life span of any lithium-ion battery.

• Limit use of Microsoft® Voice Command software when it is not needed.

Making your first call

We recommend that you charge your smartphone for a full 3.5 hours (or until the indicator light is solid green) before using it for the first time.

1. If you do not see your Today screen, press Phone/Send 📞.

2. If prompted, press Center ⓐ to turn off Keyguard (see Locking your smartphone and info for more info.)

3. If you have not activated your phone, follow these steps to do so:

   • Use the number pad on the keyboard to enter *228 (these numbers appear on the ZRRC letter keys).
• Press **Phone/Send** (📞) to dial.
• Follow the voice prompts to activate your phone. A service provisioning message appears.
• Wait a few minutes until you see the Programming Successful! message, and then press **Dismiss** (⪸) (left action key).

4 Use the number pad on the keyboard to enter the number you want to call.

5 Press **Phone/Send** (📞) to dial.

6 When your call is complete, press **Power/End** (멈춤) to end the call.

**Adjusting call volume**
While a call is in progress, press the **Volume** button on the side of your smartphone to adjust call volume. To dismiss the volume control dialog box, press **Center** (넷 중앙).  

**What’s my number?**

1 Make sure your phone is on (see **Turning your smartphone on/off**).
2 If you do not see your Today screen, press **Phone/Send** (📞).
3 Press **Menu** ( aç기 ) (right action key).
4 Select **Preferences > Phone Settings**.
5 On the Phone tab, look for your phone number below the title bar.

Look here for your phone number

6 Press OK.

**TIP** If your phone number doesn’t appear on the Phone Settings screen, press OK, and then turn your phone off and back on again. Repeat steps 1–6. If your phone number still doesn’t appear, your phone has not been activated. Turn your phone off, wait a few hours, and then turn on your phone and repeat these steps. If your phone number still does not appear, please contact Verizon Wireless for assistance.

---

**Setting up synchronization**

Once you’ve finished setting up your smartphone, we recommend that you set up a synchronization method to get the most out of your smartphone. Synchronization allows you to enter or change information on your smartphone or in Microsoft Office Outlook® on your computer. Your info is then automatically updated in both places; there’s no need to enter the info twice. See Synchronizing information.
Moving around on your smartphone

Have you ever been to a new city and felt a bit lost until you figured out that the numbered streets run north/south and the avenues run east/west? Learning to move around on your smartphone is similar. Most applications that work on your smartphone use the same set of controls. So once you learn how to use these controls, you’ll be driving all over town and you won’t even need a map.

**Benefits**

- Quickly move around and complete tasks in applications using one thumb on the 5-way navigator
- Access extra features with menus
- Find and open applications quickly
In this chapter

Navigating around the screen ............................................. 15
Using the keyboard ............................................................ 21
Opening and closing applications .......................................... 25
Using your Today screen ....................................................... 26
Navigating around the screen

To move around the Palm® Treo™ 700wx smartphone screen, you can use the 5-way navigator or you can tap items on the screen with the stylus. As you become familiar with your smartphone, you’ll find your own favorite way to scroll, highlight, and select items.

The 5-way includes the Right ▶️, Left ◀️, Up ▲, Down ▼️, and Center □ buttons.

**TIP** Some third-party applications may not work with the 5-way navigator, and you must use the stylus instead.

**DID YOU KNOW?** Custom navigation features are available when you browse the web using Internet Explorer. See Viewing a web page.

**TIP** The arrow icons that indicate directions on the 5-way are different from the onscreen scroll arrows and the arrows that indicate that a list is available (see Selecting options in a list).

Scrolling through screens

As on a computer, on your smartphone you scroll to move from field to field or page to page, or in some cases to highlight an item or option in a list. There are several methods of scrolling:

- Use the **5-way** on the front of your smartphone. Press **Right ▶️**, **Left ◀️**, **Up ▲**, **Down ▼️**, and **Center □** buttons.
**Up ▲, or Down ▼ to move to the next field, button, or action in that direction.**

- Press and hold **Option ⌘** while pressing **Up ▲** or **Down ▼** to scroll one screen at a time. These keys work just like the Page Up and Page Down keys on your computer keyboard.

**TIP** When you are in applications such as Messaging, Internet Explorer, and Word Mobile, press and hold **Option ⌘** while pressing **Left ◀** or **Right ►** on the 5-way to automatically go to the top or bottom of a screen.

- Press and hold **Option ⌘** while pressing **Left ◀** or **Right ►** to jump to the top or bottom of the current document or entry.
- When viewing a screen with tabs, such as when adding a contact, press **Down ▼** to scroll to the tabs, and then press **Left ◀** or **Right ►** to move between tabs.

- When inside a text field, press **Right ►** or **Left ◀** to move to the next character, and press **Up ▲** or **Down ▼** to move between lines.
- When inside a list, press and hold **Up ▲** or **Down ▼** to rapidly scroll through the list.
- Tap an onscreen scroll arrow.
- Tap and drag the slider of an onscreen scroll bar.
Closing screens
To accept the information you entered on a screen and to return to the previous screen, do one of the following:

- Press **OK**.
- Use the stylus to tap **OK** or **X** in the upper-right corner of the screen.

Highlighting and selecting items
On most screens, one item—a button, a list entry, or a check box—is highlighted by default. The highlight identifies which item is affected by your next action. Use the 5-way to move the highlight from one item to another before opening or selecting it.

The highlight can take one of two forms, depending on what is highlighted:

**Border:** This rectangular border highlights items such as an onscreen button (for example, OK, Dismiss, or Hide), a check box, an option, or a web link.

**Reverse type (light text on a dark background):** This highlights items such as a phone number, an email address, text, or an item in a list.

After highlighting an item with the 5-way, you can select or activate it by pressing **Center** or by tapping the item with the stylus.

**TIP** The best way to learn to use the 5-way is to experiment. Press the 5-way buttons and as you do, follow the movement of the border around the screen. The behavior of the 5-way varies slightly in each application.

Highlighting text
You can use the 5-way or the stylus to highlight text on the screen:

**5-way:** Press and hold **Shift** while pressing **Right**, **Left**, **Up**, or **Down** to extend the highlight in that direction.
**Stylus:** Tap and drag the stylus across the text you want to highlight. To highlight a word, double-tap it. To highlight a paragraph, triple-tap it.

**TIP** When text is highlighted, you can press Backspace to delete the highlighted text.

**Using the action keys**
The left and right action keys give you quick access to tasks that you can do on the current screen, so the action key items vary from application to application and from screen to screen. Look on the screen directly above the action key to see the action that it does in the current context. In some contexts, these keys may do nothing at all. In most cases the right action key opens the menu, and the left action key activates a specific command, such as New or Edit. Remember that action key functions vary from screen to screen, so be sure to check the onscreen label before pressing the action keys.
Selecting menu items
In many applications, a menu provides access to additional features. The menu is hidden until you press **Menu** (right action key). To get the most out of your smartphone, it’s a good idea to familiarize yourself with the additional features available through the menu in various applications.

1. Press **Menu** (right action key) to display an application’s menu.

2. Press **Up ▲** or **Down ▼** to highlight a menu item.

3. If an arrow appears next to a menu item, press **Center ▼** or **Right ▶** to display additional options for that item, and then press **Up ▲** or **Down ▼** to highlight a menu item. To return to the main menu without making a selection, press **Left ◄**.

4. Press **Center ▼** to select the menu item, or press **Left ◄** or **Menu ▼** (right action key) to close the menu and cancel your selection.

**DID YOU KNOW?** You can select most menu items by pressing a key on the keyboard. To quickly access a menu item, press **Menu** (right action key) followed by the underlined letter in the menu item’s name.

Selecting options in a shortcut menu
Most applications also provide access to context-sensitive, shortcut menus—similar to the right-click menus on a computer. The shortcut menu options vary based on the highlighted selection.
1 Highlight the item you want to open the shortcut menu for.

2 Press and hold Center to open the shortcut menu.

3 Press Up or Down to highlight a menu item.

4 Press Center to select the menu item or press Left to cancel your selection.

**TIP** You can also tap and hold an item with the stylus to open the shortcut menu.

---

**Selecting options in a list**

Lists let you select from a range of options. You can identify whether a list is available when you select the field. If a rectangle appears around the field along with a downward-pointing arrow, a list is available. Lists are different from the menus described earlier in this section.
To select from a list, do any of the following:

- Use the **5-way** to highlight the field, and then press **Center** to display the items in the list. Press **Up** or **Down** to highlight the item you want, and then press **Center** to make your selection.

- Use your stylus to tap the arrow, and then tap the item in the list.

- To exit the list and cancel your selection, press **Left**.

**TIP** When selecting fields, you might not see the downward-pointing arrow until you press Center on the 5-way.

**DID YOU KNOW?** In fields where you see a downward-pointing arrow but no rectangle, you must tap the arrow with the stylus to expand the field.

---

**Using the keyboard**

- **Left action key**
- **Phone/Send**
- **Start**
- **Option**
- **Shift**
- **Space**
- **Alt**
- **Right action key**
- **Power/End**
- **OK**
- **Backspace**
- **Return**
- **Shift**
Understanding the keyboard backlight

Your smartphone includes a keyboard backlight for low light conditions. The keyboard backlight is activated automatically when you turn on the screen. The backlight turns off automatically when the screen turns off or when you are on a call or you are playing music in the background for longer than the time specified in Backlight Settings. You can set different time intervals depending on whether the smartphone is operating on battery power or is connected to an external power source. The backlight also turns off when an application’s power-saving features turn it off.

Entering lowercase and uppercase letters

By default, the first letter of each sentence or field is capitalized and the remaining text you enter is lowercase. To enter other uppercase letters, do one of the following:

- Press Shift (this symbol appears at the bottom of the screen), and then enter a letter. You don’t need to press and hold Shift while entering a letter.
- Press Shift twice to turn on Caps Lock, and then enter a series of letters. When Caps Lock is on, this symbol appears at the bottom of the screen: . To turn off Caps Lock, press Shift again.

Entering numbers, punctuation, and symbols

Numbers, punctuation, and symbols appear above the letters on the keys. To enter these characters, do one of the following:

TIP When using the keyboard, most people find it easiest to hold the smartphone with two hands and to use the tips of both thumbs to press the keys.

TIP You can change the backlight shut-off interval. Press Start and select Settings. Select the System tab, and then select Backlight. Set the time interval on the Battery Power tab and on the External Power tab.

TIP You can turn off the first-letter capitalization setting. For details see Setting input options.
• Press **Option** (this symbol appears at the bottom of the screen), and then press the key of the desired character. You don’t need to hold Option while pressing the key.

• Press **Option** twice to turn on Option Lock, and then press the desired keys to enter a series of characters. When Option Lock is on, this symbol appears at the bottom of the screen: `. To turn off Option Lock, press **Option** again.

### Entering other symbols and accented characters

You can enter symbols and accented characters that don’t appear on the keys using the alternate characters list.

1. Press **Alt** to display the alternate character list.

2. Narrow the list by pressing the key that corresponds to the character you want. For example, to enter an é, press **e**. See the table on the next page for a list of corresponding characters.

   **TIP** The alternate characters are grouped according to their similarity to the corresponding key. For example, the alternate characters available for the e key are é, è, ê, and ë. If you press the wrong key, press **Backspace** to return to the full list of alternate characters. You can then press another key.

   **DID YOU KNOW?** If you don’t know which key to press to narrow the list when entering a symbol, you can scroll through the full list until you find the character you want.

3. Press **Up** or **Down** to highlight the desired character.

4. Press **Center** to insert the character.
### Symbols and accented characters

<table>
<thead>
<tr>
<th></th>
<th>Press Alt and enter... to select...</th>
<th>Press Alt and enter... to select...</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>á à ä å â æ</td>
<td>S</td>
<td>S ß Š</td>
</tr>
<tr>
<td>A</td>
<td>Â Ä Å Æ</td>
<td>t or T</td>
<td>TM</td>
</tr>
<tr>
<td>b or B</td>
<td>ß</td>
<td>u</td>
<td>û ü û</td>
</tr>
<tr>
<td>c</td>
<td>ç ©</td>
<td>U</td>
<td>Ú Ù Ü Ü Ø</td>
</tr>
<tr>
<td>C</td>
<td>Ç ©</td>
<td>x or X</td>
<td>x ø</td>
</tr>
<tr>
<td>e</td>
<td>é è ê ê</td>
<td>y</td>
<td>Ý Ŷ</td>
</tr>
<tr>
<td>E</td>
<td>É È Ê Ê</td>
<td>Y</td>
<td>Ý Ŷ</td>
</tr>
<tr>
<td>i</td>
<td>í î ï î</td>
<td>0</td>
<td>°</td>
</tr>
<tr>
<td>l</td>
<td>ï î ï î</td>
<td>1</td>
<td>¹ ¾ ½</td>
</tr>
<tr>
<td>l or L</td>
<td>£</td>
<td>2</td>
<td>²</td>
</tr>
<tr>
<td>n</td>
<td>ñ</td>
<td>3</td>
<td>³ ¾ ⁴</td>
</tr>
<tr>
<td>N</td>
<td>Ñ</td>
<td>$</td>
<td>€ £ ¥ ¢</td>
</tr>
<tr>
<td>o</td>
<td>ó ô õ õ oœ oœ</td>
<td>!</td>
<td>i</td>
</tr>
<tr>
<td>O</td>
<td>Ó Ô Õ Ô œ œ O œ Ô œ</td>
<td>?</td>
<td>¿</td>
</tr>
<tr>
<td>p or P</td>
<td>¶ . , &quot; @ + - * / # ( or )</td>
<td>, : &amp; _ • % = ÷ ^ € £ ¥ ¢ [ ] {} &lt; &gt; « » © ® ° ~ \ Ø µ</td>
<td></td>
</tr>
</tbody>
</table>
Opening and closing applications

Opening applications
You can access all the applications on your smartphone through the Start menu:

1. Press Start to open the Start menu.

2. Use the 5-way to highlight the application you want to use. To view additional applications, select Programs.

3. Press Center to open the highlighted application.

4. (Optional) Press OK to return to Programs and open another application. The current application continues to run in the background.

TIP With the Start menu open, you can press the letter underlined in the application’s name to open the app. For example, press H to open Help. You can also select the shortcut icons at the top of the Start menu to open recently used applications.

DID YOU KNOW? You can open apps by pressing Option and then pressing Phone/Send, Start, or OK. You can customize the apps assigned to these button combinations; see Reassigning buttons for details.

Closing applications
You can have several applications open at once, so you don’t need to exit an application to open another one. In most cases, applications close automatically when available memory is low, but you can also close applications manually.

1. Press and hold OK to open Memory Settings.
On the Running Programs tab, do one of the following:

- Select the application you want to close, and then select **Stop** to close it.
- Select **Stop All** to close all of your open applications.

**NOTE** If you press **OK** to return to Programs, the current application continues to run in the background.

**TIP** You can also open Memory Settings from the Start menu. Press **Start**, select **Settings**, select the **System tab**, and then **Memory**.

---

**Using your Today screen**

Your Today screen is your home base. From your Today screen you can quickly look up a contact, dial a phone number or speed-dial button, see your latest calendar appointments, see the number of unread email messages, and even display a web page.

To access your Today screen, press **Phone/Send**.

---

**Title bar and status info**

**Dial Lookup field**

**Speed-dial entries**

**Web search field**
**Title bar and status info:** See [What are all those icons?](#) to learn about the icons that appear in this area.

**Dial Lookup field:** Begin typing the name or number you want to look up. See [Dialing by contact name](#) for more info.

**Web search field:** Enter a word you want to find on the Internet and press Center to begin the search (data services connection required).

**Speed-dial entries:** Select the picture or button you want to dial. See [Defining speed-dial buttons](#) to create your own.

**TIP** If you press **Phone/Send** while a number is highlighted, your smartphone dials the number. If a number is highlighted, deselect the number, or use the Start menu to access the Today screen.

**TIP** You can select a picture for your Today screen background and select which items appear in the Today screen. See [Today screen settings](#) for details.
Your Phone

The phone, along with the Today screen, is your home base for making and receiving calls.

You can creatively manage multiple calls; for example, you can swap between calls, send text messages to ignored calls, and create conference calls.

And you can do more than manage your phone calls. You can send text messages, open applications, go to your favorite web pages, see your upcoming appointments, and even find out how many unread email messages you have.

**Benefits**

- Stay in touch—you choose how
- Work in other applications when on an active call.
- Create speed-dial buttons with pictures of your friends
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turning your smartphone on/off</td>
<td>31</td>
</tr>
<tr>
<td>Phone overview</td>
<td>32</td>
</tr>
<tr>
<td>Making calls from the Today screen</td>
<td>32</td>
</tr>
<tr>
<td>Other ways of making calls</td>
<td>36</td>
</tr>
<tr>
<td>Receiving calls</td>
<td>38</td>
</tr>
<tr>
<td>Using voicemail</td>
<td>39</td>
</tr>
<tr>
<td>What can I do during a call?</td>
<td>40</td>
</tr>
<tr>
<td>Defining speed-dial buttons</td>
<td>45</td>
</tr>
<tr>
<td>Using a phone headset</td>
<td>49</td>
</tr>
<tr>
<td>Phone settings</td>
<td>51</td>
</tr>
<tr>
<td>What are all those icons?</td>
<td>58</td>
</tr>
</tbody>
</table>
Turning your smartphone on/off

The phone and the screen of your Palm® Treo™ 700wx smartphone can be turned off and on separately. This means you can wake up the screen to use just the organizer features of your device, without turning on the phone. Also, when the screen is turned off, the phone can be on and ready for you to receive and make calls.

**Turning your phone on and off**

When you turn on your phone, it connects to a mobile network so that you can make and receive phone calls and use other wireless services.

1. Press and hold **Power/End** to turn on your phone. When your smartphone locates a signal, Verizon Wireless and the signal-strength icon appear at the top of the screen, indicating that you can use the phone and Internet features (if supported by the local network).

**DID YOU KNOW?** The indicator light flashes green when your phone is on and you’re inside a coverage area. If you’re outside a coverage area, the indicator light flashes amber and no bars appear in the signal-strength icon.

2. Press and hold **Power/End** again to turn off your phone. When your phone is off, the phone-off icon appears at the top of the screen and your smartphone is not connected to any mobile network. You can still use the organizer and other features.

**TIP** If the Ringer switch is in the Sound On position, you hear a series of tones when you turn your phone on and off. For more info see Setting the Ringer switch.

**Waking up the screen and turning it off**

Wake up the screen and leave the phone turned off when you want to use only the organizer features of your smartphone, for example, when you’re on a plane and want to look at your calendar. You can also turn off your smartphone’s screen without
turning off your smartphone’s wireless features.

1 Press **Power/End** 📞 to wake up the screen.

2 Briefly press **Power/End** 📞 to turn off the screen.

**TIP** You can set how long the screen stays on. Press **Start**, select **Settings**, select the **System** tab, and then select **Power**. Select the **Advanced** tab, and then increase the **On battery power** setting.

---

### Phone overview

You can make and receive calls and store speed-dial entries right from your Today screen. Be sure you know how to turn on your phone before reading this section (see **Turning your smartphone on/off**).

**IMPORTANT** Depending on where you are on a network and certain coverage conditions, you might experience interruptions with your phone operation while using a Wi-Fi® card. Palm recommends that you turn off the phone radio when using any Wi-Fi card or remove the Wi-Fi card when not in use to ensure that you can always make and receive phone calls. For emergency calls, always remove the card from your smartphone to ensure optimal connectivity.

### Accessing your Today screen

Press **Phone/Send** 📞.

### Making calls from the Today screen

Your smartphone offers several ways to make phone calls from the Today screen.
Dialing from the Today screen
1 Go to your Today screen (see Accessing your Today screen).
2 Using the numbered keys on the keyboard, enter a phone number in the Dial Lookup field.

3 Press Phone/Send to dial.

NOTE You do not need to press Option to access the numbers on the keyboard. However, when dialing short numbers, such as 411, the number may conflict with a contact name. If this occurs, press Option to avoid starting a contact lookup. You can always dial 911 without pressing Option first.

TIP If you press Phone/Send while a number is highlighted, your device dials the number. If a number is highlighted, deselect the number, or use the Start menu to access the Today screen.

Dialing with a speed-dial button
Before you can use a speed-dial button, you must create some speed-dial entries. See Defining speed-dial buttons.

DID YOU KNOW? After you initiate a call, you do not need to press Option to access the * and # keys when responding to further dialing instructions.
You can make a call with your speed-dial buttons by doing any of the following:

- Use the 5-way to highlight a speed-dial button, and then press Center.
- Tap a speed-dial button with the stylus.
- Press and hold the Quick Key that you assigned to the speed-dial button. For more info on Quick Keys see Creating a speed-dial button.

To see more speed-dial buttons, highlight the picture speed-dial area and press Right or Left repeatedly, or highlight the text speed-dial area and press Up, Down, Right, or Left.

**Dialing by contact name**

You can look up contacts quickly by entering just a few letters of a contact’s name directly from your Today screen.

**BEFORE YOU BEGIN** Before you can dial a number by contact name, you must create some contacts (see Adding a contact) or import them by synchronizing (see Synchronizing information).

1. Go to your Today screen.
2. Using the keyboard, begin entering one of the following for the contact you want to call:

   - First name (for example, joh for John)
   - Last name (smi for Smith)

**TIP** You can hide your speed-dial buttons on your Today Screen and still use your Quick Keys to call a speed-dial number. For details see Selecting which items appear on your Today screen.

**DID YOU KNOW?** You can dial an alternate number for a contact with a speed-dial button. Highlight the speed-dial button, press and hold Center on the 5-way, and then select a number from the shortcut menu.

**TIP** You can customize the default speed-dial buttons. See Editing a speed-dial button.
• First initial, a space, and then last initial (j s for John Smith)
• First name and last name (joh smi for John Smith)

For example, entering sm finds both Smilla Anderson and John Smith. Entering sm a finds only Smilla Anderson.

To clear the Dial Lookup field and start another Contacts search, press OK. To delete letters when correcting a misspelled name, press Backspace.

**TIP** To see a contact’s address, company, and other details, highlight the name and press Center on the 5-way.

3 Select the number you want to dial.
4 Press Phone/Send ☎️ to dial.

**DID YOU KNOW?** After you look up a contact, you can select how you want to communicate with that person. Press and hold Center on the 5-way, and then select the communication method you want to use.

---

**Dialing using the onscreen Dial Pad**

The onscreen Dial Pad is useful when you need to dial numbers that are expressed as letters, such as POPCORN to check the time, and when you need large numbers that you can tap with your finger or the stylus.

1 Go to your Today screen.
2 Press Phone/Send ☎️ and then select Dial Pad from the menu.
3 Tap the onscreen Dial Pad to enter the number.
4 Press Phone/Send ☎️ to dial.
Redialing a recently called number

To dial the last number you called: Go to your Today screen, and then press and hold Phone/Send  

To select from your most recently dialed numbers: Go to your Today screen, press Phone/Send  
highlight the number or contact name you want to call, and then press Phone/Send  

To select from a chronological list of calls: Go to your Today screen, press Phone/Send  
and then select Call Log. Highlight the number you want to call, and then press Call  
(left action key) to dial.

Other ways of making calls

Your smartphone offers other ways to make phone calls besides from the Today screen. Try them all and you’ll discover which methods you prefer.
Dialing by company name

DID YOU KNOW? You can paste numbers directly into the Dial Pad. Copy a number from another application, switch to Dial Pad, and then press and hold Center on the 5-way to paste the number.

1. Press Start and select Contacts.
2. Press Menu (right action key) and select View By > Company.
3. Press Phone/Send to go to your Today screen.
4. Using the keyboard, begin entering the first few letters of the company name.
5. Select the number you want to dial.
6. Press Phone/Send to dial.

TIP Until you change the View By setting, your contact list (in the Contacts application) remains sorted by company name.

Dialing from a web page or message

Your smartphone recognizes most phone numbers that appear in web pages or in messages (text, email, or multimedia).

1. Use the 5-way to highlight the phone number you want to dial in the web page or message.
2. Press Center to open the Phone dialog box, and then select Yes to dial.

TIP If you can’t dial a phone number directly from a web page or a message, then highlight the number, press and hold Center on the 5-way, and select Copy. Open the Dial Pad, press and hold Center on the 5-way, and then select Paste. Press Phone/Send to dial.
Receiving calls

To receive calls, your phone must be on.

**DID YOU KNOW?** When you are on a plane, you can turn off your phone and all wireless services using Wireless Manager (see Turning wireless services on/off). But you can still wake up the screen and use any app that doesn’t require wireless services, like your smartphone’s calendar, music player, and games.

To answer a call, do one of the following:

- Press **Phone/Send**.
- Press **Answer** (left action key).
- If the headset is attached, press the **headset** button.

**TIP** See a picture of the person calling you! Learn how to assign a caller ID picture in Assigning a picture and ringtone ID to a contact.

**TIP** If music is playing when a call arrives, the smartphone rings softly. You can answer the phone as you normally would. The audio pauses during your call.

To ignore a call and send it to voicemail, do one of the following:

- Press **Power/End**.
- Press **Menu** (right action key) and select **Ignore**.

**DID YOU KNOW?** You can also ignore a call and send a text message. Press **Menu** (right action key) and select **Ignore with text message**.

To silence the ringer while your smartphone is ringing:

- Press the **Volume** button or any key on your smartphone except Phone/Send, Power/End, or the 5-way.
- To immediately silence all system sounds including the ringer, slide the **Ringer switch** to the **Sound Off** position. All sounds remain off until you slide the **Ringer switch** back to the **Sound On** position.

When you silence the ringer, you can either answer the call or let it ring through to voicemail.
Using voicemail

Setting up voicemail

1. Go to your Today screen.
2. Press and hold 1 on the keyboard to dial the Verizon Wireless voicemail system.
3. Follow the voice prompts to set up your voicemail.

**DID YOU KNOW?** The 1 key is the Quick Key for the voicemail speed-dial button. For more info on Quick Keys see Creating a speed-dial button.

**TIP** If you have trouble accessing a voicemail system, try changing the Dial Pad tone setting. See Selecting your call settings.

Voicemail notification

When you have a new voicemail message, a notification screen appears. To hear your message now, press **Listen** (left action key). To retrieve your message later, press **Dismiss** (right action key). When you have unretrieved voicemail messages, a voicemail icon appears at the top of your screen and the left action key is labeled Voicemail.

Retrieving voicemail messages

1. Go to your Today screen.
2. Press and hold 1 on the keyboard to dial the Verizon Wireless voicemail system.
3. Enter your voicemail password using the keyboard, or press **Extra Digits** (left action key) if you defined this option (see Creating a speed-dial button for details).
4. Select **Play** to listen to your messages.
What can I do during a call?

Your smartphone offers many advanced telephone features, including call waiting, three-way calling, and call forwarding.

When you make or receive a call, the active call info appears on your Today screen.

During a call, you can do any of the following:

**Put the call on hold:** Press Hold (left action key). To take the call off hold, press Off Hold (left action key).

**Use the built-in speakerphone:** Select the speakerphone icon to turn on the speakerphone. To return to the earpiece, select the speakerphone icon again.

**Mute the microphone so you can’t be heard:** Select the mute icon. To turn the microphone back on, select the mute icon again.

**Switch to another application:** Press Start and select the application.

DID YOU KNOW? When a voicemail icon appears at the top of the screen, you can tap this icon to retrieve your voicemail.

Current duration of call
Caller’s name and number
Ending a call
Do one of the following:

- Press **Power/End**.
- Press the headset button (if the headset is attached and has a button on it). Some headsets do not have a button.

Returning to an active call from another application
You can use many other applications on your smartphone while holding a phone conversation, including the organizer and SMS features. You cannot browse the web or send and receive email or MMS messages while on a voice call.

From any application, press **Phone/Send** to return to your Today screen.

Saving phone numbers
After you complete a call, you are prompted to add the number if it is not already in your Contacts list.

- To create a new contact for this number, select **Create New Contact**.
- To add this number to an existing contact, select **Copy** and **Add**, and then select a contact name.
- To decline adding the number, press **Dismiss** (left action key).
- To permanently disable the Add Contact prompt, select **Don’t show this again**.
If you don’t add a number right away, follow these steps to add it later:

1. Go to the Call Log (see Redialing a recently called number).
2. Highlight the number you want to save.
3. Press and hold Center to open the shortcut menu, and then select Save to Contacts.
4. Enter the information for the entry.
5. Press OK.

### Making a second call

You can make a second call while your first call is still active. When you dial a second number, the first call is automatically placed on hold.

To dial a second number, use any of the methods described in Making calls from the Today screen. If you’re dialing by contact name or with the keyboard, you must first use the 5-way to select the Dial Lookup field.

When two calls are active, your Today screen includes two call status sections, each representing one of the calls.
Answering a second call (call waiting)
When you’re on a call and you receive a second call, the call-waiting notification appears. You can do any of the following:

**Place the current call on hold and answer the new call:**
Press Answer (left action key) or Phone/Send (right action key).

**Send the new call to voicemail:** Press Menu (right action key) and select Ignore.

**Send the new caller a text message:**
Press Menu (right action key) and select Ignore with text message. The second call is sent to voicemail.

**Hang up both calls:** Press Power/End (left action key). The second call is sent to voicemail.

**Making a conference call**
When the second call is outgoing, you can join two calls in a conference session. Additional charges may apply and minutes in your mobile account may be deducted for each active call. Please contact Verizon Wireless for more information.

1. Put the first call on hold, and then place a second call.

2. Press Conference (left action key); this joins the two active calls in a conference.

3. After you finish the conference, press End Conference (left action key); this ends the second call and returns you to the first call. If you’re ready to hang up both calls, press Power/End (left action key) instead.
Using Flash mode during an Active call

Flash mode is an alternate way to manually manage your calls while one or more calls are active. The preferred methods for managing multiple calls are described in Making a second call, Answering a second call (call waiting), and Making a conference call. But when these methods don’t work, you can use Flash mode. This mode is often used during a conference call when one of the calls has ended but the other remains connected.

1. Press **Phone/Send (left action key)** from the **Active Call** screen.

2. Select **Send Key (Flash)**.

3. Press **Flash (left action key)**. Depending on the state of your active call, pressing Flash does one of the following:
   - If you have one active call, pressing **Flash (left action key)** puts the call on hold. To take the call off hold, press **Flash (left action key)** again.
   - If you have two active calls and at least one of the calls is an incoming call, pressing **Flash (left action key)** swaps between the two calls.
   - If you have two active calls and both of the calls are outgoing, pressing **Flash (left action key)** conferences the two calls.
   - If you have two calls in conference, pressing **Flash (left action key)** hangs up the second call. You can then dial another number.

4. Press **Power/End (left action key)** to exit Flash mode and end all calls.
Forwarding calls
You can forward calls to another phone number. Please check with Verizon Wireless about availability and pricing of forwarded calls; additional charges may apply.

1. Go to your Today screen.
2. Dial *72 followed by the number where you want to forward your calls. For example: *72 415-555-1234.
3. Press Phone/Send to dial.
4. When you’re ready to turn off call forwarding, dial *73, and then press Phone/Send.

**TIP** If *72 and *73 do not turn call forwarding on and off, please contact Verizon Wireless to obtain the forwarding codes for your area.

After you turn on call forwarding, call your smartphone to confirm that call forwarding is active.

Viewing minutes usage
1. Go to the Call Log (see Redialing a recently called number).
2. Press Menu (right action key) and select Call Timers to view voice minutes or Data Log to view data minutes.
3. (Optional) To reset the counters to zero, select Reset.
4. Press OK.

**TIP** Keep in mind that your billing statement may vary slightly from the information you see onscreen. Usage is charged based on your calling plan, and calling plans vary.

Defining speed-dial buttons
Your smartphone lets you create both picture and text speed-dial buttons so that you can select a button on the Today screen to quickly dial a number.
Creating a speed-dial button

You can create up to 20 picture buttons and 50 text buttons.

1. Go to your Today screen.
2. Press Menu (right action key) and select New Speed Dial.
3. Do one of the following:
   - Select Link, select Link to contact, select the contact you want to link to this button, and then select the number you want to dial with this button.
   - Select Label and enter a name for this button, and then select Number and enter the phone number you want to dial with this button.
4. (Optional) Enter a Quick Key. When the Today screen is showing, you can press and hold the Quick Key to instantly dial this phone number.

TIP Quick Keys can be letters or numbers, but you can’t use both the letter and number for the same key. For example, the voicemail Quick Key is 1. The letter equivalent for that key is E, so you cannot assign E as a Quick Key to another speed-dial button.

5. If this button is linked to a contact entry with a picture, select either Text Speed Dial or Picture Speed Dial to indicate which type of button you want to create.

TIP You can add a special ringtone to a contact associated with the speed-dial button. See Adding a contact.
6 (Optional) Select the **Advanced** tab and set any of the following options:

**Extra Digits:** Defines additional numbers to dial, such as a password or extension. In addition to numbers, you can enter the star symbol (*) or the pound sign (#). To enter a one-second pause, enter a comma (,).

**Dial extra digits automatically:** Dials predefined Extra Digits immediately after dialing the phone number. If you do not check this box, you need to press **Extra Digits** (left action key) to dial these digits.

**Show voice mail buttons:** Displays the voicemail playback controls after you dial this speed-dial number. When this option is checked, you can enter numbers below each control to tailor the controls to your voicemail system.

- Plays the previous message
- Saves the current message
- Plays the current message
- Deletes the current message
- Repeats the current message
- Plays the next message

**TIP** The playback controls for the Verizon Wireless Voicemail speed-dial button are already set up for the Verizon Wireless voicemail system.

7 Press **OK** 🔄.
Editing a speed-dial button
1. Go to your Today screen.
2. Highlight the speed-dial button you want to edit.
3. Press and hold Center to open the shortcut menu, and then select Edit Speed Dial.
4. Make the desired changes.
5. Press OK.

Deleting a speed-dial button
1. Go to your Today screen.
2. Highlight the speed-dial button you want to delete.
3. Press and hold Center to open the shortcut menu, and then select Edit Speed Dial.
4. Press Delete.
5. Select Yes to confirm the deletion.

Arranging your speed-dial buttons
1. Go to your Today screen.
2. Press Menu (right action key) and select Speed Dial Options.
3. Highlight the button you want to move.
4. Press Option + Left or Right to move the button left or right.

**TIP** You can also edit a speed-dial button by pressing Menu and selecting Speed Dial Options, and then selecting the button you want to edit.
Using a phone headset

You can connect a phone headset for hands-free operation. If you need to use your smartphone while driving and this is permitted in your area, we recommend using a phone headset or a hands-free car kit (sold separately).

The headset button is context-sensitive, so it performs various actions based on the situation. You can press the headset button to perform any of the following tasks:

- Answer an incoming call
- Respond to call waiting
- Hang up all calls
- Swap between calls if the second call is an incoming call
- Create a conference call if the second call is an outgoing call

**TIP** You can use the headset that came with your smartphone or compatible third-party headsets.

**TIP** The headset designed for Palm® Treo™ 180/270/300 smartphones is not compatible with the Treo 700wx smartphone.
Headset specifications

Your smartphone works with headsets that have a 2.5mm, 3-pin connector (look for two black bands on the plug). When in doubt, ask the third-party headset manufacturer if the product is compatible with Palm Treo 700wx smartphones. If you hear a headset buzz or poor microphone performance, your headset may be incompatible with your smartphone.

Using a hands-free device with Bluetooth® wireless technology

Your Treo 700wx smartphone is also compatible with many headsets and car kits enabled with Bluetooth® wireless technology version 1.1 or 1.2, as well as the A2DP and AVRCP profiles.

For a list of compatible hands-free devices with Bluetooth wireless technology, go to http://www.palm.com/us/products/smartphones/treo700w/bluetooth.html.

To learn how to set up and connect to Bluetooth devices, see Connecting to devices using Bluetooth wireless technology.

Additionally, your smartphone includes software that enables you to choose settings for the THB car kit (car kit sold separately). To access these car kit settings do the following:

1. Press Start ‡ and select Settings.
2. On the Personal tab, select THB Kit 🚗.

Here are tips for working with a Bluetooth hands-free device:

- To transfer a call from the handset to a Bluetooth hands-free device during a call, press Menu (right action key) and select Connect Bluetooth. To transfer the call back to the headset, press Menu (right action key) and select Cancel Bluetooth.

- To transfer a call from a wired headset to a Bluetooth headset or car kit that is within range and with which you’ve previously set up a partnership (Bluetooth headset or car kit required, sold separately), unplug the wired headset and press the button on the Bluetooth headset or car kit.
Phone settings

**BEFORE YOU BEGIN** Turn on your phone to access your Phone Settings. See Turning your smartphone on/off.

**Selecting ringtones and vibrate settings**

You can set various tones for various types of incoming phone calls and notifications.

**DID YOU KNOW?** You can download MP3, MIDI, QCELP, WAV, and WMA ringtones directly to your smartphone (see Downloading files and images from a web page). You can also download ringtones to your computer and then email them to your phone.

1. Press **Start** and select **Settings**.
2. On the Personal tab, select **Sounds & Notifications**.
3. Make sure your phone is on.

**NOTE** If your phone is off, the notification tab changes to allow you to select general notification settings. See Selecting Sounds & Notifications.

4. Select the **Notifications** tab.
5. Select the **Event** list, and then select which type of call or notification you want to set the ringtone for:

**Phone: Known Caller:** An incoming call from someone in your Contacts list or Speed-Dial list.

**DID YOU KNOW?** If you have both a compatible Bluetooth headset and car kit, the one you connected to your smartphone last becomes the active device.

**TIP** To find out how to transfer your contacts from your smartphone to your car kit, go to http://www.palm.com/us/products/smartphones/treo700w/bluetooth.html.
**Phone: Missed call:** A call you did not answer.

**Phone: Roaming:** A call that comes in when you’re outside your home wireless network.

**Phone: Unknown Caller:** An incoming call from someone identified by caller ID who is not in your Contacts list or Speed-Dial list.

**Phone: Voice mail:** A new voicemail.

6 Select the **Ring type** list, and then select the ring style for the selected type of call.

7 Select the **Ring tone** list, and then select the sound for the selected type of call.

8 Check the **Vibrate when...** boxes to turn the vibrate feature on/off based on the Ringer switch setting.

9 (Optional) Select **Play** to preview the sound.

10 Repeat steps 4–7 to select ringtones for other types of calls.

11 Press **OK** 🍂.

---

**TIP** To record, preview, delete, and send sounds on your smartphone, select **Manage**. To record a sound, press **Menu** and select **New Sound**. To play a sound, select it. To delete a sound, highlight it and press **Backspace**. To send a sound, highlight it, press **Menu**, and select **Send Sound**.

**DID YOU KNOW?** You can also set sounds for messaging notifications and calendar reminders. See **Selecting Sounds & Notifications**.

**Adjusting volume settings**

Press the **Volume** button (on the side of your smartphone) to adjust the sound for any of the following:

- A call in progress
- Music and videos
- Ringer (adjust the ringer volume when you’re not on a call or listening to music or video)
Assigning a picture and ringtone ID to a contact

1. Press Start and select Contacts.
2. Highlight the contact to whom you want to give a picture caller ID, and then press Center.
3. Highlight the contact’s name, and press Edit (left action key).
4. Select Picture, and then press Center.
5. Select Camera to take a picture and add it to this contact entry, or select an existing picture for this contact entry.
6. Select Ring tone, and then press Center. Select a tone for this contact entry.

Selecting your call settings

BEFORE YOU BEGIN Turn on your phone to access your Phone Settings. See Turning your smartphone on/off.

1. Press Start and select Settings.
2. On the Personal tab, select Phone.

3. On the Phone tab, set any of the following options:
   - **Dialpad**: Sets the style for the Dial Pad tones (DTMF) in the Phone application.
     - **Short tones**: Tones sound briefly as you dial.
     - **Long tones**: Tones continue to sound until you release the key.
   - **TTY/TDD**: Lets you configure your smartphone for use with a TTY/TDD device for people who are deaf or hard of hearing.

   TIP If you have trouble accessing a voicemail system, try changing the Dialpad tone setting.
After calls from numbers that are not in Contacts, ask if I want to add them: Indicates whether you are prompted to add contact entries for numbers that are not already in your Contacts list.

4 Press OK to finish.

### Setting your dialing preferences

Dialing preferences let you assign a prefix to your phone numbers. For example, you can automatically dial a 1 before all 10-digit phone numbers. You can add a different prefix based on the length of the phone number.

1 Press Start and select Settings.
2 On the Personal tab, select Phone.
3 Select the Dialing tab and set any of the following options:

**Dialing from North America:** Formats phone numbers using North American conventions (XXX-XXX-XXXX).

**Always dial 1 in front of the area code:** Adds a 1 in front of 10-digit phone numbers. This option is available only when North American Dialing is enabled.

**International Dialing Prefix:** Adds the specified number in front of international phone numbers. (When an international number beginning with “+” is dialed, the “+” is replaced with the number in this field.)

4 Press OK to finish.

### Setting your abbreviated dialing preferences

Abbreviated dialing automatically completes a phone number when you enter a shortened version of that number. Shortened phone numbers are typically used in corporate phone systems that
allow internal users to dial an extension number rather than the complete number. For example, if your co-worker’s phone number is 1-555-222-1234, you may need to dial only the last five digits of that number from an internal phone. In that case, you would dial 21234. If that shortened five-digit internal number appears in your contact list or in a corporate Global Address List (GAL), your smartphone attempts to dial an incomplete number because it is not on the internal phone network.

If that is the case, use the abbreviated dialing settings to automatically complete shortened numbers. For example, if all the phone numbers in your office begin with 1-555-22, followed by a five-digit extension, set your smartphone to automatically enter 1-555-22 as the prefix before any five-digit number. When you enter your colleague’s five-digit extension, your smartphone automatically dials 1-555-22 plus the five-digit extension. The complete number is 1-555-222-1234.

1. Press Start and select Settings.
2. On the Personal tab, select Phone.
3. Select the Dialing tab and then select Abbreviated Dialing.
4. Check the box that corresponds to the number of digits you want your smartphone to dial (3, 4, 5, 6, or 7). Selecting the option adds a prefix to numbers with the specified number of digits.
5. Press OK to finish.

Selecting your privacy settings
1. Press Start and select Settings.
2. On the Personal tab, select Phone.
3. Select the Services tab and set any of the following options:
   Voice Privacy: Prevents over-the-air eavesdropping when this option is
turned on and this feature is available on the Verizon Wireless network.

**Location Privacy:** Indicates whether your smartphone broadcasts your location at all times, or only during a 911 call.

**TIP** For quick access to the Location Privacy setting, tap the **Location Privacy** icon on your Today Screen (see What are all those icons?).

**Selecting your wireless band**

**IMPORTANT** The wireless band setting is preset for optimum performance. Do not change this setting unless instructed to do so by a Verizon Wireless representative. Changing this setting may affect your wireless service. For more info, contact Verizon Wireless.

1. Press **Start** and select **Settings**.
2. On the Personal tab, select **Phone**.
3. Select the **Services** tab.
4. Select **Network**.

4. Press **OK** to return to Phone Settings.
5. Press **OK** to finish.

5. Select the **Band selection** list, and then select the band you want your smartphone to use to connect to the Verizon Wireless network.
Setting roaming preferences

Sometimes you are in a location that’s not covered by the Verizon Wireless network, and yet you can still make phone calls. That’s because you’re within network coverage of a wireless service provider with which Verizon Wireless has a roaming agreement.

When you roam outside the Verizon Wireless network, the roaming icon appears at the top of the screen. Additional charges may apply if you use your smartphone while roaming. To learn more about roaming charges, contact Verizon Wireless.

Things to keep in mind when using roaming services:

- You can make and receive calls while roaming.
- Other features, such as call waiting and voicemail, may be available depending upon your roaming network.
- Data services may not be available when you are roaming on partner networks.

Use Network Preferences to set specific options for using your phone while roaming. For example, you can set an option to be notified that you are roaming before placing a call or making a data connection, so that you are aware that you might incur extra charges.

1. Press Start and select Settings.
2. On the Personal tab, select Phone.
3. Select the Services tab.
4. Select Network.
5. Check the boxes to enable either or both of the following roaming options:

   **Before outgoing calls**: Causes an alert to appear, warning you that you are on a roaming network when you attempt to dial an outgoing call.

6. Press OK to finish.
Before data connections: Prevents a data connection while roaming. An alert appears, warning you that you are on a roaming network when you attempt to make a data connection.

NOTE You can dismiss the warning and make the data connection by selecting the Don’t show this again. Always connect when roaming box. You must then attempt to make a data connection again.

6 Press OK 📦.

What are all those icons?

You can use the icons on your Today screen to monitor the status of several items:

- You missed an incoming call.
- You have a voicemail message.
- You have a new email, text, or multimedia message.

An error occurred during synchronization.

You have more than one of the conditions listed above.

Your phone is on. The bars display the signal strength. The stronger the signal, the more bars that appear. If you are outside a coverage area, no bars appear.

Your phone is off.

You are outside a Verizon Wireless coverage area and are roaming on another wireless service provider’s network.

A voice call is in progress.

You are in an area that supports NationalAccess (1xRTT) data services.

You are in an area that supports BroadbandAccess (EVDO) data services.
A NationalAccess data call is in progress. You can make calls, but you cannot receive calls; any incoming calls go to voicemail. When you make a call, the data transmission is automatically interrupted.

A BroadbandAccess data call is in progress. You can still make or receive calls. When you make or receive a call, the data transmission is automatically interrupted.

Your phone is connected to a NationalAccess network, but you are not actively transmitting data. You can still make or receive calls.

Your phone is connected to a BroadbandAccess network, but you are not actively transmitting data. You can still make or receive calls.

Your smartphone is connected to a computer or network that is providing a data connection.

A data connection is not available or your phone is off.

Your smartphone’s battery is low.

Your smartphone’s battery is being charged.

Your smartphone is connected to a power outlet and the battery is fully charged.

Your phone is on and you’re in a Verizon Wireless coverage area. If you’re roaming on another wireless service provider’s network, Roaming or Extended Network appears instead. If you’re outside a coverage area, No service appears instead, and when you turn off your phone, Phone Off appears instead.
Voice privacy is preventing over-the-air eavesdropping. This icon appears during a call when this option is turned on and this feature is available on the Verizon Wireless network.

Location privacy is turned off. Your smartphone is broadcasting your GPS location. The whereabouts of your smartphone can be determined by the Verizon Wireless network, by emergency agencies like 911, and also by other apps on your smartphone.

Location privacy is turned on. The GPS location of your smartphone can be determined by emergency call operators only. Your smartphone’s location cannot be determined by the Verizon Wireless network or other apps on your smartphone.

Bluetooth wireless technology is turned off.

Bluetooth wireless technology is turned on.

Your smartphone is communicating with another Bluetooth device.

A call is in progress and your smartphone is connected to a Bluetooth headset or car kit.
Synchronizing information

Synchronizing simply means that information that has been entered or updated in one place—your Palm® Treo™ 700wx smartphone, your computer, or your corporate server—is automatically updated in the other. There’s no need to enter information twice. Some kinds of synchronization can happen on an automated schedule, so you don’t even have to think about it.

After you get into the habit of synchronizing regularly, you’ll know what a powerful tool synchronization is for transferring, updating, and backing up large amounts of information on your smartphone.

**Benefits**

- Quickly enter and update information on your computer and your smartphone
- Protect your information
- Send photos and videos to your smartphone from your desktop computer
In this chapter

How do I synchronize? ......................................................... 64
What can I synchronize? ..................................................... 65
Setting up your computer for synchronization ....................... 67
Synchronizing using the sync cable .................................... 70
Setting up wireless synchronization .................................... 71
Other ways to synchronize .................................................. 75
Setting synchronization options ....................................... 77
This chapter discusses using ActiveSync® desktop software and other methods to synchronize your smartphone and your computer.

Synchronization enables you to enter or change information on your smartphone or in Microsoft Office Outlook®. Your info is then automatically updated in both places; there’s no need to enter the info twice. This is true whether you sync with your computer using ActiveSync desktop software (see Setting up your computer for synchronization) or wirelessly with your company’s Exchange Server using Microsoft Exchange ActiveSync (see Setting up wireless synchronization).

By default, the info from the following applications is synchronized when you use either method of synchronization:

- Contacts
- Calendar
- Tasks
- E-mail

You can, however, customize sync settings to suit your needs and sync only some of these applications.

If you set up ActiveSync synchronization with your computer, information in the Favorites application is synchronized by default as well. You can also change the synchronization settings to include Word, Excel®, PowerPoint®, and PDF files, as well as pictures, music, videos, and other types of files (see Selecting which info to sync). For synchronization of music and videos, you must also have Windows Media® Player 10 on your computer.

**DID YOU KNOW?** When you sync Favorites, it creates a folder in your computer’s web browser called Mobile Favorites that backs up any favorites you create in the browser on your smartphone. You can add or remove favorites directly to or from the folder.

**TIP** If you don’t already have Windows Media Player installed on your computer, you can install it from the Getting Started CD. Insert the CD into your computer’s CD drive, select Add Programs, and then select Windows Media Player.

You can set up your smartphone to use any combination of wireless synchronization, ActiveSync synchronization, and Windows Media Player synchronization.
How do I synchronize?

There are a number of ways to synchronize your information. You can install ActiveSync desktop software on your computer to synchronize in one of a number of ways, or you may be able to synchronize wirelessly with an Exchange Server. You can, of course, maximize your sync options and sync with both an Exchange Server and with ActiveSync desktop software.

**Synchronizing with ActiveSync desktop software**

**BEFORE YOU BEGIN** Install the software from the Getting Started CD, which came with your smartphone. You must install this software even if you have already installed a previous version of ActiveSync desktop software. See Installing the desktop synchronization software for instructions.

If you install ActiveSync desktop software from the Getting Started CD, you can choose to synchronize in any of the following ways:

- By connecting your smartphone to your computer using the sync cable; see Synchronizing using the sync cable.
- Wirelessly, using the built-in Bluetooth wireless technology on your smartphone; see Synchronizing over a Bluetooth connection.
- Wirelessly, using the infrared (IR) port on your smartphone; see Synchronizing over an infrared connection.

**Synchronizing wirelessly with the server**

You can set up your smartphone to synchronize email and other information wirelessly with Microsoft Exchange Server 2003 using Microsoft Exchange ActiveSync; see Setting up wireless synchronization. If you choose this method, synchronization takes place automatically after setup; you do not need to install the software from the Getting Started CD, which came with your smartphone.
We recommend that you install ActiveSync desktop software from the CD even if you synchronize wirelessly with the server. You need ActiveSync to synchronize pictures, videos, music files, and other info directly with your computer.

### What can I synchronize?

This table lists the types of info you can synchronize and the methods to use.

<table>
<thead>
<tr>
<th>Info type</th>
<th>Method</th>
<th>Where to learn more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outlook Contacts, Calendar, Tasks</td>
<td>ActiveSync (sync with computer) or Exchange ActiveSync (direct sync with server)</td>
<td>Setting up your computer for synchronization or Setting up wireless synchronization</td>
</tr>
<tr>
<td>Outlook Email</td>
<td>ActiveSync or Exchange ActiveSync</td>
<td>Setting up your computer for synchronization or Setting up wireless synchronization</td>
</tr>
</tbody>
</table>
| Word, Excel, PowerPoint, PDF files | ActiveSync                                 | Setting up your computer for synchronization  
Synchronizing your Microsoft Office files  
Selecting which info to sync |
<table>
<thead>
<tr>
<th>Info type</th>
<th>Method</th>
<th>Where to learn more</th>
</tr>
</thead>
<tbody>
<tr>
<td>Music and video files</td>
<td>ActiveSync and Windows Media Player 10</td>
<td>Setting up your computer for synchronization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selecting which info to sync</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transferring media files to your smartphone</td>
</tr>
<tr>
<td>Pictures</td>
<td>ActiveSync</td>
<td>Setting up your computer for synchronization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selecting which info to sync</td>
</tr>
<tr>
<td>Outlook Notes</td>
<td>ActiveSync</td>
<td>Setting up your computer for synchronization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selecting which info to sync</td>
</tr>
<tr>
<td>Favorites</td>
<td>ActiveSync</td>
<td>Setting up your computer for synchronization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selecting which info to sync</td>
</tr>
<tr>
<td>Files to be transferred to an expansion card</td>
<td>ActiveSync</td>
<td>Setting up your computer for synchronization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Selecting which info to sync</td>
</tr>
</tbody>
</table>
Setting up your computer for synchronization

Why set up a connection between your smartphone and your computer? So you can synchronize them. Why synchronize? Here are two good reasons:

- Once you enter info on your computer, you don’t need to enter it again on your smartphone. Whether you enter or change information on your computer using Microsoft Office Outlook or on your smartphone, when you synchronize, you automatically update the info in both places.
- You have a backup copy of all your info. Should anything happen to your smartphone, your info still exists on your computer.

We strongly recommend that you synchronize your smartphone with your computer frequently to keep your information up-to-date (and backed up) in both locations.

**TIP** If you want to synchronize with a personal information manager (PIM) other than Microsoft Office Outlook, you must install a third-party solution. Contact the PIM’s vendor to learn if software is available for your smartphone.

Before you can synchronize, you need to install the desktop synchronization software and connect the sync cable to your computer. Even if you have already installed a previous version of ActiveSync desktop software, you must install the software that came with your smartphone on the Getting Started CD.

**System requirements**

Your computer should meet the following minimum system requirements:

- Windows 2000 or XP (later versions may also be supported)
- 32MB of available memory (RAM)
- 170MB of free hard disk space
- CD drive
- Available USB port
- USB sync cable (included with your smartphone)
Installing the desktop synchronization software

**BEFORE YOU BEGIN** Check the following:

- You must have Windows Media Player 10 or later installed on your computer if you want to sync music, pictures, and videos.
- If you are installing on a computer at work, make sure your company allows you to install new software. Contact your company’s IT department for help.

1. Close any applications that are currently running on your computer, including those running in the background. Your computer must have all its resources available to install the software.
2. Insert the **Getting Started CD** into the CD drive on your computer.
3. Follow the onscreen instructions during the installation. The Install program prompts you to connect your smartphone to your computer and synchronize for the first time.

**TIP** Need additional help installing the desktop software? See “Trouble installing the desktop software?”

Using ActiveSync desktop software

After you install ActiveSync desktop software, synchronization happens automatically anytime you connect your smartphone to your computer, as described in the next section. However, you can open the ActiveSync window on your computer to do tasks such as the following:

- Install applications from your computer to your smartphone (see Installing applications from your computer) or to an expansion card inserted into the expansion card slot on your smartphone (see Installing applications onto an expansion card)
- Change which applications synchronize
- Enter settings to synchronize wirelessly with Microsoft Exchange Server 2003
To open the ActiveSync window, double-click the **ActiveSync** icon in the taskbar in the lower-right corner of your computer screen.

**DID YOU KNOW?** You can also change which applications synchronize (see Selecting which info to sync) and enter settings to synchronize wirelessly (see Setting up wireless synchronization) in the ActiveSync app on your smartphone. Whether you enter changes on your smartphone or your computer, the changes are transferred to the other location the next time you synchronize.

Desktop software installation also creates a Mobile Device folder on your computer, which you can see when you open My Computer or Windows Explorer. When your smartphone is connected to your computer, opening the Mobile Device folder displays an icon representing your smartphone. It also displays folders containing items you synchronized, such as music files, pictures, and videos.

### Connecting your smartphone to your computer

**NOTE** If you’re transferring from a previous Windows Mobile® device or from a Palm OS® device, you can learn more about how to move content, such as pictures, music, and files, to your smartphone by going to [www.palm.com/treo700wx-support](http://www.palm.com/treo700wx-support).

1. Connect the **AC charger** to a wall outlet. If necessary, connect an adapter.
2. Connect the **USB sync cable** to an available USB port or to a powered USB hub on your computer.

**TIP** If the ActiveSync icon does not appear in the taskbar, go to **Start**, navigate to **Programs**, and select **Microsoft ActiveSync** to open the ActiveSync window.

**TIP** For best performance, connect your sync cable directly to a USB port on your computer. If your computer has USB ports on both the front and back, we suggest using the back port. If you use a USB hub, make sure it is a powered hub.

3. With the USB cable on the left, connect the **sync cable** to the bottom of your smartphone.
4 Connect the charger cable to the connector on the sync cable.

Synchronizing using the sync cable

After you install ActiveSync desktop software, synchronization takes place automatically anytime your smartphone is connected to your computer and info is updated in either location.

1 Connect your smartphone to your computer. You should hear the ActiveSync tone.

2 Look for the ActiveSync icon at the top of your smartphone’s screen and the ActiveSync icon in the taskbar on your computer.
   - If you don’t see the ActiveSync icon, make sure the desktop synchronization software that came with your smartphone is running on your computer.
   - If you have any problems synchronizing, see Synchronization (ActiveSync software) for troubleshooting suggestions.
Setting up wireless synchronization

Does your company use Microsoft Outlook as its email solution? Does your company also use Microsoft Exchange Server 2003 as its email server? If so, you may be able to wirelessly synchronize the email and other Outlook info on your smartphone and the same info stored on the Exchange Server using Microsoft Exchange ActiveSync.

When the Exchange Server is upgraded to Service Pack 2, you may be able to take advantage of the additional features of Direct Push Technology. Direct Push Technology is a two-way wireless delivery method that keeps your Outlook information always up-to-date and provides more efficient communication between the server and your smartphone. It includes features like Global Address List, Tasks Over The Air (OTA), and IP-based push updating of Calendar, Messaging, and Email.

**BEFORE YOU BEGIN** To synchronize wirelessly, you need to set up an Exchange Server Account. Before following the steps in this section to set up an account, work with your system administrator to gather the following information:

- Mail server address and domain name.
- The username and password you use to access your corporate mail server.
- Does your company’s security policy prohibit storing your corporate email password on your smartphone?
- Security connection: Does your server use an encrypted (SSL) connection?

**TIP** A backup and restore app preserves your data and settings if your smartphone is ever lost or stolen, and it protects your data during a hard reset. For info on backup applications, go to [www.palm.com/mytreo700wxVerizon](http://www.palm.com/mytreo700wxVerizon).

**DID YOU KNOW?** Because your desktop copy of Outlook also syncs with the server, whatever is synchronized to the server from your smartphone also shows up in Outlook; and whatever you enter or change in Outlook on your computer syncs to the server and then shows up on your smartphone.
1. Press **Start** and select **Programs**.

2. Select **ActiveSync**.

3. Press **Menu** (right action key) and select **Add Server Source**.

4. Enter the server address, and then press **Next** (right action key).

5. Enter the username and password you use to access your corporate mail server, and enter the Exchange Server domain. Check the box if your server uses an encrypted connection.

You can’t see your password as you enter it, so be careful. Be sure Caps Lock and Option Lock are not on unless you need them. For info on how to enter characters, see Entering lowercase and uppercase letters and Entering numbers, punctuation, and symbols.

6. Check the **Save password** box.

**TIP** The Exchange Server settings are case-sensitive. Be sure to enter uppercase and lowercase letters properly.
7 (Optional) Select Advanced to set the rules for fixing sync conflicts.

8 Press Next (right action key) and check the boxes for the types of information you want to synchronize with the Exchange Server.

9 (Optional) Highlight one of the items and select Settings to change the synchronization settings for that type of information. Settings are not available for all items.

TIP Ask your system administrator if it is OK to store your corporate email password on your smartphone (for increased security, you may need to enter your password each time you access your email). If it is not OK, you must synchronize manually (see Initiating wireless synchronization manually).

TIP To automatically download more of an incoming email message than the default setting, select E-mail in step 9 and increase the KB setting. If you don’t increase this setting, you can manually download the rest of the message at your convenience.

10 Press Finish (right action key). Synchronization with your Exchange Server begins automatically. A status bar appears onscreen, indicating sync progress.

You can set a schedule for synchronization to take place anytime info is updated on either your smartphone or the server or at certain intervals (see Setting the synchronization schedule), or you can allow synchronization to take place only when you initiate it manually (see Initiating wireless synchronization manually).
Setting the synchronization schedule
You can set a synchronization schedule in either of the following situations:

If your Microsoft Exchange Server 2003 is upgraded to Service Pack 2: By default, wireless synchronization takes place anytime info is updated on either your smartphone or the server using Direct Push Technology. To save battery life, however, you can set synchronization to take place at intervals that you specify.

If your Microsoft Exchange Server 2003 is not upgraded to Service Pack 2: By default, wireless synchronization does not take place automatically. Set a synchronization schedule to have synchronization take place either anytime info is updated on your smartphone or on the server, or at certain intervals. Keep in mind, that synchronizing anytime info is updated uses text messaging, so additional text messaging charges may apply. Contact Verizon Wireless for info on your current text messaging rate plan.

1 Press Start (right action key) and select Programs.
2 Select ActiveSync (right action key).

3 Press Menu (right action key) and select Schedule.

4 Set any of the following options:

Peak times: Sets the frequency for high-traffic time periods such as when you are at work or when email volume is high.

Off-peak times: Sets the frequency for low-traffic time periods such as late at night.

Use above settings while roaming: Sets the frequency while you are roaming outside the Verizon Wireless network. You should keep this box checked to ensure that wireless synchronization works properly.
Send outgoing items immediately:
Sets whether items are sent as soon as you select Send in the Inbox application, or whether they are held until the next synchronization.

5 Press OK.

Initiating wireless synchronization manually
If you want to control exactly when wireless synchronization takes place, or if it is not OK to store your corporate email password on your smartphone, you can initiate synchronization manually.

1 To set up manual sync, follow the preceding procedure, Setting the synchronization schedule. In the Peak times and Off-peak times lists, select Manual.
2 To initiate a manual sync, press Start and select Programs.
3 Select ActiveSync.
4 Press Sync (left action key).

Other ways to synchronize

Synchronizing over a Bluetooth connection
You can wirelessly synchronize your computer and smartphone using Bluetooth wireless technology.

BEFORE YOU BEGIN Do the following:
• Make sure your computer is equipped with Bluetooth® wireless technology.
• If you did not do so during initial setup, install the ActiveSync Plug-in for Bluetooth wireless technology from the Getting Started CD.

TIP To install the plug-in for Bluetooth technology, insert the Getting Started CD into your computer’s CD drive, and then select Add Programs. Select the plug-in option on the Add Programs screen and follow the onscreen instructions.
1. On your computer, right-click the ActiveSync icon in the taskbar in the lower-right corner of the screen, and select Connection Settings.

2. Check the Allow connections for one of the following box, and then select Bluetooth.

3. On your smartphone, press Start and select Settings.

4. Select the Connections tab, and then select Bluetooth.

5. Check the Turn on Bluetooth box to turn on the Bluetooth feature on your smartphone.

6. Press Start and select Programs.

7. Select ActiveSync.

8. Press Menu (right action key) and select Connect via Bluetooth.

9. If this is the first time you’re making a Bluetooth connection to this computer, follow the onscreen prompts to set up a Bluetooth partnership with this computer. See Connecting to devices using Bluetooth wireless technology for more information on partnerships.

10. Select Sync.

11. When synchronization has finished, press Menu (right action key) and select Disconnect Bluetooth.

Synchronizing over an infrared connection
If your computer has an IR (infrared) port, you can synchronize with your computer wirelessly using the IR port on your smartphone.

BEFORE YOU BEGIN Make sure your computer is equipped with an IR port.

1. Set up your computer to receive infrared beams. See ActiveSync Help on your computer for details.

2. Point the IR port on your smartphone directly at the IR port on your computer.

3. On your smartphone, press Start and select Programs.

4. Select ActiveSync.

5. Press Menu (right action key) and select Connect via IR.

6. Select Sync.
Synchronizing with multiple computers
You can set up your smartphone to synchronize with up to two computers as well as with Exchange Server 2003. When synchronizing with multiple computers, the items that you synchronize appear on all the computers.

For example, if you set up to sync your smartphone with two computers named Windows PC and Windows PC2, when you sync Contacts and Calendar on your smartphone with both computers, you get the following results:

- The contacts and calendar appointments that were on Windows PC are now also on Windows PC2.
- The contacts and calendar appointments that were on Windows PC2 are now also on Windows PC.
- The contacts and calendar appointments from both computers are on your device.

**NOTE** Microsoft® Office Outlook® E-mail can synchronize with only one computer.

Setting synchronization options

Selecting which info to sync

1. Press **Start** and select **Programs**.
2. Select **ActiveSync**.
3. Press **Menu** (right action key) and select **Options**.
4. Do any of the following:
   - Check the box next to any items you want to synchronize. If you cannot check a box, you might have to uncheck a box for the same information type elsewhere in the list.
• Uncheck the box next to any items you want to stop synchronizing.
• Select an item and then select Settings to customize the settings for that item. Settings are not available for all items.

**TIP** To stop synchronizing with one computer completely, select the computer name and then select **Delete**.

**Stopping synchronization**
If you ever need to manually stop synchronization, follow these steps:

1. Press **Start** and select **Programs**.
2. Select **ActiveSync**.
3. Press **Stop** (left action key).

**TIP** To stop synchronizing all items on a computer, select the computer name and then select **Delete**.
Your email and other wireless services

Your smartphone brings you email on the go. Enjoy the ease and speed of communicating with friends, family, and colleagues anywhere you can access the Verizon data network.

If you need to get a short message to a friend or a co-worker fast, send a text or multimedia message from your smartphone to their mobile phone or email address.

With your smartphone’s built-in web browser, you can take the web with you almost anywhere you go. And your smartphone’s built-in Bluetooth® wireless technology helps you easily set up wireless connections to a number of devices.

**Benefits**

- Receive photos, sound files, Word and Excel® files, and more
- Attach and send files of almost any type
- Use text messaging to chat with friends
- Carry the web with you
- Connect to Bluetooth headsets and car kits
In this chapter

Sending and receiving messages and email .......................... 81
Using Pocket MSN .................................................................. 102
Browsing the web ..................................................................... 103
Connecting to devices using Bluetooth wireless technology ..... 109
Beaming information with IR ................................................. 114
Using your smartphone as a wireless modem ....................... 116
Sending and receiving messages and email

BEFORE YOU BEGIN  Do the following:

• Make sure your phone is on before you send or receive messages.
• For delivery of Outlook® email using Direct Push Technology, install the software from your Getting Started CD. This feature also requires an Exchange Server 2003 upgrade to Service Pack 2.

You can use the Messaging application to exchange email, brief text messages (SMS), and multimedia messages (MMS) with other mobile devices and email addresses that support these forms of messaging. You can also exchange instant messages (IM) with Pocket MSN. Before you use your smartphone to send or receive messages, consult Verizon Wireless for pricing and availability of email, text, multimedia, and IM messaging services.

Creating and sending a text message

Each text message can hold up to 160 characters. To save time, you can select from predefined My Text phrases, such as “Call me” or “On my way.” You can add your own My Text phrases, and if you prefer, you can enter the full message text too.

DID YOU KNOW?  You can send and receive text messages even while you are on a phone call. This is easiest when using a hands-free headset or the speakerphone.

1  Go to your Today screen.
2  Press Messaging (left action key).
3  Press Left until you see Text Messages in the title bar.
4  Press New (left action key).
5. Do one of the following to address the message:

- If the recipient’s name and mobile number are in your Contacts list, type the first few letters of the first or last name or simply enter the first initial, followed by a space, and then the last initial to find a name.

- If the recipient’s name is in an online address book, press Center ➤, enter the name, press Menu ➤ (right action key), and then select Find Online. Select the name, and then select either the phone number or the email address. For more information, see Using an online address book.

- If the recipient’s name and mobile number are not in your Contacts list, enter the full mobile number or email address.

**TIP** To address a message to multiple recipients, separate the addresses with a semicolon (;). If you address a text message to three people, you are billed for three messages.

**DID YOU KNOW?** When addressing a message, you can enter the first few numbers of a contact’s mobile phone number or the contact’s first and last initials separated by a space.

6. Enter your message, or press Menu ➤ (right action key), select My Text, and then select a predefined phrase you want to insert.

**TIP** Some symbols can’t be used in text messages. Invalid characters are automatically replaced by the Messaging application.

7. (Optional) Press Menu ➤ (right action key) and select Spell Check.

8. (Optional) Press Menu ➤ (right action key) and select Message.
**Options.** Enter a callback number and then select **OK**.

9 Press **Send** (left action key).

**Creating and sending a multimedia message**

Multimedia messages consist of pictures, videos, text, and sounds presented as one or more slides. You can include any of the following items:

**Ringtones:** MIDI

**Sound clips:** WAV, QCELP

**Pictures:** JPEG, GIF

**Videos:** 3G2

1 Go to your Today screen.

2 Press **Messaging** (left action key).

3 Press **Left** until you see MMS in the title bar.

4 Press **New** (left action key).

5 Do one of the following to address the message:

- If the recipient’s name and mobile number are in your Contacts list, type the first few letters of the first or last name; or simply enter the first initial, followed by a space, and then the last initial to find a name.

- If the recipient’s name is in an online address book, press **Center** (right action key), enter the name, press **Menu** (right action key), and then select **Find Online**. Select the name, and then select to use either the phone number or email address. For more information, see **Using an online address book**.
• If the recipient’s name and mobile number or email address are not in your Contacts list, enter the full mobile number or email address.

**TIP** To address a message to multiple recipients, separate the addresses with a semicolon ( ; ). If you address a multimedia message to three people, you are billed for one message.

6 Select **Subject** and enter a title for the message.

7 Select **New Slide**.

8 Press **Center** and select one of the following:

**Add Picture:** Lets you insert a picture. You can take the picture with the built-in camera or insert an existing picture.

**Add Video:** Lets you insert a video. You can capture a video with the built-in camera or insert an existing video clip. If you insert a video, you cannot add any more pictures, videos, or sounds to that message.

**Add Sound:** Lets you record a message, such as a voice caption for a picture, or insert an existing sound, such as a ringtone. You can add one sound per slide; to send more than one sound in a message, add another slide to your message. If you capture a picture with the built-in camera and save it with a voice caption, the voice caption does not count as a sound file.

9 Enter a text caption or message for the item you inserted.

**TIP** To add a new My Text phrase, select **Edit My Text Messages** in the list.

10 Select **Next** and repeat steps 8–9 to add other items in this message.

**DID YOU KNOW?** A multimedia message can contain up to 350KB and can consist of multiple items (up to 16 slides).

**TIP** While creating a message, select the arrows at the bottom of the screen to move between slides.

11 (Optional) Select **Preview** to view the message as the recipient will see it.
12 After you finish creating the message, press **OK**.

13 Press **Send** (left action key).

**Receiving text and multimedia messages**

When your phone is on and is in a wireless coverage area, you automatically receive new text messages. For multimedia messages, you can set your smartphone to automatically download new messages or to notify you that messages are ready to download. You can also set your smartphone to notify you when a new text or multimedia message arrives.

The new message notification may include any of the following options:

**View**: Opens the message so you can view its full contents.

**Download**: Downloads the rest of the message from the server.

**Reply**: Opens a message addressed to the sender’s phone number.

**Dismiss**: Closes the notification and puts the message in your Inbox.

**Menu**: Opens a menu where you can select other options.

**DID YOU KNOW?** When you respond to a text message from the SMS list view, you can change the phone number before sending the response. Open the text message and enter your reply. Press **Menu** and select **Message Options**. Check the **Add Call Back Number** box, enter the phone number, and then press **OK**. Press **Send** (left action key) to send the message.
Viewing/playing a multimedia message

1. Go to your Today screen.
2. Press Messaging (left action key).
3. Press Left until you see MMS in the title bar.
4. From the Inbox, select the message you want to view.

5. If you’re viewing the message for the first time, playback begins automatically. Otherwise, select an item to play.
6. Do any of the following:
   - **Go the previous or next slide:** Tap the previous icon or the next icon.
   - **Pause or resume playback:** Tap the pause icon or the play icon.

7. Press OK.

**Save the item that is playing:** Press Menu (right action key) and select Save.

**Go to the top of the message:** Press Menu (right action key) and select Message Overview.

**Reply to the message:** Press Menu (right action key) and select Reply or Reply All.

**Call the sender:** Press Menu (right action key) and select Call Sender.

**Save the message as a template for other messages:** Press Menu (right action key) and select Save to Template.

**DID YOU KNOW?** When viewing a message, you can press Right on the 5-way to move to the next message in that account, or press Left on the 5-way to move to the previous message in that account.
Setting up an email account

You can use your smartphone to access several types of email accounts. Before you set up your email account on your smartphone, you must determine which type of account you want to access, as the steps vary for each of the following account types:

**Exchange Server:** Enables you to wirelessly synchronize your email and other information directly with the information stored on a Microsoft Exchange 2003 Server.

When the Exchange Server 2003 is upgraded to Service Pack 2, new features are available that allow you to access online address books and use Direct Push Technology. These features include Global Address List, Tasks Over The Air (OTA), and IP-based push updating of Outlook information.

Direct Push Technology is the two-way wireless delivery method used between Microsoft Exchange 2003 with SP2 (Service Pack 2) servers and a smartphone with Windows Mobile® 5.0 with MSFP (Messaging and Security Feature Pack) for Outlook information (Email, Calendar, Contacts, and Tasks).

Direct Push Technology uses an Internet Protocol (IP)–based methodology rather than an SMS-based methodology, resulting in lower network overhead, lower costs, and more efficient communications.

**Wireless Sync:** Enables you to use a Verizon Wireless Sync account to wirelessly synchronize your email and other information with the information stored on your computer (Verizon Wireless Sync account required, additional charges may apply).

**IMAP or POP:** Enables you to send and receive email messages with a corporate email account or an account that you have with an Internet service provider (ISP).

**Hotmail:** Enables you to send and receive email messages with an MSN Hotmail account. See Using Pocket MSN for information on setting up an MSN Hotmail account.
Sending and receiving messages and email

Setting up an Exchange Server email account

**BEFORE YOU BEGIN** Do the following:

- Install the software from the Getting Started CD.
- For delivery of Outlook email using Direct Push Technology, make sure that your Exchange Server 2003 is upgraded to Service Pack 2.

You can use your smartphone to sync directly with Exchange Server using Exchange ActiveSync. You may have already set up your Exchange Server email settings when you installed the ActiveSync® desktop software. If you did not set up an Exchange Server email account, then follow the steps in this section to set up an account. However, before you begin, work with your system administrator to gather the following info:

- Mail server address and domain name
- Your username and password

1. Press **Start** and select **Programs**.
2. Select **ActiveSync**.
3. Press **Menu** (right action key) and select **Add Server Source**.

   **TIP** If your email account requires a VPN connection to establish a secure connection, you must install a VPN application (sold separately) on your smartphone before you can access your email. See [Connecting to a VPN](#) for more info.

4. Enter the **Server** address, and then press **Next** (right action key).
5 Enter your username, password, and domain. Your password can use numbers and text, and the password is case-sensitive.

6 If you want to enter your password each time you access this account, do not check the Save password box. If you want your password entered automatically, check this box.

TIP If you have problems sending mail, try using the following outgoing mail settings:
Username: (9-digit phone number)@vzmail.net
Password: (Your www.vtext.com password)

7 (Optional) Select Advanced to set the rules for fixing sync conflicts.

8 Press Next (right action key) and check the boxes for the types of information you want to synchronize with Exchange Server.

9 (Optional) Highlight one of the items and select Settings to change the
synchronization settings for that type of information.

10 Press Finish (right action key).

11 Synchronize with your Exchange Server and set your sync schedule. See Setting a sync schedule with an Exchange Server.

NOTE Settings are not available for all items. If you want to download more than the email message header, select E-mail in step 9 and increase the KB setting. If you don’t increase this setting, you can manually download the rest of the message at your convenience.

Setting a sync schedule with an Exchange Server

BEFORE YOU BEGIN Set up an Exchange Server email account. See Setting up an Exchange Server email account.

Follow these steps to set your sync schedule:

1 Press Start and select Programs.

2 Select ActiveSync.

3 Press Menu (right action key) and select Schedule.

4 Set your sync schedule for peak and off-peak times. To conserve power we recommend that you change these settings to Every 30 minutes or Every 60 minutes instead of as items arrive.

5 Set your roaming preference. By default, a scheduled sync does not work while you are roaming. This is to prevent roaming charges on your account. If roaming charges are not a concern, check the Use above settings while roaming box.

6 Press OK.
**Setting up a Wireless Sync email account**

**BEFORE YOU BEGIN** Make sure your phone is on.

Wireless Sync lets you sync your email and other information when you’re away from your computer. To use Wireless Sync, you must first install the desktop synchronization software that came with your smartphone, and you must subscribe to the Wireless Sync feature from Verizon Wireless (additional charges may apply).

**TIP** For more info about Wireless Sync, visit http://www.wirelesssync.vzw.com.

1. On your smartphone, press **Start**   and select **Programs**.

2. Select **Wireless Sync**  .

3. Press **Start**   (left action key) and then wait a few minutes until the installation is finished.

4. When the message “Have you created your Wireless Sync account yet?” appears on your smartphone screen, select **No - Create account now** and then select **Next**.

5. Select the type of email account(s) you want to set up: **Internet, Corporate**, or **Both**.

6. Enter your mobile phone number. If you have not set up a Wireless Sync password, select **Get Password** to receive a text message with a temporary password. If you already have a password, enter it and select **Next**.

7. Check the **I agree to the terms and conditions of service** box, and then select **Next**.

8. Select your time zone and enter your zip code, and then select **Next**.

9. Enter your email address and the password you use to access this email account on your computer. Select **Next**.

10. When the Congratulations! screen appears, press **OK**  .

11. Press **Sync**   (left action key). If prompted, enter your password and select **OK**.

12. When the First Synchronization dialog box appears, do one of the following...
based on the type of email account you set up:

**Corporate email or both:** Select **Refresh**.

**Internet email:** Select **Merge**.

**TIP** For corporate email accounts, the default settings do wireless synchronization whenever info changes in Microsoft® Office Outlook®. To find out how often you can expect message delivery, contact your system administrator and ask about your company’s server settings. For Internet email accounts, the default settings do wireless synchronization every 30 minutes. To customize your Wireless Sync settings, select **Setup** at the bottom of the screen, and then select **Push/ReadySync**.

### Setting up an IMAP or POP email account

**BEFORE YOU BEGIN** Work with your system administrator to gather the following info:

- Account type (POP3 or IMAP)
- Mail server name for receiving mail
- Mail server name for sending mail
- Your username and password
- Domain name
- Any special security requirements

If you have problems configuring your account, go to **www.palm.com/emailsetup** for more information.

You can send and receive email messages with an email account that you have with an Internet service provider (ISP), an email account that you access using a VPN server connection (such as a work account), or any other IMAP (Internet Message Access Protocol) or POP email account.

1. Go to your Today screen.
2. Press **Messaging** (left action key).
3. Press **Menu** (right action key) and select **Tools > New Account**.
4. Enter the email address that you want to set up, and then press **Next** (right action key).
5. Wait until the Status box displays Completed, and then press **Next** (right action key).
YOUR EMAIL AND OTHER WIRELESS SERVICES

CHAPTER 6

6 Enter your name, username, and password.

7 If you want to enter your password each time you access this account, do not check the Save password box. If you want your password entered automatically, check this box.

8 Press Next (right action key).

9 Select the Account type list, and then select POP3 or IMAP.

10 Enter a name for this account, and then press Next (right action key). For example, if this is your work email account, enter “Work” or your company’s name.

11 Enter the name of the Incoming mail and Outgoing mail servers. Do not enter anything in Domain; it is not needed for POP3 or IMAP accounts.
12 (Optional) Select Options to select
download settings for this account.

13 Press Finish (right action key).

**TIP** To delete an email account, press Menu
and select Tools > Options. Highlight the
account you want to delete. Press and hold
Center on the 5-way, and then select Delete.

**DID YOU KNOW?** You can set up more than one
email account. Press Menu, select Tools, and
then select New Account. Enter the account
information in the E-Mail Setup wizard.

**Creating and sending an email message**

1. Go to your Today screen.
2. Press Messaging (left action key).

3. Press Left to cycle through your
   Messaging accounts until you see the
   email account you want to use in the
title bar.
4. Press New (left action key).
5. Do one of the following to address the
   message:

   - If the recipient’s name and email
     address are in your Contacts list,
     enter the first few letters of the
     recipient’s first or last name, and then
     select the recipient’s name.
   - If the recipient’s name is in an online
     address book, you can find the name

**DID YOU KNOW?** You can also access the
Messaging application from the Start menu.
and add it. For more information, see Using an online address book.

- If the recipient’s name and email address are not in your Contacts list, enter the full email address.

6 Select **Subject** and enter a title for the message.

7 Enter your message, or press **Menu** (right action key), select **My Text**, and then select a predefined phrase you want to insert.

8 (Optional) Do any of the following:
   - Press **Menu** (right action key) and select **Insert**. Select the type of item you want to attach, and then select the file or record a voice note.
   - Press **Menu** (right action key) and select **Spell Check**.
   - Press **Menu** (right action key) and select **Message Options**. Select the **Priority** list, select a setting for the message, and then press **OK**.

9 Press **Send** (right action key).

**DID YOU KNOW?** By default, email messages you send are saved in the Sent folder. If you want to save memory on your smartphone, you can turn this option off. In the Messaging list, press **Menu** and select **Tools > Options**. Select **Message**, and then uncheck the **Keep copies of sent items in Sent folder** box.

**TIP** Not ready to send that message yet? You can save it without sending it. While creating a message, press **Menu** and select **Save to Drafts**. To access the draft, select the **Show** list in the upper-left corner, and then select **Drafts**.

**DID YOU KNOW?** If you are outside a coverage area or if your phone is turned off, your outgoing messages go into the Outbox. When you return to a coverage area, your pending messages are sent automatically and transferred to the Sent folder.

**Using an online address book**

You can access contact information, such as an email address or phone number, from your organization’s online address book or Global Address List (GAL). To access a GAL, make sure you are accessing an Exchange Server 2003 upgraded to Service Pack 2.
1. In a new message, select the **To** box.
2. Press **Menu** (right action key), and select **Add Recipient**.
3. Press **Menu** (right action key), and select **Find Online**.
4. Enter the contact name as it appears in the directory and select **Find**. You must spell the contact name correctly.

**DID YOU KNOW?** You can receive email messages in various formats, including HTML, RTF, and plain text.

**TIP** Your computer must be connected to the Internet when you sync your email.

### Synchronizing your default email account
To send and receive messages for your default email account, simply synchronize your smartphone with your computer. See **Setting the synchronization schedule** for details. During synchronization, new messages are copied to your smartphone’s Inbox, and messages in the smartphone’s Outbox are sent.

### Synchronizing your other email accounts
To send and receive email messages for additional email accounts, such as an Internet service provider (ISP) account or an account that you access using a VPN server connection (typically a work account), follow these steps:

1. Go to your Today screen.
2. Press **Messaging** (left action key).
3. Press **Left** to cycle through your Messaging accounts until you see the account you want to download in the title bar.
4. Press **Menu** (right action key) and select **Send/Receive** to synchronize your smartphone with your email server.
Receiving attachments

1. Select the attachment (below the subject) to mark it for download.
2. Synchronize the email account that contains the message as described in the previous sections.
3. Select the attachment to open it.

**DID YOU KNOW?** You can receive and open attachments in a number of separate formats, including Word, Excel, PowerPoint® , and PDF. To view PDF files, you must first install Picasel PDF Viewer from the Getting Started CD.

**TIP** To store attachments on an expansion card, press **Menu**, and then select **Tools > Options**. Select **Storage**, and then check the **Store attachments on a storage card** box.

If you have a Microsoft Office Outlook E-mail account and want to download attachments automatically, do the following:

1. Press **Start** and select **Programs**.
2. Select **ActiveSync**.
3. Press **Menu** (right action key) and select **Options**.
4. Select **E-mail**, and then select **Settings**.
5. Check the **Include file attachments** box.
6. Press **OK**.

To automatically download attachments from an IMAP4 email account (typically an ISP account) or an account that you access using a VPN server connection (typically a work account), do the following:

1. Go to your Today screen.
2. Press **Messaging** (left action key).
3. Close any open messages.
4. Press **Menu** (right action key) and select **Tools > Options**.
5. On the Accounts tab, select the IMAP4 account name.
6. Press **Next** (right action key) until you reach Server information, and then select **Options**.
7. Press **Next** twice, and then select **Get full copy of messages** and **When getting full copy, get attachments**.
YOUR EMAIL AND OTHER WIRELESS SERVICES

CHAPTER

YOUR EMAIL AND OTHER WIRELESS SERVICES

Using links in messages
When you receive a text message that contains a telephone number, email address, or URL, you can dial the number, send an email message, or go to the web page immediately. Your smartphone automatically opens the appropriate application from the link.

1. Select a message in the list.
2. Select the phone number, email address, or URL (appears as underlined blue text).

Forwarding a message
1. Open the message that you want to forward.
2. Press Menu (right action key) and select Forward.
3. Address the message and enter any text you want to add.

4. Press Send (right action key).

Managing your messages
The status icons that appear next to each message in the Inbox and Outbox indicate the following:

- An unread text message.
- An unread message with pictures or videos.
- An unread message with sound.
- A read text message.
- A read message with pictures or videos.
- A read message with sound.
- An urgent message. This icon appears below the message size on the right side of the screen.
- A message that was delivered (Sent folder only).

DID YOU KNOW? Embedded images and objects cannot be received as attachments, unless you have an IMAP4 email account with TNEF disabled. Note that TNEF must be enabled to receive meeting requests.

TIP
Unread messages appear in bold. Messages you’ve read appear in plain text.

You can rearrange the messages in any folder or account.
1 Go to the Messaging account that you want to arrange.

2 Select the Sort by list in the upper-right corner, and then select the sort method you want to use.

You can delete several messages at once from any folder.

1 Go to the Messaging account that you want to delete the messages from.

2 Highlight the message(s) that you want to delete. To select multiple messages, tap and drag the stylus across the messages.

3 Press Menu (right action key) and select Delete.

4 Select Yes to move the items to the Deleted Items folder.

**DID YOU KNOW?** If you are working offline, messages that you deleted from the server are deleted from your smartphone the next time you connect, or according to the options you selected.

**TIP** To permanently remove messages from the Deleted Items folder, press Menu and select Tools > Empty Deleted Items.

### Adding a signature to your messages

You can use a different signature with each Messaging account.

1 Go to the Messaging list.

2 Press Menu (right action key) and select Tools > Options.

3 On the Accounts tab, select Signatures.

4 Select the account that you want to create a signature for.

5 Check the Use signature with this account box add this signature to new messages you create with this account.

6 (Optional) Check the Use when replying and forwarding box to add this signature to messages you reply to or forward with this account.
7. Select the default signature text and enter the signature text you want to use.

8. Press OK.

Customizing your Messaging settings

1. Go to the Messaging list.

2. Press Menu (right action key) and select Tools > Options.

3. Select the Message tab and set any of the following options:
   - When replying to e-mail, include body: Indicates whether the body of a message you received appears in your response to that message.
   - Keep copies of sent items in Sent folder: Indicates whether messages you send are stored in the Sent folder.
   - After deleting or moving a message: Specifies what you want to appear after you delete or move a message.

4. Select the Address tab and set any of the following options:
   - In Contacts, get e-mail addresses from: Indicates whether you want to check Contacts in addition to any directory services for email addresses.
   - Verify names using these address books: Indicates which directory services you want to check for email addresses.
**Add:** Lets you add directory services to the list of online address books.

5 Select the **Storage** tab and set any of the following options:

**Store attachments on storage card:** Indicates whether you want to automatically store email attachments on an expansion card.

**Empty deleted items:** Indicates whether you want to automatically empty the Deleted folder, and when you want this to occur.

6 Press **OK**.

---

**Customizing your multimedia messaging settings**

1 Go to the Messaging list.

2 Press **Menu** (right action key) and select **Tools > Options**.

3 On the Accounts tab, select **MMS**.

4 Set either of the following options:

**Automatically Collect Messages:** Indicates whether you want to automatically receive multimedia messages.

**Confirm Message Deletion:** Indicates whether you want deletion confirmation messages to appear.

5 Press **OK**.
Using Pocket MSN

**BEFORE YOU BEGIN** You must subscribe to data services from Verizon Wireless.

Pocket MSN provides quick access to the following:

**MSN Hotmail:** Lets you read, write, send, and delete email. You can also manage your Hotmail folders.

**MSN Messenger Contacts list:** Lets you see who’s online and exchange instant messages (IM). Subscribe to status updates for selected contacts so you’re notified when they’re online.

**Options:** Lets you customize your Pocket MSN experience.

**DID YOU KNOW?** You can add Pocket MSN to your Today screen. See Selecting which items appear on your Today screen for details.

**TIP** When you set up a Pocket MSN Hotmail account, you can access that account in the Messaging application. To access your instant messages, use the MSN application or the MSN plug-in on the Today screen.

**Signing in to Pocket MSN**

1. Press **Start** and select **Pocket MSN**.

2. Select **MSN Mobile Home**.

3. Select **Sign in**.

4. Enter the email address and password for your Passport account or your Hotmail account.
   - To create a Passport (IM) account, go to [www.passport.com](http://www.passport.com).
   - To create a Hotmail account, go to [www.hotmail.com](http://www.hotmail.com).
Browsing the web

Internet Explorer Mobile provides quick and easy access to web pages. You can view most sites you use on your computer, including those with security and advanced features, such as JavaScript and frames. To browse the web, you must subscribe to data services from Verizon Wireless.

Viewing a web page
By default, Internet Explorer Mobile scales web page content to fit your smartphone screen so that you can view most of the information without scrolling left or right.

1 Make sure your phone is on (see Turning your smartphone on/off).
2 Press Start (right action key), and select Internet Explorer.
3 Highlight the address line, enter the address of the web page you want to view, and then press Center.

4 Press Menu (right action key), select View, and then select any of the following:
   **One Column:** Arranges web pages into one column that is as wide as the screen, so that you don’t have to scroll horizontally.
   **Default:** Maintains a layout similar to what you see on a desktop computer, but it makes items smaller and arranges the content so that you can see most of it without scrolling horizontally.
   **Desktop:** Keeps the same layout and size as on a desktop computer, which requires both horizontal and vertical scrolling.
**Full Screen:** Hides the status and navigation areas and fills the entire screen with the web page. To exit full screen mode, press \(\text{Menu} (\text{right action key})\), or tap and hold anywhere on the screen and uncheck **Full Screen**.

**Show Pictures:** Shows or hides pictures on web pages. Hiding pictures speeds up the time it takes to load pages.

---

**DID YOU KNOW?** You can send email from a web page. Email addresses appear as links on web pages. After you configure an email application on your smartphone, you can select an email link to create a message to that address.

**TIP** To send a link, press **Menu** and select **Tools > Send Link via E-mail**. Select the Messaging account you want to use to send the link.

---

5 Do any of the following:

- To view the previous page, press **Back** (left action key) or **Backspace**.
- To refresh the page with the latest content from the Internet, press **Menu** (right action key) and select **Refresh**.
- To scroll through the page in One Column View or Default View, press **Up** or **Down**. In Desktop View, press **Up**, **Down**, **Left**, or **Right** to scroll in all directions.
- To follow a link to another web page, press **Up** or **Down** to highlight the link, and then press **Center** to go to the selected page. You can also tap the link on the screen with your stylus.
- To adjust the size of the text on web pages, press **Menu** (right action key), select **Zoom**, and then select the size you want.
- To view a web page’s properties, press **Menu** (right action key) and select **Tools > Properties**.
- To view each item in a list, select the list and scroll using **Up** or **Down**.
- In a list, press **Left** or **Right** to cycle between items, and press **Center** to accept the change.
• In a form, such as a browser search field, press Center to interact with the form, and then press Center to stop interacting with the form.

6 Press OK to close Internet Explorer Mobile.

DID YOU KNOW? You can also start a web search from your Today screen by selecting the Web search field, entering the item you want to find, and then pressing Center on the 5-way.

TIP To return to a recently viewed page, select the address line list, and then select the web address.

TIP If you browse to a secure web page, the Lock icon in the address line appears closed instead of open.

Creating a favorite
Favorites let you bookmark a web page so that you can instantly access it without entering the web address.

1 Go to the page you want to mark as a favorite.

2 Press Menu (right action key) and select Add to Favorites.

3 (Optional) Select Name and enter a different description.

4 (Optional) Select the folder where you want to create the favorite.

5 Select Add.

Viewing a favorite
1 Press Start and select Internet Explorer.

2 Press Favorites (left action key).

3 Select the page you want to view in the list.
Organizing your favorites

You can create folders for organizing your favorites. For example, you can store travel links in one folder, stock links in another, and business links in a third folder.

1. Press **Start** and select **Internet Explorer**.
2. Press **Menu** (right action key) and select **Favorites**.
3. Select the **Add/Delete** tab.
4. Select **New Folder**.
5. Enter a name for this folder, and then select **Add**.
6. Press **OK**.

**TIP** Create the folders where you want to store your favorites first. Once you create a favorite, you can’t move it to another folder.

**TIP** To delete a favorite or folder, press **Menu** and select **Favorites**. Select the **Add/Delete** tab, highlight the item you want to delete, and then select **Delete**. Select **Yes** to confirm deletion, and then press **OK**.

Downloading files and images from a web page

You can download files that are usable on your smartphone, such as new applications, MIDI ringtones, or pictures that are specifically tagged for download.

1. Go to the page that contains the link to the file you want to download.
2. Press **Left** or **Right** to highlight the link to the file.
3. Press and hold **Center**, and then select **Save As** to download a file, or tap and hold, and then select **Save Image** to download an image.
4. Select **Name** and enter a new name for the file.
5. Select the **Folder** list, and then select the folder where you want to save the file.
6. Select the **Location** list, and then select where you want to store the file: **Main memory** or **Storage card**.
7. Press **OK**.

**DID YOU KNOW?** You can select the **Downloads** favorite to access the Verizon Wireless downloads page.
Copying text from a web page
You can copy text from a web page and paste it into other applications.

1 Use the stylus to highlight the text you want to copy.
2 Press Menu (right action key) and select Edit > Copy.
3 Go to the application in which you want to paste, and then position the cursor where you want to paste the text.
4 Press Menu (right action key) and select Edit > Paste.

**TIP** You can copy the text from the entire web page. Tap and hold on the page, and tap Select All Text. Tap and hold on the page again, and tap Copy.

**TIP** If Internet Explorer Mobile does not recognize a smartphone number as dialable, you can copy the phone number (as text) and paste it into the Phone Dial Pad.

Using the History list
The History list stores the addresses of the pages you visited recently.

1 Press Menu (right action key) and select History.

2 (Optional) Select the Show list in the upper-left corner, and then select how you want to sort the History list.
3 Select the web page you want to view.

Customizing your Internet Explorer Mobile settings

1 Press Menu (right action key) and select Tools > Options.
2 On the General tab, set any of the following options:

   **Home Page:** Sets the page that appears when you open Internet Explorer Mobile. To use the page you were on when you opened the menu, select Use Current. To select the original home page, select Use Default.
Encoding: Sets the character set for the web pages you view.

3 Select the Memory tab and set any of the following options:

Save links to pages visited in the past: Sets how many days of activity the History list stores.

Clear History: Empties the History list.

Delete Files: Removes web files that you synchronized with your computer.

4 Select the Security tab and set any of the following options:

Allow cookies: Sets whether your smartphone accepts cookies (small files containing info about your identity and preferences). The page sends the file and stores it on your smartphone.

Clear Cookies: Deletes any cookies stored on your smartphone.

Warn when changing to a page that is not secure: Sets whether a message appears when you switch from a secure page to one that is not secure.

Warn when page content is blocked due to security settings: Sets whether a message appears when you attempt to open a page that does not meet your smartphone’s security standards.
Connecting to devices using Bluetooth wireless technology

With your smartphone’s built-in Bluetooth wireless technology, you can connect to a number of Bluetooth devices, such as a stereo headset, hands-free car kit, or GPS receiver, as well as to other phones, handhelds, or piconets. For a list of hands-free devices with Bluetooth wireless technology that are compatible with your smartphone, go to www.palm.com/us/products/smartphones/treo700w/bluetooth.html.

If your computer is enabled with Bluetooth wireless technology, you can also synchronize wirelessly.

**Key Term** Piconet: An ad-hoc network of devices that uses Bluetooth wireless technology to connect one master device with up to seven active slave devices. The network can include up to 255 inactive, or parked, slave devices which the master device can bring into active status at any time.

**Did you know?** If you’re using a hands-free Bluetooth device and it is within range, your smartphone routes all calls to the hands-free device instead of to your smartphone’s earpiece. Bluetooth range is up to 30 feet in optimum environmental conditions.

**Setting up a Bluetooth connection**

After you set up a connection with a Bluetooth device, you can communicate with that device whenever your smartphone’s Bluetooth feature is turned on.

**Tip** Internet Explorer Mobile supports JavaScript, Secure Sockets Layer (SSL), and cookies, but does not support plug-ins (Flash, Shockwave, and so on) or Java applets.

**Tip** The security certificates and 128-bit SSL strong encryption let you browse secure sites, such as online shopping, banking, and email. Remember that some secure sites also require specific browsers and may not work with Internet Explorer Mobile. Ask the organization for an alternate access point that is compatible with Internet Explorer Mobile.
on and your smartphone is within range (about 30 feet) of the Bluetooth device.

**TIP** Wi-Fi® routers, microwaves, and wireless telephones using the 2.4GHz band may interfere with Bluetooth connections, because they share the same wireless frequency. For best results, move away from these types of equipment when making a Bluetooth connection. If you cannot move away, move the Bluetooth devices closer together to improve the reception.

1. If necessary, prepare the device you want to connect with to accept a new connection. Check the device’s documentation for details.

**NOTE** Establishing a connection between two Bluetooth devices is also known as *pairing*.

2. Go to your Today screen, and then tap **Bluetooth**.

3. Check the **Turn on Bluetooth** box to turn on your smartphone’s Bluetooth feature.

4. Select the **Devices** tab, and then select **New Partnership**.
5 Wait for your smartphone to search for devices and to display the device list.

6 Select the device you want to connect with, and then press Next (right action key).

7 Enter the same passkey on your smartphone and on the Bluetooth device, and then press Next (right action key).

**IMPORTANT** Some Bluetooth devices have a preset passkey; if so, you can find the passkey in the documentation for that device. Other devices provide a screen where you enter a passkey that you make up. In either case, you must use the same passkey on both your smartphone and the other Bluetooth device. We recommend that where possible, you make up a passkey of 16 alphanumeric characters (letters and numerals only) to improve the security of your smartphone. The longer the passkey, the more difficult it is for the passkey to be deciphered.

8 Do any of the following that apply to the type of device you’re connecting to:

- **Headset or hands-free car kit:** Check the Hands Free box.

- **A2DP/AVRCP enabled stereo headset:** Check the Wireless Stereo box.

- **GPS device:** Press Finish (right action key), select the COM Ports tab, select the GPS device you selected in step 6, and then select New Outgoing Port. After you set the partnership and COM port, you can configure the GPS settings (see Setting up a GPS device). Be sure to select the same port you have assigned for GPS here.

9 Press Finish (right action key) and then press OK.

You can now communicate with this device whenever it is within range (about 30 feet)
and your smartphone’s Bluetooth feature is turned on (see steps 1 and 2 earlier in this section).

**DID YOU KNOW?** The Bluetooth icon on your Today screen indicates the status of your smartphone’s Bluetooth feature:
- Gray = Bluetooth off.
- Blue = Bluetooth on.
- White = Connected to a Bluetooth device.
- Headset = Call in progress with a Bluetooth headset or car kit.

**TIP** To delete the established partnership with a device, go to the Bluetooth Settings screen and select Devices. Highlight the connection you want to remove, press and hold Center on the 5-way, and then select Delete. The deleted device can no longer automatically connect with your smartphone.

### Sending information over a Bluetooth connection

You can send an individual entry or file.

**TIP** Check your battery level before establishing a Bluetooth connection. If the battery level is low, you can’t make a Bluetooth connection.

1. Make sure the receiving device is ready to receive a Bluetooth connection.
2. Highlight the entry or file you want to send.
3. Press **Menu** (right action key) and select **Beam**... (the menu item changes names based on the type of item you highlighted). A red icon indicates an IR connection, and a blue icon indicates a Bluetooth connection.
4. Select the receiving device in the list. When the transmission is complete, “Done” appears next to the name of the receiving device.
Receiving information over a Bluetooth connection

1. Go to your Today screen, and then tap Bluetooth.

2. Check the Turn on Bluetooth box to turn on your smartphone’s Bluetooth feature.

3. If you have already set up a partnership with the transmitting device, your smartphone is ready to receive the info. If you haven’t set up a connection, check the Make this device discoverable to other devices box to let the device find your smartphone and request a connection.

4. When your smartphone is receiving info, a notification tells you that a transmission is in progress. To stop the transmission, press Cancel (left action key); to close the notification, press Dismiss (right action key).

TIP: If you have trouble receiving info over a Bluetooth connection, press Start and select Settings. Select the Connections tab, and then select Beam. Make sure the Receive all incoming beams box is checked.

Synchronizing over a Bluetooth connection

**BEFORE YOU BEGIN** Make sure your computer is equipped with Bluetooth wireless technology and that you installed the synchronization software on the CD that came with your smartphone.

1. Set up your computer for Bluetooth wireless communication. For details, see the documentation that came with your computer. In most cases your computer must support the Virtual Serial Port profile and this profile must be turned on.

2. Set up ActiveSync on your computer for Bluetooth wireless communication. See ActiveSync Help on your computer for details.

3. Go to your Today screen, and then tap Bluetooth.

4. Check the Turn on Bluetooth box to turn on your smartphone’s Bluetooth feature.

5. Press Start and select Programs.

6. Select ActiveSync.
7 Press Menu (right action key) and select Connect via Bluetooth.

8 If this is the first time you’re making a Bluetooth connection to this computer, follow the onscreen prompts to set up a Bluetooth partnership with this computer.

9 Select Sync.

10 When synchronization has finished, press Menu (right action key) and select Disconnect Bluetooth.

TIP For best results, the path between the two devices must be clear of obstacles and both devices must be kept stationary. If you have difficulty beaming, shorten the distance and avoid bright sunlight.

The type of information you can beam depends on the type of device you are beaming to. Windows Mobile devices are always compatible with the Palm® Treo™ 700wx smartphone.

Beaming a record

1 Highlight the entry or file you want to beam.

2 Press Menu (right action key) and select Beam… (the menu item changes names based on the type of item you highlighted).
3 Point the IR port on your smartphone directly at the IR port of the receiving device.

4 When the name of the receiving device appears, select it to begin the transfer. A blue icon indicates a Bluetooth connection, and a red icon indicates an IR connection.

5 Wait for “Done” to appear next to the name of the receiving device before you continue using your smartphone.

Receiving beamed information

1 Turn on your screen.
2 Point your smartphone’s IR port directly at the IR port of the transmitting device.
3 When the Receiving Data message appears, select Yes to receive the beam.

TIP If you can’t receive beamed info, press Start and select Settings. Select the Connections tab, and then select Beam. Make sure the Receive all incoming beams box is checked. If you still can’t receive info, try a soft reset (see Resetting your smartphone).

Synchronizing over an infrared connection

1 Set up your computer to receive infrared beams. See ActiveSync Help on your computer for details.
2 Point your smartphone’s IR port directly at the IR port on your computer.
3 On your smartphone, press Start and select Programs.
4 Select ActiveSync.
5 Press Menu (right action key) and select Connect via IR.
6 Select Sync.
Using your smartphone as a wireless modem

Your smartphone’s data capabilities enable you to use your smartphone as a wireless modem for your laptop computer. Use this feature to send and receive email, browse the Internet, and access your company’s network if you do not have another Internet connection for your laptop. Use this feature to connect to the Internet when working remotely at airports and other locations.

BEFORE YOU BEGIN

- To use this service, you must have access to a wireless data network, and a separate data service plan may also be required. Contact Verizon Wireless for more information.
- In addition, you must have a desktop application that supports this feature. Verizon Wireless may provide a dedicated software application, or visit the following web site for additional instructions from Palm: www.palm.com/treo700wx-support

Preparing your smartphone for a wireless modem connection using a USB cable

To use your smartphone as a wireless modem using a USB cable, you need to start the Modem Link application on your smartphone, and then complete the instructions at the Palm web site (provided at the end of the following steps).

1. On your smartphone, press Start and select Programs.
2. Select Modem Link.
3. Press OK to dismiss the message and open Modem Link.
4 Select the **Connection** list, and then select **USB**.

5 Press **Activate** (left action key).

**TIP** You cannot sync your smartphone with your PC when **Modem Link** is activated. To deactivate Modem Link, complete steps 1–3 and press **Deactivate**.

**TIP** If you’re using your smartphone as a wireless modem to connect to the Internet through a BroadbandAccess connection, the data connection is terminated whenever you receive or make a phone call.

### Preparing your computer for a wireless modem connection using a USB cable

To complete the configuration and connect your laptop to the Internet using your smartphone, you must download and install the VZAccess application. Go to www.verizonwireless.com/b2c/businessSoutions/mobileProfessional/remoteAccess.jsp to download the VZAccess application and to find the instructions on its use.

**NOTE** Palm does not support wireless modem connections on Mac OS X computers. Third-party solutions may be available, but these solutions are not supported by Palm.

### Preparing your smartphone for a wireless modem connection using Bluetooth technology

To use your smartphone as a wireless modem using a Bluetooth connection, you must first create a partnership between your smartphone and your computer.

**NOTE** Establishing a connection between two Bluetooth devices is also known as *pairing*.

**TIP** Wi-Fi routers, microwaves, and wireless telephones using the 2.4GHz band may interfere with Bluetooth connections, because they share the same wireless frequency. For best results, move away from these types of equipment when making a Bluetooth connection. If you cannot move away, move the Bluetooth devices closer together to improve the reception.

1 Prepare your computer to accept a new connection. Check your computer’s documentation for details.
2 Go to your Today screen, and then tap Bluetooth.

3 Check the Turn on Bluetooth box to turn on your smartphone’s Bluetooth feature.

4 Select the Devices tab, and then select New Partnership.

5 Wait for your smartphone to search for devices and to display the device list.

6 Select your computer from the list, and then press Next (right action key).

7 Enter the same passkey on your smartphone and on your computer, and then press Next (right action key).

**IMPORTANT** Some Bluetooth devices have a preset passkey; if so, you can find the passkey in the documentation for that device. Other devices provide a screen where you enter a passkey that you make up. In either case, you must use the same passkey on both your smartphone and the other Bluetooth device. We recommend that where possible, you make up a
passkey of 16 alphanumeric characters (letters and numerals only) to improve the security of your smartphone. The longer the passkey, the more difficult it is for the passkey to be deciphered.

8 Press Finish (right action key), and then press OK.

You can now communicate with this device whenever it is within range (about 30 feet) and your smartphone’s Bluetooth feature is turned on (see steps 1 and 2 earlier in this section).

Preparing your computer for a wireless modem connection using Bluetooth technology

Bluetooth connectivity and setup varies from computer to computer based on your operating system version and the way your computer is enabled with Bluetooth technology.

The instructions that follow are general instructions for setting up a connection with a computer that has a Windows certified Bluetooth device and is running Windows XP SP2.

For instructions on setting up other operating systems or Bluetooth devices, see the documentation that came with the computer and the Bluetooth device.

1 On your computer, click Start and select Run.
2 Enter telephon.cpl, and then click OK.
3 On the Modems tab, click Add to open the Select Bluetooth Device dialog box.
4 Select your smartphone from the list of devices to use as a modem.
5 Click Start > Control Panel > Phone and Modem Options.
6 Enter #777 as the phone number to dial.
7 (Optional) Create an Internet connection by clicking Start > Control Panel > Network Connections.

Notes on wireless modem connections using Bluetooth technology

- Windows XP automatically generates a passkey for the connection between your smartphone and your computer. You can use this passkey or enter one of your own. Passkeys can have up to 16 characters. You must enter the passkey
within 30 seconds, or authentication may not succeed.

- When your smartphone is connected as a modem, it appears in Device Manager as a modem.
- If you configure Windows to detect modems while a Bluetooth adapter is connected, Windows automatically opens the Select Bluetooth Device dialog box when it detects your smartphone (or another dial-up networking device).
- Although the maximum throughput for Bluetooth technology is approximately 723Kbps, real world performance for Bluetooth wireless modem is in the range of 200Kbps–350Kbps depending on Bluetooth performance and wireless network performance.
- Bluetooth is not a secure wireless technology. Your data may be visible to other devices that are in range.
- Only one Bluetooth connection can be active. For example, to make a phone call while using a wireless modem connection using Bluetooth technology, you must first end the modem connection.

For more information please visit www.bluetooth.com
Your photos, videos, and music

Do you have a wallet bulging with photos of friends, family, pets, and your most recent vacation?

Are you tired of carrying both your MP3 player and your phone?

Your smartphone solves both problems. You can keep your favorite photos—videos, too—right on your smartphone. And there’s no need to carry an expensive MP3 player; you can play music on your smartphone. Simply transfer songs onto your smartphone or an expansion card and then listen through your stereo headphones.

**Benefits**
- Never be far from your favorite people, places, and songs
- Arrange your photos, videos, and songs
- No separate photo viewer, MP3, CD, or mini-disc player required
In this chapter

Pictures & Videos ................................................................. 123
Windows Media Player Mobile ........................................ 131
Pictures & Videos

Your Palm® Treo™ 700wx smartphone comes with an easy-to-use, built-in 1.3-megapixel camera with 2x digital zoom. You can use the camera to take and view pictures and videos and send them to your friends and family. To add a personal touch to your smartphone, use your pictures as your Today screen background and as caller ID images, or use your videos to create video ringtones.

DID YOU KNOW? Pictures are captured and stored in 16-bit color, JPG format. Resolution settings range from 160 x 120 pixels to 1280 x 1024 pixels (VGA to 1.3-megapixels). Videos are captured and stored in 3G2 format. Video resolution settings range from 176 x 144 to 352 x 288 pixels. You can change the default setting. See Customizing your Camera settings for details.

Taking a picture

By default, pictures are stored in the My Pictures folder on your smartphone. If you want to store your pictures on an expansion card, see Customizing your Camera settings to change where pictures are stored. For info on accessing your pictures on your computer, see Viewing pictures and videos on your computer.

1 Press Start and select Pictures & Videos.
2 Select Camera.
3 Adjust the position of your smartphone until you see the subject you want to photograph on the screen.

TIP If you see a camcorder icon below the preview image, video mode is on. To turn on the still camera, press Menu and select Still Mode.
YOUR PHOTOS, VIDEOS, AND MUSIC

CHAPTER

DID YOU KNOW? After three minutes of inactivity when previewing an image, the camera goes into standby mode. Press any key or tap the screen to return to the image preview.

4  (Optional) Adjust any of the following:

Zoom: Press Up ▲ to zoom in, or Down ▼ to zoom out.

Brightness: Press Right ► to increase the brightness or Left ◀ to decrease the brightness.

Resolution: Press Menu (right action key) and select Resolution to change the image quality.

TIP You can also adjust the zoom and brightness by pressing Menu and selecting Zoom or Brightness.

5  (Optional) Set a five-second timer: Press Menu (right action key), select Mode, and then select Timer.

6  Press Center ◁ to capture the picture or to start the timer.

7  Hold your smartphone still until the picture renders, and then do one of the following:

- Press Camera ◀ (left action key) to take another picture.
- Press OK ◀ to return to Thumbnail View.

Taking pictures in burst mode

Burst mode takes five pictures in quick succession, with one button press.

1  Press Start ◀ and select Pictures & Videos.

2  Press Camera ◀ (left action key).

3  Press Menu (right action key) and select Mode > Burst.

4  Press Center ◁.

Recording a video

BEFORE YOU BEGIN You must have QuickTime Player version 6.5 or later installed on your computer to play videos recorded by your smartphone and downloaded from an expansion card, or to play videos that you access by clicking the video thumbnail after synchronizing the files.
Videos can be any length, provided that you have ample storage space available. By default, videos are stored in the My Pictures folder on your smartphone. If you want to store your videos on an expansion card, see Customizing your Camera settings to change where videos are stored. For information on accessing your videos on your computer, see Viewing pictures and videos on your computer.

1. Press Start and select Pictures & Videos.
2. Select Camera.
3. Press Menu (right action key) and select Video Mode.
4. Adjust the position of your smartphone until you see the subject you want to record on the screen.
5. (Optional) Adjust any of the following:
   - **Brightness**: Press Right to increase the brightness or Left to decrease the brightness.
   - **Resolution**: Press Menu and select Quality to change the video resolution.
6. Press Center to start recording.
7. After you finish recording, press Stop (left action key) or Center to stop recording.
8. (Optional) To review the video in Windows Media® Player Mobile, press Thumbnails (left action key), highlight the video, and then press Center. Press OK to return to Thumbnail View.

**DID YOU KNOW?** Your smartphone has a self-portrait mirror next to the camera lens on the back of your smartphone. Use the mirror when you’re taking a picture or video and you want to be in the picture too.
CHAPTER

YOUR PHOTOS, VIDEOS, AND MUSIC

DID YOU KNOW? If the Camera goes to standby while the recording is paused, the recording is stopped and the video clip is saved.

Viewing a picture or video

1 Press Start (Start) and select Pictures & Videos.
2 Select the picture or video you want to view. For more info on viewing videos, see Playing media files on your smartphone.
3 Press OK (OK) to return to Thumbnail View.

TIP To view pictures or videos in a different folder, select the Show list in the upper-left corner, and then select the album you want to view.

TIP If you don’t like a video you recorded, delete it (see Deleting a picture or video).

3 Press Center (Center) to display the slide show toolbar, and then select any of the following icons to control the slide show:
   - Rotates the current slide.
   - Starts playing the slide show.
   - Pauses the slide show.
   - Moves to the previous slide.
   - Moves to the next slide.
   - Stops the slide show.

TIP You can also press Right and Left on the 5-way to move forward or backward through the slides.

Sending a picture or video

You can send a picture or video to other picture-enabled mobile smartphones or to an email address.

1 Press Start (Start) and select Pictures & Videos.
2 Highlight the picture or video that you want to send.
3 Press Menu (Menu) (right action key) and select Send.
4 Select the email or MMS account you want to use to send the picture or video.

5 When the Messaging application opens, address and send the message. (See Creating and sending a multimedia message for details.)

**DID YOU KNOW?** You cannot send copyrighted pictures or videos that appear with a Lock icon in Thumbnail View.

**TIP** You can send pictures and videos as email attachments.

### Creating a video ringtone
You can save a video that you record as a ringtone.

1 Press Start and select **Pictures & Videos**.

2 Highlight the video you that want to use as a ringtone.

3 Press Menu (right action key) and select **Save to Contact Ring Tone**.

4 Select the contact to whom you want to assign the ringtone.

### Organizing pictures and videos
You can move or copy pictures and videos to other folders or between your smartphone and an expansion card.

1 Press Start and select **Pictures & Videos**.

2 Highlight the picture or video that you want to move or copy.

3 Do one of the following:
   - To move the picture or video to another location, press Menu and select **Edit > Cut**.
   - To keep the picture or video in two locations, press Menu and select **Edit > Copy**.

4 Select the Show list in the upper-left corner, and select the location where you want to place the picture or video that you selected in step 3.

5 Press Menu (right action key) and select **Edit > Paste**.

You can also view a specific folder or expansion card and arrange the pictures and videos by name, date, or size.

1 Press Start and select **Pictures & Videos**.
2  Select the **Show** list in the upper-left corner, and then select the folder you want to view.

3  Select the **Sort By** list in the upper-right corner, and then select the sort method: **Name**, **Date**, or **Size**.

### Using a picture as the Today screen background

1  Press **Start**  and select **Pictures & Videos**.

2  Highlight the picture you want to use.

3  Press **Menu**  (right action key) and select **Set as Today Background**.

4  Select the **Transparency level** list and select the appropriate level. Use a higher percentage for a more transparent picture and a lower percentage for a more opaque picture.

5  Press **OK**  to return to Thumbnail View.

### Editing a picture

1  Press **Start**  and select **Pictures & Videos**.

2  Highlight the picture you want to edit.

3  Press **Menu**  (right action key) and select **Edit**.

4  Do any of the following:
   - To rotate a picture 90 degrees counterclockwise, select **Rotate**.
   - To crop a picture, press **Menu**  (right action key) and select **Crop**. Tap and drag the stylus to highlight the area to crop. Tap outside the box to stop cropping.
   - To adjust the brightness and contrast levels of a picture, press **Menu**  (right action key) and select **AutoCorrect**.

### Deleting a picture or video

1  Press **Start**  and select **Pictures & Videos**.

2  Highlight the picture or video you want to delete.

---

**TIP** To undo an edit, press **Menu** and select **Undo**. To cancel all unsaved edits you made to the picture, select **Revert to Saved**.

**TIP** For more extensive edits, download your picture or video to your computer and edit it in your favorite graphics program. Then sync the picture or video back onto your smartphone.
3 Press Menu (right action key) and select Delete.

4 Select Yes.

Customizing your Camera settings

1 Press Start and select Pictures & Videos.

2 Press Menu (right action key) and select Options.

3 On the General tab, set any of the following options:

- **Use this picture size**: Sets the size of pictures you send with the Messaging application.

4 Select the **Slide Show** tab and set any of the following options:

**During slide shows, optimize for viewing**: Sets whether pictures are optimized for portrait or landscape format during slide shows.

**Play screensaver when connected to my PC and idle for 2 minutes**: Sets whether the pictures in your My Pictures folder are used as a screensaver when your smartphone is connected to your computer and ActiveSync® software is not running.
5 Select the **Camera** tab and set any of the following options:

**Save files to:** Specifies where pictures and videos are stored: on your smartphone or on an expansion card.

**Type filename prefix:** Assigns a name to a series of pictures to be captured, such as Seattle001, Seattle002, and so on.

**Still image compression level:**
Sets the default size for newly captured pictures.

6 Select the **Video** tab and set any of the following options:

**Include audio when recording video files:** Turns the microphone on and off so that you can record videos with or without sound.

**Time limit for videos:** Limits the length of videos you record. You can also select the No limit option.

7 Press **OK** to return to Thumbnail View.

**Viewing pictures and videos on your computer**

When you synchronize your smartphone, your pictures and videos are copied to your desktop computer. You can view pictures in
JPEG, GIF, BMP, and PNG format, and videos in 3G2 and WMV format. You can also send them to friends by using your desktop email application.

To find all synchronized pictures and videos, look in C:\Documents and Settings\<Username>\My Documents\Treo My Documents.

**DID YOU KNOW?** You can also download animated GIF files and view them in Internet Explorer Mobile.

---

### Windows Media Player Mobile

Windows Media Player Mobile can play music, audio, and video files that are stored on your smartphone or on an expansion card (sold separately) in any of the following file formats:

- WMA
- WMV
- MP3
- 3G2

You can listen to these music, audio, and video files through the speaker on the back of your smartphone or through a stereo headphone (3.5mm stereo headphone adapter or 2.5mm stereo headphone required, sold separately).

**Transferring media files to your smartphone**

**BEFORE YOU BEGIN** Do the following:

- You must have Windows Media Player 10 or later installed on your computer. See *My media files won’t sync*.
- To sync media files with your computer, you must set the Media sync option. See *Selecting which info to sync*.

Use the Sync feature in the desktop version of Windows Media Player 10 to transfer digital music, audio, video, and playlist files from your computer to an expansion card or your smartphone. Using Sync ensures that the files are transferred correctly.

1. On your computer, open Windows Media Player 10.
2 (Optional) Insert a 32MB or larger expansion card into your smartphone.

3 Connect your smartphone to your computer with the USB sync cable.

4 When the Device Setup Wizard opens on your computer, click Automatic.

5 Check the Customize the playlists that will be synchronized box.

6 Select the playlists you want to sync.

7 Click Finish to begin the transfer. The next time you connect your smartphone to your computer while the desktop version of Windows Media Player 10 is running, synchronization starts automatically.

**Tip** If you can’t find a media file on your expansion card, update the library (see Working with libraries).

**Tip** To play a file that is not in a library, go to the Library screen, press Menu, and select Open File.

**Tip** To play a file from the web, press Menu on the Library screen, and then select Open URL. Select URL and enter the website address, or select History and select a site you’ve visited before.

4 Select the item you want to play (such as a song, album, or artist name).

5 Press Play (left action key).

6 Use any of the following onscreen controls during playback:
   - ▶ Plays the current file.
   - ■ Pauses the current file.
   - ‹ Skips to the beginning of the current file or to the previous file.
Skips to the next file.

Sets the point from which playback begins. Tap and drag the slider to change the current position.

Increases the volume level.

Decreases the volume level.

Turns the sound on or off.

Displays a video using the full screen.

Displays a website where you can find music and videos to play.

Indicates the rating of the current file. Select the star to change the rating.

Library: Displays the Library screen so you can select a different song to play.

Shuffle/Repeat > Shuffle: Plays the Now Playing playlist in random order. A check appears next to this command when it is on.

Shuffle/Repeat > Repeat: Plays the Now Playing playlist repeatedly. A check appears next to this command when it is on.

Stop: Ends playback.

7 Press Menu (right action key) and select any of the following during playback:

TIP You can also use the Volume button to adjust the volume and the 5-way to control playback. Press Center to play or pause the file. Press Left to skip to the beginning of the current file (or to the previous file), and press Right to skip to the next file.

TIP To repeat the current song, press Menu and select Repeat Song.

DID YOU KNOW? If you close the Windows Media Player Mobile window, your music continues to play in the background.

Working with libraries

A library represents each of the storage locations available to Windows Media Player Mobile, so you should have two libraries: My Device and My Storage Card. Each library contains links to the media files in that location. Windows Media Player Mobile usually updates the My Device library automatically, but you must
manually update the My Storage Card library.

1. Press Start and select Windows Media.
2. Press Menu (right action key) and select Library.
3. Press Menu (right action key) and select Update Library.
4. Wait for the files to be added, and then select Done.

Working with playlists
A playlist is a list of media files that play in a specific order. You can use playlists to group audio files together or video files together for convenient playback. For example, in the desktop Player, you can create a playlist of upbeat songs for when you exercise and a playlist of soothing songs for a long flight. When you synchronize, your favorite playlists are automatically copied to your smartphone. Your playlists appear in your libraries (in the My Playlists category).

A temporary playlist, called Now Playing, appears on the Now Playing menu. It lists the currently playing file, as well as any files that are queued up to play next. You can add to, modify, or clear the files on the Now Playing playlist.

1. Go to the Now Playing screen:
   - If you are on the Library screen, select the Now Playing category.
   - If you are on the Playback screen, select Now Playing.
2 Do any of the following:

- To move a file up or down one slot, highlight the file and then select **Move Up** or **Move Down**.
- To add a file, select **Add**, press **Menu** (right action key), and then select **Queue Up**.
- To delete a file from the playlist, highlight the file and then select **Remove**.
- To view more info about a file, highlight the file and then select **Properties**.
- To remove all items from the Now Playing playlist, press **Menu** and select **Clear Now Playing**.

**DID YOU KNOW?** You can also move a file in the Now Playing playlist by tapping and dragging it to a new position.

**Customizing Windows Media Player Mobile**

1 If necessary, go to the Playback screen by pressing **OK** to close the current screen.

2 Press **Menu** (right action key) and select **Options**.

3 On the Playback tab, set any of the following options:

**Show time as:** Sets whether the time remaining or time elapsed appears in the Playback screen.

- **Elapsed**
- **Pause playback while using another program**
- **Resume playback after a phone call**
Pause playback while using another program: Sets whether playback continues if you switch to another application.

Resume playback after a phone call: Sets whether playback continues after you finish a phone call.

4 Select the Video tab and set any of the following options:

Play video in full screen: Sets whether videos automatically play in full-screen format.

Scale to fit window: Sets whether videos are automatically scaled to fit the Playback screen.

5 Select the Network tab and set the following options:

Protocol: Enables and disables the available protocols. You must select at least one protocol. You can also set a UDP Port.

Internet Connection Speed: Sets the speed of your network connection, and sets whether you want the device to detect connection speed.

6 Select the Library tab and set whether you want to see the Library or Playback screen when you open Windows Media Player Mobile.

7 Select the Skins tab and select Previous or Next to set the player’s background.

8 Select the Buttons tab to change any of the available button settings:

- To assign a button, highlight the item you want to set, select Assign, and then press the button you want to use for that item.

- To restore an item’s factory setting, highlight the item and select Reset.

- To unassign an item, highlight the item and select None.
9  Press **OK**.

**DID YOU KNOW?** You can also customize your smartphone so that pressing and holding the Side button on the side of your smartphone opens Windows Media Player Mobile. See [Reassigning buttons](#) for details.
Your personal information organizer

Say good-bye to paper calendars and throw away those scribbled to-do lists. Your smartphone is all you need to organize your personal information and keep it with you wherever you go.

You never lose your information, even if your battery is completely drained. All your personal information is backed up each time you synchronize, and your information is kept private when you use your smartphone’s security features. Also, you can easily share info with others electronically.

Benefits

- Track current, future, and past appointments
- Make to-do lists that get done
- Set reminders for appointments, birthdays, important tasks, and more
In this chapter

Contacts ................................................................. 141
Calendar ................................................................. 143
Tasks ................................................................. 149
Notes ................................................................. 151
Calculator ................................................................. 154
Contacts

Adding a contact
1. Press Start and select Contacts.

**TIP** You can also open Contacts from your Today screen. Press Menu and select Contacts.

2. Press New (left action key).

3. Use the 5-way to move between fields as you enter information.

4. To add a caller ID picture that appears when that person calls, select Picture and then select Camera and take a picture, or select an existing picture from the Thumbnail screen.

5. To assign the entry to one or more categories, select Categories and then check the categories under which you want this entry to appear.

6. To add a note to an entry, select the Notes tab.

7. To assign a ringtone to the entry, select Ring tone and select a tone.

8. After you enter all the information, press OK.

**TIP** If you have many contacts to enter, it’s best to enter them in Microsoft® Office Outlook® on your computer and then sync. See Synchronizing information for details.

**TIP** Be sure to enter mobile numbers and email addresses in the correct fields. Otherwise, Messaging can’t find this info when you address a message and Calendar can’t find your contacts to invite them to meetings.

Viewing or changing contact information
1. In the Contacts list (name view), begin entering one of the following for the contact you want to view or edit:
   - First name
   - Last name
• First initial and last initial separated by a space
• Phone number

**TIP** In the Contacts list, press **Up** and **Down** on the 5-way to move to the previous or next contact.

2 Select the entry you want to open.
3 Press **Menu** (right action key) and select **Edit**.
4 Make changes to the entry as necessary.
5 Press **OK** 🟍.

**DID YOU KNOW?** You can find a contact by company name. Press **Menu** and select **View By > Company**. Select a company name to see the contacts who work there.

**TIP** To view a particular group of contacts, press **Menu**, select **Filter**, and then select the category you want to view.

### Customizing Contacts

1 Go to the Contacts list.
2 Press **Menu** (right action key) and select **Options**.
3 Set any of the following options:

- **Show alphabetical index**: Displays the alphabet at the top of the Contacts list. You can use this index to find a contact.

- **Show contact names only**: Lets you fit more names on the Contacts list by hiding everything but the contact’s name.

- **Area code**: Sets the default area code for new contact entries.

4 Press **OK** 🟍.

### Finding a contact in an online address book

In addition to having contacts on your device, you can also access contact information from your organization’s online address book or Global Address List (GAL).
BEFORE YOU BEGIN  Make sure you are accessing an Exchange Server 2003 upgraded to Service Pack 2. You must synchronize with the Exchange Server in order for the Find Online option to appear.

1  Press Start and select Contacts.
2  Press Menu (right action key), and select Find Online.

Calendar

Displaying your calendar
1  Press Start and select Calendar.
2  Press Menu (right action key) and select View.
3  Select one of the following views:
   - Agenda: Shows your daily schedule in list format. Upcoming appointments are bold; past appointments are dimmed.
   - Day: Shows your daily schedule in day-planner format.
   - Week: Shows your schedule for an entire week.
   - Month: Shows your schedule for a whole month using the following symbols:
     - A morning appointment
     - An afternoon appointment
     - Both morning and evening appointments
     - An all-day event
   - Year: Shows a calendar for a six-month period.
4  Use the 5-way to move to another day, week, month, or year (based on the current view).

Creating an appointment
1  Press Start and select Calendar.
2  Press Menu (right action key) and select New Appointment.
Creating an untimed event

An untimed event, such as a birthday, anniversary, or vacation, does not occur at a particular time. These events appear as banners at the top of your calendar; they don’t occupy blocks of time. For example, “Submit Final Draft” in the following screenshot is an untimed event.

1  Press Start (right action key) and select Calendar.

2  Press Menu (right action key) and select New Appointment.

3  Enter a Subject (description).

4  Select the starting and ending dates.

TIP If you have several appointments to enter, it’s most efficient to enter them in Microsoft Office Outlook on your computer and then synchronize your smartphone with your computer. For more information, see Synchronizing information.

TIP To pencil in an appointment, open the appointment, select Status, and then select Tentative.

DID YOU KNOW? An untimed event can last longer than a day.
5. Select **All Day**, and then select **Yes**.
6. Press **OK**.

**Scheduling a repeating appointment**
1. Create an appointment or an untimed event, and then select it.
2. Press **Edit**.
3. Select **Occurs**, and then select a repeat pattern. To create a repeat pattern, select **Edit pattern** and follow the onscreen instructions.
4. Press **OK**.

**Adding an alarm reminder to an event**
1. Create an event, and then select it.
2. Press **Edit**.
3. Select **Reminder**, and then select **Remind Me**.
4. Enter the number of minutes, hours, days, or weeks before the event you would like to receive the alarm.

**Sending a meeting request**
You can email meeting invitations to contacts who use Microsoft Office Outlook or Outlook Mobile.

**BEFORE YOU BEGIN**
Create contact entries with email addresses for the people you want to invite to a meeting. You can’t access contact entries without email addresses from your calendar.

1. Create an event, and then select it.
2. Press **Edit** (left action key).
3. Select **Attendees**, and then select the name of the contact you want to invite.
To invite other attendees, select Add and select the names.

4 Press OK (left action key).

The next time you synchronize, the meeting request is sent to the attendees. When attendees accept your meeting request, the meeting is automatically added to their schedules. When you receive their response, your calendar is updated as well.

**DID YOU KNOW?** If you are using an Exchange 2003 Server with Service Pack 2, you can use your corporate Global Address List to find contact information for an attendee. Select Attendees, press Menu, and then select Find Online. Enter the name of the attendee and select Find.

**Marking an event as sensitive**

If other people have access to your Microsoft Office Outlook calendar on your computer and you don’t want them to see an appointment, you can mark that appointment as private to hide it from other Microsoft Office Outlook users.

1 Create an event, and then select it.

2 Press **Edit** (left action key).

3 Select **Sensitivity**, and then select one of the following:

   **Private**: Displays the event on your smartphone and on your computer. Meeting attendees or recipients see “Please treat this as Private” near the top of an open appointment. If you sync with Exchange Server, other users who can access your folders can’t see your private events; they see private events as **unavailable** time slots.

   **Personal**: Displays the event on your smartphone and on your computer. Meeting attendees or recipients see “Please treat this as Personal” near the top of an open appointment.

   **Confidential**: Displays the event on your smartphone and on your computer. Meeting attendees or recipients see “Please treat this as Confidential” near the top of an open appointment.

4 Press **OK** (left action key).
Organizing your schedule
Use categories to view specific types of events.

1. Create an event, and then select it.

2. Press Edit (left action key).

3. Select Category, and then check the categories that apply to this event. To add a new category, press New (left action key), enter the category name, and then press OK.

4. Press OK two more times.

5. After you assign events to categories, press Menu (right action key) and select Filter.

6. Select the type of events you want to view.

Deleting an event

1. Highlight the event you want to delete.

2. Press Menu (right action key) and select Delete Appointment.

3. Select Yes.

Customizing Calendar

1. Press Menu (right action key) and select Options.
2 On the General tab, set any of the following options:

1st day of week: Sets Sunday or Monday as the first day of the week for all Calendar views.

Week view: Sets whether five, six, or seven days appear in Week View.

Show half hour slots: Sets whether time slots appear in one-hour or half-hour increments in Day View and Week View.

Show week numbers: Sets whether week numbers (1–52) appear in Week View.

3 Select the Appointments tab and set any of the following options:

Set reminders for new items: Sets whether a reminder is automatically added to new events and how long before the event the reminder appears. You can override this setting for individual events.

Show icons: Sets which icons appear next to events.

Send meeting requests via: Sets the Messaging method used to send meeting requests: email, MMS, or SMS.

4 Press OK.
Tasks

You can use Tasks to remind you of tasks you need to complete, and to keep a record of completed tasks.

**DID YOU KNOW?** If you want to use Tasks Over the Air (OTA) synchronization, install the software from your Getting Started CD. OTA features also require an Exchange Server 2003 upgrade to Service Pack 2. The option to synchronize tasks wirelessly in the ActiveSync® application appears only if you have the appropriate server.

**Adding a task**

1. Press **Start** and select **Programs**.
2. Select **Tasks**.
3. Press **New**.
4. Enter a description of the task as the **Subject**.

5. Set any of the following:

   **Priority:** Sets the priority level for this task. Later you can arrange your tasks based on the importance of each task.

   **Status:** Indicates whether the task is now complete.

   **Starts:** Specifies when the task begins.

   **Due:** Sets the due date for the task.

   **Occurs:** Indicates whether the task repeats at regular intervals and how often it repeats.

   **Reminder:** Sets an alarm for this task and indicates when you want to be reminded.
**Categories:** Assigns the task to one or more categories.

**Sensitivity:** Marks this task as Normal, Personal, Private, or Confidential.

**Notes:** Lets you enter additional text for the task.

6 Press **OK**.

**TIP** You can also add a task by selecting the Tasks entry bar at the top of the screen.

### Checking off a task

1 Select the task that you want to check off.

2 Press **Edit** (left action key).

3 Select **Status** and select **Completed**.

4 Press **OK**.

**TIP** You can also mark a task complete by tapping the check box next to the task on the Tasks list.

**DID YOU KNOW?** Overdue tasks appear in red.

### Organizing your tasks

1 In the Tasks list, press **Menu** (right action key) and select Filter.

2 Select which tasks you want to view: **All Tasks, Recently Viewed, No Categories, Active Tasks, Completed Tasks**, or a specific category, such as Business or Personal.

3 Press **Menu** (right action key) and select **Sort By**.

4 Select the sort method: **Status, Priority, Subject, Start Date, or Due Date**.

### Deleting a task

1 Highlight the task you want to delete.

2 Press **Menu** (right action key) and select **Delete Task**.

3 Select **Yes**.
Customizing Tasks

1. Go to the Tasks list.
2. Press Menu (right action key) and select Options.
3. Set any of the following options:
   - Set reminders for new items: Automatically adds a reminder to new tasks. The default reminder is set to 8:00 on the morning the task is due. You can override this setting for individual tasks.
   - Show start and due dates: Displays task start and due dates in the Tasks list.
   - Show Tasks entry bar: Displays the Tasks entry bar at the top of the Tasks list.
4. Press OK.

Creating a note

1. Press Start and select Programs.
2. Select Notes.
3. Press New (left action key).
4. Do one of the following:
   - Type the text using the keyboard.
   - Write the text with the stylus.
   - Draw a sketch with the stylus, crossing at least three ruled lines.
5. Press OK.

Notes

Notes are a great way to capture thoughts, questions, and meeting notes on your smartphone.

Recording a voice note

You can create a new voice note or add a recording to an existing note.
1 Press Start and select Programs.

2 Select Notes.

3 To add a recording to a note, open the note you want to add the recording to. To create a new voice note, skip this step.

4 Press Menu (right action key) and select View Recording Toolbar.

5 Select the record icon to begin recording.

6 Speak into your smartphone’s microphone or hold it close to another sound source.

7 After you finish recording, select the stop icon to stop recording. A Recording icon appears in the note or note list, depending on where you recorded the note.

8 Press OK.

DID YOU KNOW? You can add several voice notes within a single note.

Creating a note from a template

1 Go to the Notes list.

2 Select the Show list in the upper-left corner, and then select Templates.

3 Open the template you want to use.

4 Enter the information.

5 Press OK.

6 Rename the note and move it to the appropriate folder. See Organizing your notes for details.

TIP To create a new template, open the note you want to save as a template. Press Menu and select Rename/Move. Select Name, and then enter a name for the template. Select the Show list, and then select Template. Press OK.
Organizing your notes

You can rename your notes, move notes to another folder, and move notes between your smartphone and an expansion (storage) card.

1. Go to the Notes list and highlight a note you want to move.
2. Press Menu (right action key) and select Rename/Move.
3. Select Name, and then enter a new name for the note.
4. Select Folder, and then select the folder in which you want to store the note.
5. Select Location, and then select Main memory or Storage Card.
6. Press OK.
7. Select the Show list in the upper-left corner, and then select the folder you want to view.
8. Select the Sort By list in the upper-right corner, and then select whether you want to sort your notes by Name, Date, Size, or Type.

Deleting a note

1. Go to the Notes list and highlight the note you want to delete.
2. Press Menu (right action key) and select Delete.
3. Select Yes.

Customizing Notes

1. Go to the Notes list.
2. Press Menu (right action key) and select Options.
3. Set any of the following options:
   - Default mode: Sets the default entry mode to Writing or Typing.
   - Default template: Sets the default template for new notes.
   - Save to: Sets the default location where new notes are stored.

TIP To create a new folder, go to the Notes list, select the Show list in the upper-left corner, and then select Add/Delete. Select New, enter a name for the folder, and then press OK.
Record button action: Sets whether the Side button opens the Notes application or stays in the current application.

4 Press OK ( ).

Calculator

You can use Calculator for basic arithmetic calculations, such as addition, subtraction, multiplication, and division.

Performing calculations

1 Press Start ( ) and select Programs.
2 Select Calculator ( )
3 Enter numbers and perform calculations, including the following:

- ▼ Clears the last digit in a multi-digit entry.
- ◯ Clears the current calculation or the displayed number.
- 1/x Calculates the reciprocal of a number.
- % Calculates percentage.
- √ Calculates the square root of a number.
- +/- Switches a number between negative and positive.

TIP You can tap the screen or use the keyboard to input numbers.

TIP To paste a number you copied from another application, press Edit (left action key) and select Paste. To copy a number, press Edit (left action key) and select Copy. You can paste the copied number into another application.

TIP For more advanced calculations, use Excel® Mobile. See Excel Mobile for details.
Using the Calculator memory

- To store a number, select the box to the left of the entry box. An M appears in the box.
- To add the displayed number to the number stored in memory, select M+.
- To display the number stored in memory, select MR.
- To clear the memory, select MC.

DID YOU KNOW? When you store a number in memory, it replaces the one that is currently stored.
Your Microsoft Office tools

Your smartphone enables you to take your office with you—including your Microsoft Office files. With Microsoft Office, you can carry, create, view, and edit Microsoft Word and Excel® files directly on your smartphone. You can also view, carry, and manage PowerPoint® files on your smartphone. You can keep updated copies of the files on both your smartphone and your computer so that you can work on them in the most convenient location any time.

**Benefits**

- Manage Word, Excel, and PowerPoint files on your smartphone
- Improve productivity by taking important docs, spreadsheets, and presentations with you
In this chapter

Synchronizing your Microsoft Office files ............................... 159
Word Mobile ................................................................. 159
PowerPoint Mobile ......................................................... 165
Excel Mobile ................................................................. 167
Synchronizing your Microsoft Office files

You can edit Microsoft Office files on your computer or on your smartphone and then synchronize your files so that changes you make show up on both your computer and your smartphone. To synchronize Microsoft Office files that are on your smartphone, you must set the Files sync option on your smartphone; see Setting synchronization options. Synchronized files are stored in your WM_<device name>_My Documents folder on your computer.

To synchronize your Microsoft Office files:

1. Open My Computer or Windows Explorer on your computer.
2. Copy the file into the WM_<device name>_My Documents located in the
3. Synchronize.

After you synchronize, follow these steps to find your Microsoft Office files on your smartphone:

1. Press Start and select Programs.
2. Select File Explorer.
3. Select the Show list in the upper-left corner and select My Device > My Documents.

Word Mobile

You can create and edit documents and templates and save them as DOC, RTF, TXT, and DOT files. You can also edit Microsoft® Office Word® documents and templates that you create on your computer. Keep in mind, however, that some of the information and formatting may be lost when you save the document on your smartphone.

TIP If you have trouble finding your synchronized Microsoft Office files, connect your smartphone to your computer, look in the Mobile Device folder, and then copy the files into a folder on your computer.
The following features are not supported in Word Mobile:

- Backgrounds
- Bidirectional text
- Document protection
- Metafiles
- Artistic page borders (lined page borders are supported)
- Password-protected files (remove password protection on your computer before opening the file on your smartphone)
- Shapes and text boxes
- Smart tags

The following features are partially supported in Word Mobile:

- Picture bullets. Regular bullets are supported.
- Revision marks. Documents appear as though all revisions were accepted; if the document is saved, revision marks are lost.
- Table styles. Some or all of the formatting is lost if the document is saved.
- Underline styles. Unsupported styles are mapped to one of the four supported styles: regular, dotted, wavy, or thick/bold/wide.
- Legacy Pocket Word files. You can open PSW files, but if you edit a file, you need to save it in DOC, RTF, TXT, or DOT format.

The following features are not supported on your smartphone, but they remain in the file so that when you open the file on your computer, they appear as expected:

- Fonts and font sizes. Original fonts are listed on your smartphone but are mapped to the closest font available.
- Footnotes, endnotes, headers, footers
- Lists. Indented lists are mapped to the closest indentation level supported by Word Mobile.
- Page breaks. Although undisplayed, all page breaks, except a break placed at the end of a document, are retained in the document.

Creating a document
1. Press Start and select Programs.
2. Select Word Mobile.
3 Press **New** (left action key).
4 Enter the text of the document.
5 Press **OK** to save the file.

**DID YOU KNOW?** When you save a new document, it is automatically named after the first several words in the file.

### Opening an existing document
1 Press **Start** and select **Programs**.
2 Select **Word Mobile**.
3 In the document list, select the document you want to open.

**TIP** To zoom in or out, open a document, press **View**, select **Zoom**, and then select the zoom level.

### Creating a document from a template
1 Go to the documents list.
2 Select the **Show** list in the upper-left corner, and then select **Templates**.

**TIP** If you don’t see Templates in the Show list, select **More Folders** to access this folder.

3 Open the template you want to use, and enter the information.
4 Press **OK**.
5 Rename the document and move it to the appropriate folder. See **Organizing your documents** for details.

**TIP** To create a new template, open the document you want to save as a template. Press **Menu** and select **Rename/Move**. Select **Name**, and then enter a name for the template. Select the **Show** list, and then select **Template**. Press **OK**.

### Finding or replacing text in a document
1 Open the document containing the text you want to find.
2 Press **Menu** (right action key) and select **Edit > Find/Replace**.
3 Select **Find what** and enter the text you want to find.
4 (Optional) Check the **Match case** box to find text that matches the capitalization in the text you entered in step 3.
5 (Optional) Check the **Match whole words only** box to find only full words that match the text you entered in step 3.
6 Select **Find** to locate the first instance of the text you entered in step 3, or select **Replace** and enter the replacement text.

7 Select **Next** to find the next instance of the text, or select **Replace** to replace it. To replace all instances of the text, select **Replace All**.

8 When you see a message notifying you that the search is done, press **OK**.

**Moving or copying text**

1 Open the document containing the text you want to move or copy.

2 Highlight the text you want to move or copy.

3 Press **Menu** (right action key) and select **Copy** to copy the text, or select **Cut** to move the text.

4 Open the document where you want to insert the text, and position the insertion point where you want the text to appear.

5 Press **Menu** (right action key) and select **Paste**.

**Saving a copy of a document**

1 Open the document you want to copy.

2 Press **Menu** (right action key) and select **File > Save As**.

3 Select **Name** and enter a new name for the file.

4 Select the **Folder** list, and then select the folder where you want to save the file.

5 Select the **Type** list, and then select the format in which you want to save the file.

6 Select the **Location** list, and then select whether you want to store the file on your smartphone or on an expansion card.

7 Select **Save**.

**Formatting text**

1 Open the document you want to format.

2 Highlight the text you want to format.

**TIP** If a document was previously saved on a computer, any unsupported formatting may be lost when you save the file.
3 Press **Menu** (right action key) and select **Format > Font**.

4 Set any of the following options for the highlighted text:
   - **Font**: Sets the typeface.
   - **Font color**: Sets the color.
   - **Size**: Sets the point size.
   - **Bold**: Indicates whether the text appears normal or thick.
   - **Italics**: Indicates whether the text appears upright or slanted.
   - **Underline**: Indicates whether the text appears with an underscore.
   - **Highlight**: Indicates whether the text appears with a yellow highlight.
   - **Strikethrough**: Indicates whether the text appears with a line through it.

5 Press **OK** to return to the document.

**Formatting paragraphs and lists**

1 Open the document you want to format.

2 Position the insertion point in the paragraph you want to format.

3 Press **Menu** (right action key) and select **Format > Paragraph**.

4 Set any of the following options:
   - **Alignment**: Aligns the text with the left, right, or center of the paragraph.
   - **List**: Creates a bulleted or numbered list.
   - **Indentation**: Changes the paragraph margins.
   - **Left**: Sets the left margin for the entire paragraph.
   - **Right**: Sets the right margin for the entire paragraph.
   - **Special**: Lets you indent the first line or set a hanging indent.
   - **By**: Sets the size of the Special indentation.

5 Press **OK** to return to the document.

**TIP** You can also use the Formatting toolbar to create a list and to align text. To indent text in lists, you must use the Formatting toolbar.
**Checking spelling in a document**

1. Open the document you want to check.
2. Press **Menu** (right action key) and select **Tools > Spelling**.
3. If an unknown or misspelled word is encountered, do one of the following:
   - Select the correct word in the list if the word is spelled incorrectly.
   - Select Ignore if the word is spelled correctly.
   - Select Add to add a new word to the spelling dictionary.

**Organizing your documents**

You can rename your documents, move your documents to another folder, and move your documents between your smartphone and an expansion (storage) card.

1. Go to the documents list.
2. Highlight a file.

3. Press **Menu** (right action key) and select **Rename/Move**.
4. Select **Name**, and then enter a new name for the document.
5. Select the **Folder** list, and then select the folder you want to move the document to.

   **TIP** To check the spelling of specific text, highlight it before you select the Spelling command.

   **TIP** To create a new folder, go to the documents list, select the **Show** list in the upper-left corner, and then select the **Add/Delete** tab. Select **New**, enter a name for the folder, and then press **OK**.

   **TIP** When you go to a folder, you can easily search your documents by sorting by type.

6. Select the **Location** list, and then select **Main memory** or **Storage card**.
7. Press **OK**.
8. Select the **Show** list in the upper-left corner, and then select the folder you want to view.
9. Select the **Sort By** list in the upper-right corner, and then select the sort method.
Deleting a document
1. Go to the documents list.
2. Highlight the document you want to delete.
3. Press Menu (right action key) and select Delete.
4. Select Yes.

Customizing Word Mobile
1. Go to the document list.
2. Press Menu (right action key) and select Options.
3. Set any of the following options:
   - Default template: Sets the default template for new documents.
   - Save to: Sets the default location where new documents are stored.
   - Display in list view: Sets the types of files that appear in the documents list.
4. Press OK.

PowerPoint Mobile
With PowerPoint Mobile, you can open and view slide show presentations created on your computer. Many presentation elements, such as slide transitions, animations, and URL links, are also supported.

DID YOU KNOW? You can purchase SDIO presentation modules that let you project your PowerPoint Mobile presentations through an LCD projector.

Microsoft® Office PowerPoint® features not supported on your smartphone include the following:
- Notes written for slides
- Rearrangement or editing of slides
- Files created in PPT format earlier than Microsoft PowerPoint 97
- HTML files in HTM and MHT formats

Playing a presentation
1. Press Start and select Programs.
2. Select PowerPoint Mobile.
3 In the presentation list, highlight the presentation you want to play.

4 Press **Center**.

5 Do any of the following:
   - Press **Right** to advance to the next slide or **Left** to view the previous slide.
   - Press **Menu** (right action key), select **Go to Slide**, and select the slide you want to view.
   - Select **Next** or **Previous** to play animations.
   - Press **Menu** (right action key), select **Zoom In**, and then select **Zoom In** to zoom in or **Zoom Out** to zoom out. To scroll within the current slide, tap and drag the slide. To return to the slide show, select **Return**.
   - Press **Menu** (right action key) and select **End Show**.

**Setting presentation playback options**

1 Open the presentation for which you want to change the settings.

2 Press **Menu** (right action key) and select **Show Options**.

3 Select the **Playback** tab, and check the **Override playback options for all files** box.

4 Set any of the following options:
   - **Show without animation**: Turns off builds and other animations.
   - **Show without slide transition**: Turns off transition effects between slides.
   - **Use slide timings, if present**: Enables the timings recorded with each slide in a presentation.
   - **Loop continuously**: Advances to the first slide after playing the last slide in a presentation.

5 Press **OK**.

**TIP** If a presentation is set up as a timed slide show, the slides advance automatically. Presentations pause during zooming.

**TIP** To turn the presentation into a continuously looping slide show, check both the **Use timings, if present**, and the **Loop continuously** boxes.
Excel Mobile

With Excel Mobile you can create and edit workbooks and templates on your smartphone. You can also edit workbooks and templates that you create on your computer. However, keep in mind that you may lose some of the information and formatting when you save the workbook on your smartphone.

**Alignment:** Vertical text appears horizontal.

**Borders:** Borders appear as a single line.

**Cell patterns:** Patterns applied to cells are removed.

**Fonts and font sizes:** The original font is listed on your smartphone and is mapped to the closest font available. Original fonts reappear on your computer.

TIP For simple calculations, use the Calculator (see Calculator).

Note the following formatting considerations:

**Number formats:** Microsoft® Excel® 97 conditional formatting is displayed in Number format.

**Formulas and functions:** Unsupported functions are removed, and only the returned value of the function appears. Formulas containing the following are also converted:

- An array or array argument, for example, =SUM({1;2;3;4}), is converted to its value.
- An external link reference or an intersection range reference, is converted to its value.
- A reference past row 16384 is replaced with #REF!.

**Protection settings:** Most protection features are disabled but are not removed. However, password protection is removed. You must remove the password protection in Microsoft® Office Excel® on your computer before opening the file on your smartphone.

**Zoom settings:** Worksheet-specific zoom settings are not retained. The zoom setting applies to the entire workbook.
Worksheet names: Names that refer to other workbooks, arrays, array formulas, or intersection ranges are removed from the name list, causing those formulas to be resolved as “#NAME?” All hidden names are visible.

AutoFilter Settings: AutoFilters that cause rows to be hidden are supported. Use the Unhide command to display hidden rows. Other AutoFilters are removed, but you can use the AutoFilter command in Excel Mobile to perform similar functions.

Chart Formatting: All charts are saved as they appear in Excel Mobile. Unsupported chart types are changed to one of these supported types: Column, Bar, Line, Pie, Scatter, and Area. Background colors, gridlines, data labels, trend lines, shadows, 3D effects, secondary axes, and logarithmic scales are turned off.

The following features are not supported in Excel Mobile and are removed or modified when you open a workbook on your smartphone:
- Hidden, dialog, and macro sheets
- VBA modules

- Text boxes
- Drawing objects and pictures
- Lists
- Conditional formats and controls
- Pivot table data (converted to values)

Creating a workbook
1. Press Start and select Programs.
2. Select Excel Mobile.
3. Press New (left action key).
4. Highlight a cell where you want to enter text or other info.
5. Enter the info in the cell, and then press Enter.

TIP To insert a symbol, place the insertion point where you want the symbol. Press Menu and select Insert > Symbol. Highlight the symbol you want to insert, and then select Insert.

6. Repeat steps 4 and 5 to enter the remaining info.
7. Press OK to save the file.
Creating a workbook from a template

1. Go to the workbook list.
2. Select the Show list in the upper-left corner, and then select Templates.
3. Open the template you want to use, and enter the information you want to include in the template.
4. Press OK.
5. Rename the workbook and move it to the appropriate folder. See Organizing your documents for details.

Viewing a workbook

1. Press Start and select Programs.
2. Select Excel Mobile.

3. In the workbook list, select the workbook you want to view.
4. Press View (left action key), and then select any of the following:

   **Full Screen**: Shows as much data as possible on the screen. To return to the normal view, select Restore in the upper-right corner.

   **Zoom**: Sets the magnification level so that you can easily read the worksheet.

   **Sheet**: Lets you switch to a different worksheet.

   **Split**: Divides the window into two scrollable areas. To move the split bar, tap and drag the split bar. To remove the split bar, select View > Remove Split.

   **Freeze Panes**: Locks rows and columns so that they remain visible while you scroll. Highlight the cell at the juncture you want to lock before you select this command. To unlock the rows or columns, select View > Unfreeze Panes.

   **Toolbar**: Sets whether the toolbar appears onscreen.
**Status Bar:** Sets whether the status bar appears onscreen.

**Show:** Sets whether headings and scroll bars appear onscreen.

1. Press **View** (left action key) and select **Toolbar**.
2. Highlight the cell where you want to insert the sum.
3. Select **=**.
4. Tap and drag the stylus across the cells you want to add.
5. Press **Enter**.

**Calculating a sum**

1. Enter an equals sign (=) followed by any values, cell references, name references, operators, and functions. Example: 
   
   $=(B4/25)+100=\text{Revenue-Expenses}$

2. Press **Enter**.

**Entering a formula**

1. Open the workbook where you want to insert the function.
2. Press **Menu** (right action key) and select **Insert > Function**.
3. Select the **Category** list, and then select the type of function you want to insert.
4. Select the **Function** list, and then select the specific function you want to insert.

**Inserting a function**

1. To jump to a cell or region, press **Menu** and select **Edit > Go To**. Select **Cell reference or name** and enter the target cell info or select **Current region**. Select OK.

**TIP**

**DID YOU KNOW?** You can also switch worksheets by selecting the sheet list at the bottom of the screen.
5 Select **OK**.

**Entering a sequence automatically**

1 Highlight both the cells containing the info you want to automate and the adjacent destination cells.

2 Press **Menu** (right action key) and select **Edit** > **Fill**.

3 Select the **Direction** list, and then select the direction you want to populate.

4 Select the **Fill type** list, and then select **Series**.

5 Select the **Series type** list, and then select the type of series you want. If you select Date or Number, enter a Step value increment.

6 Select **OK**.

**TIP** Select Autofill as the series type when you want to quickly fill cells with repetitive data such as numbers or repeated text. Autofill takes the content of the first cell in the highlighted row or column and copies it down or across the rest of the selection.

**Adding cells, rows, and columns**

1 Open the workbook you want to add to.

2 Highlight the area where you want to insert elements.

3 Press **Menu** (right action key) and select **Insert** > **Cells**.

4 Select how you want to insert the elements:
   - **Shift cells right**: Inserts a new cell. The highlighted cell and all cells on its right move one column to the right.
   - **Shift cells down**: Inserts a new cell. The highlighted cell and all cells below it move down one row.
   - **Entire row**: Inserts a new row. The entire row in which the highlighted cell is located and all rows below it move down one row.
**Entire column:** Inserts a new column. The entire column in which the highlighted cell is located and all columns to its right move one column to the right.

5. Select **OK**.

**Formatting cells**
1. Open the workbook you want to format.
2. Highlight the cells you want to format.
3. Press **Menu** (right action key) and select **Format > Cells**.
4. Select any of the following:
   - **Size:** Sets the row height and column width.
   - **Number:** Sets the type of information the cells contain.
   - **Align:** Sets whether text wraps within the highlighted cells, and sets horizontal and vertical alignment position.
   - **Font:** Sets the typeface, color, size, and style attributes.
   - **Borders:** Turns borders on and off for various cell edges, and sets the border and background colors.

5. Press **OK**.

**TIP** To add a new worksheet, press **Menu** and select **Format > Modify Sheets**. Select **Insert**, enter a name for the worksheet, and then press **OK**. To change the order of the worksheets, highlight a worksheet you want to move, and then select **Move Up** or **Move Down**. Press **OK** to finish.

**TIP** To name the highlighted cell or range of cells, press **Menu** and select **Insert > Define Name**. Enter the name and select **Add**. Press **OK**.

**Formatting rows and columns**
1. Open the workbook you want to format.
2. Highlight the rows or columns you want to format.
3. Press **Menu** (right action key), and then select **Format > Row or Format > Column**.
4. Select any of the following:
   - **AutoFit:** Adjusts the size of the highlighted rows or columns to their contents.
   - **Hide:** Hides the highlighted rows or columns.
Unhide: Displays hidden rows or columns in the highlighted area.

DID YOU KNOW? You can adjust the column and row size by tapping and dragging the right edge of the column or the bottom edge of the row. To automatically fit rows and columns to their contents, double-tap the lower edge of the row heading or the right edge of the column heading.

Renaming a worksheet
1. Open the workbook containing the worksheet you want to rename.
2. Press Menu (right action key) and select Format > Modify Sheets.
3. In the Sheets list, highlight the worksheet you want to rename.
4. Select Rename, enter a new name for the worksheet, and then press OK twice.

Sorting info in a worksheet
1. Highlight the cells you want to sort.
2. Press Menu (right action key) and select Tools > Sort.
3. Select the Sort by list, and then select the primary sort column.
4. Check or uncheck the Ascending box to indicate whether you want to sort in ascending or descending order.
5. (Optional) Select the Then by lists, and then select second and third level sorting options.
6. Check or uncheck the Exclude header row from sort box to indicate whether you want to sort the header row.
7. Select OK.

Filtering info in a worksheet
1. Highlight the cells that contain the info you want to filter.
2. Press Menu (right action key) and select Tools > AutoFilter. A list appears at the top of each related column.
3. Select one of the new lists, and then select a filter. This hides all rows that do not include the selected filter.
4. (Optional) Select the other lists, and then select other filters.
Creating a chart
1. Open the workbook you want to create a chart from.
2. Highlight the cells you want to include in the chart.
3. Press Menu (right action key) and select Insert > Chart.
4. Select the type of chart, and then press Next (right action key).
5. Confirm the area you want the chart to include, and then press Next (right action key).
6. Select the data layout, and then press Next (right action key).
7. Check the boxes to indicate whether the first row and column represent labels.
8. Select whether you want the chart to appear as a separate worksheet within the current workbook, or as part of the current worksheet.
9. Press Finish (right action key).

Formatting or changing a chart
1. Open the workbook that contains the chart you want to format.
2. Open the chart.
3. Press Menu (right action key) and select Format > Chart.
4. Select any of the following:
   - **Titles**: Sets the title of the chart and headings, whether a legend appears, and the placement of the legend.
   - **Scale**: Sets the minimum and maximum scales for charts with an x or y axis.
   - **Type**: Sets the chart style. You can use this setting to convert your chart to a different format.
   - **Series**: Lets you add, modify, format, or delete related data points without affecting the info in your worksheet.
5. Press OK.
Finding or replacing info in a workbook
1. Open the workbook containing the info you want to find.
2. Press **Menu** (right action key) and select **Edit > Find/Replace**.
3. Select **Find what** and enter the info you want to find.
4. (Optional) Check the **Match case** box to find text that matches the capitalization in any text you entered step 3.
5. (Optional) Check the **Match whole words only** box to find only full words that match any text you entered in step 3.
6. Select **Find** to locate the first instance of the info you entered in step 3, or select **Replace** and enter the replacement info.
7. Select **Next** to find the next instance of the info, or select **Replace** to replace it. To replace all instances of the info, select **Replace All**.
8. When you see a message notifying you that Excel Mobile has finished searching, press **OK**.

Organizing your workbooks
You can rename your workbooks, and move them to another folder and between your smartphone and an expansion (storage) card.
1. Go to the workbook list.
2. Select a file.
3. Press **Menu** (right action key) and select **Rename/Move**.
4. Select **Name**, and then enter a new name for the workbook.
5. Select the **Folder** list, and then select the folder you want to move the workbook to.
6. Select the **Location** list, and then select **Main memory** or **Storage card**.
7. Press **OK**.
8. Select the **Show** list in the upper-left corner, and then select the folder you want to view.
9. Select the **Sort By** list in the upper-right corner, and then select the sort method.

**TIP** When you go to a folder, you can easily search your documents by sorting by type.
Deleting cells, rows, and columns

1. Open the workbook containing the elements you want to delete.
2. Highlight the area you want to delete.
3. Press **Menu** (right action key) and select **Edit > Delete Cells**.
4. Select how you want to remove the elements:
   - **Shift cells left**: Deletes the highlighted cells and moves all cells on their right one column to the left.
   - **Shift cells up**: Deletes the highlighted cells and moves all cells below them up one row.
   - **Entire row**: Deletes the entire row in which the highlighted cells are located, and moves all rows below it up one row.
   - **Entire column**: Deletes the entire column in which the highlighted cells are located, and moves all columns on their right one column to the left.
5. Select **OK**.

**DID YOU KNOW?** Excel Mobile adjusts formulas to reflect the new cell locations. However, a formula that refers to a deleted cell displays the #REF! error value.

**TIP** To delete a workbook, go to the workbook list and highlight the workbook you want to delete. Press **Menu** and select **Delete**. Select **Yes** to confirm.

**TIP** To delete a worksheet, press **Menu** and select **Format > Modify Sheets**. Highlight the worksheet you want to delete, and then select **Delete**. Select **Yes**, and then press **OK** to finish.

Customizing Excel Mobile

1. Go to the workbook list.
2. Press **Menu** (right action key) and select **Options**.
3. Set any of the following options:
   - **Template for new workbook**: Sets the default template for new workbooks.
   - **Save new workbooks to**: Specifies where new workbooks are stored.
   - **Files to display in list view**: Sets which types of files appear in the workbook list.
4. Press **OK**. 
Your application and info management tools

Your smartphone comes equipped with a variety of tools for managing and organizing your information. Get the most out of your smartphone: Install some of the thousands of business, education, or leisure-time applications available. After you use your smartphone to create or capture important business and personal information, use one of several options to share it with others. Insert expansion cards (sold separately) for a compact and limitless answer to the storage dilemma.

Benefits
- Locate info in any application
- Install applications, games, and other software
- Keep others up-to-date with meaningful business and personal information
- Store, carry, and exchange info
# In this chapter

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Find</td>
<td>179</td>
</tr>
<tr>
<td>Installing applications</td>
<td>180</td>
</tr>
<tr>
<td>Removing applications</td>
<td>183</td>
</tr>
<tr>
<td>Sharing info</td>
<td>183</td>
</tr>
<tr>
<td>Using expansion cards</td>
<td>184</td>
</tr>
</tbody>
</table>
Using Find

With the built-in search features on your smartphone, you can find information quickly:

**Lookup:** Helps you find and dial your contacts by name or phone number. See Dialing by contact name for details.

**Search:** Looks through the text in all the applications on your smartphone.

**File Explorer:** Lets you browse through the files and folders on your smartphone or an expansion card.

**Global Address Lookup:** Enables you to look up names in your online corporate address list.

**Using Search**

Search for files and other items stored in the My Documents folder on your smartphone or on an expansion card. You can search by file name or by words located in the item. For example, you can search for words within notes, appointments, contacts, and tasks.

1. Press **Start** and select **Programs**.

2. Select **Search**.

3. Select **Search for**, and then enter the file name, word, or other info you want to find.

4. Select the **Type** list, and then select the kind of information you want to find.

5. Press **Search** (left action key).

6. Use the 5-way to select and view an item from the results of the search.

**DID YOU KNOW?** You can also open the Search screen by pressing **Option + left Shift**.

**TIP** If you’ve looked for an item before, select the **Search for** list, and then select the item in the list.
Exploring files and folders
File Explorer lets you browse the contents of folders on your smartphone. The root folder on your smartphone is named My Device. My Device is similar to My Computer on your computer.

1. Press Start ( Start) and select Programs.
2. Select File Explorer ( File Explorer).
3. Select the Show list in the upper-left corner, and then select the folder you want to explore.
4. Do any of the following:
   • To open an item, select it.
   • To quickly delete, rename, beam, or email an item, highlight the item, press and hold Center ( Center) to open the shortcut menu, and then select the appropriate command.
   • To move a file to another folder, highlight the item, press and hold Center ( Center) to open the shortcut menu, and then select Cut or Copy. Open the destination folder, and press and hold Center ( Center) to open the shortcut menu, and then select Paste.
   • To highlight multiple items, tap and drag the stylus.

**IMPORTANT** Do not delete any files that you cannot identify. These files may be required for your smartphone to function properly.

**DID YOU KNOW?** You can sort the contents of a folder by name, date, size, or type. Select the Sort by list in the upper-right corner, and then select the sort method.

**TIP** The storage card symbol appears next to the names of files that are stored on an expansion card.

Installing applications
Your Palm® Treo™ 700wx smartphone comes with several built-in and ready-to-use applications. You can also install any of the additional software included on the Getting Started CD, as well as other third-party applications that are compatible with Windows Mobile® 5.0 devices, such as business software,
Install applications on your smartphone:

1. Make sure your phone is on (see Turning your smartphone on/off).
2. Press Start and select Internet Explorer.
3. Go to the page that contains the link to the application you want to download.
4. Press Left or Right to highlight the link to the file, and then press Center to start the download process.
5. Press Start and select Programs.
7. Go to the My Documents folder in File Explorer.
8. Tap the file you downloaded to start the installation program.

Applications you download to your computer are likely to be in a compressed format such as ZIP. If the file is compressed, you need to use a decompression utility on your computer, such as Winzip, before you install applications on your smartphone.

These instructions tell you how to install basic files onto your smartphone. Some software uses an installer or wizard to guide you through the process. Consult the documentation that came with the software for details.

Installing applications from the Internet

You can use Internet Explorer Mobile to install Windows Mobile apps in the CAB file format directly from the Internet. You must use your computer to install apps in other file formats.

### TIP
If an application does not have a Microsoft Mobile to Market certificate, you will see a message indicating that the application is untrusted. If this occurs, you can indicate whether you want to continue the installation.

Be sure to select and install Microsoft Windows Mobile 5.0 software for Pocket PC Phone Edition. Microsoft Windows Mobile 5.0 software for Smartphone is not compatible with your Treo 700wx smartphone.

### DID YOU KNOW?
You can purchase a third-party application that lets you run Palm OS® applications on your Treo 700wx smartphone.

You can learn more about installing applications at www.palm.com/mytreo700wxVerizon.
Installing applications from your computer

BEFORE YOU BEGIN To install an application from your computer to your smartphone, you must first install the ActiveSync® software on your computer (see Installing the desktop synchronization software).

1. Open My Computer or Windows Explorer on your computer.
2. Copy the application file(s) into the Mobile Device folder.
3. Connect your smartphone to your computer to synchronize and install the application(s) on your smartphone.
4. Press Start and select Programs to open the application.

Installing applications onto an expansion card

1. Insert the expansion card into the expansion card slot (see Removing and inserting expansion cards).

2. Open the ActiveSync window on your computer.
3. Click Tools and select Explore Device.
4. Double-click My Windows Mobile-Based Device to open the Mobile Device folder.
5. Copy the application file(s) into the Storage Card folder inside the Mobile Device folder.

Getting help with third-party applications

If you encounter a problem with a third-party application (such as an error message), contact the application’s author or vendor. For general troubleshooting of third-party applications, see Third-party applications.

Make sure that the third-party application supports 240 x 240 screen resolution. Some older applications have screen-size limitations. Third-party applications should also be written for Windows Mobile version 5 or later. Programs written for earlier versions do not support 5-way navigation or action keys and can have...
performance problems. If you can try a free version of the software before purchasing it, you can test it first to make sure it works properly.

TIP  Before purchasing a third-party program, try the free version

Removing applications

To free up memory on your smartphone, you can remove applications that you no longer use. You can remove only applications, patches, and extensions that you install; you cannot remove the built-in applications that reside in the ROM portion of your smartphone.

1  Press Start and select Settings.
2  Select the System tab, and then select Remove Programs.
3  Highlight the application that you want to remove.
4  Select Remove.
5  Select Yes to confirm the deletion.

TIP  Some applications are factory-installed on your smartphone and cannot be deleted. These are not listed in the Remove Programs list.

Sharing info

Your smartphone comes equipped with a variety of options for sharing information, so that you can choose the quickest, most convenient way to send your info or to receive info from another device.

- When you have a file open in a program such as Notes or PowerPoint Mobile, you can easily share a file by pressing
Using expansion cards

The expansion card slot on your smartphone enables you to add SD cards and MultiMediaCard cards to extend the storage capacity of your smartphone. For example, SD or MultiMediaCard expansion cards can store the following:

- Pictures
- Videos
- MP3 audio files
- Email attachments
- Games
- eBooks
- Applications
- Databases

**TIP** SD cards are faster than MultiMediaCard cards for reading and writing information.

**NOTE** Your smartphone does not support SDHC (SD High Capacity) expansion cards. These cards typically have a capacity of over 2GB.
You can also purchase SDIO cards that contain software such as presentation modules. When purchasing an SDIO card, make sure that the card is compatible with the Treo 700wx smartphone.

Expansion cards are sold separately. Your smartphone comes with a dummy card inside the expansion card slot, to protect the slot. When you do not have a functioning card inside the slot, reinsert the dummy card to protect the slot opening.

**TIP** We recommend that you purchase preformatted expansion cards. To format a card on your own, you need to connect a card reader (sold separately) to your computer.

**Removing and inserting expansion cards**

1. Press down and release the dummy card.
2. After you feel the expansion card slot eject the dummy card, remove the card from the slot.
3. To insert an expansion card, hold your smartphone with the screen facing you and hold the card with the label facing you. The notch on the card should be in the lower-left corner, next to the antenna.
4. Insert the card into the expansion card slot until you feel it lock into place and you hear the confirmation tone.
Opening applications on an expansion card

After you insert an expansion card into the expansion card slot, you can open any of the applications stored on the expansion card.

1. Insert the expansion card into the expansion card slot.
2. Press Start and select Programs.
4. Select the Show list in the upper-left corner, and then select Storage Card.
5. Select the application you want to open.

Saving files to an expansion card

You may find it helpful to automatically save the info on an expansion card. For example, when you create new Word Mobile documents, notes, Excel® Mobile workbooks, pictures, videos, and audio files, you can save them directly to an expansion card. (Some applications may not support this feature.)

1. Insert an expansion card into the expansion card slot.
2. Open the application you want to save the info from.
3. Press Menu (right action key) and select Options.
4. Select the Save to list, and then select Storage Card.
5. Press OK.

**TIP** To run an application on an expansion card, your smartphone must have enough free space in the internal memory to run the application.

**TIP** If you don’t see the Save to list on the Options screen, look on the other tabs (if present). If you still can’t find a Save to list, the application may not support this feature.
Moving info between your smartphone and an expansion card

1 Insert an expansion card into the expansion card slot.
2 Open the application from which you want to move the info.
3 Go to the list view.
4 Press Menu (right action key) and select Rename/Move.
5 Select the Location list, and then select where you want to move the info: Storage Card or Main Memory.
6 Press OK  

Copying or moving applications and files between your smartphone and an expansion card

1 Insert the expansion card into the expansion card slot.
2 Press Start  and select Programs.
3 Select File Explorer.
4 Select the file or application you want to copy or move (see Exploring files and folders).
5 Press Menu (right action key) and select Edit > Copy or Edit > Cut.
6 Go to the folder where you want to place the selected item.
7 Press Menu (right action key) and select Edit > Paste.
8 Press OK  

Viewing available expansion card memory

You can view how much space is available on the expansion card that is currently in the expansion card slot.

1 Insert the expansion card into the expansion card slot.
2 Press Start  and select Settings.
3 Select the System tab, and then select Memory  
4 Select the Storage Card tab.
5 Press OK  

TIP Your applications are usually located in the My Device/Program Files folder.
Exploring files on an expansion card
1 Insert the expansion card into the expansion card slot.
2 Press Start and select Programs.
3 Select File Explorer.
4 Select the Show list in the upper-left corner, and then select Storage Card.
5 Select the folder or files you want to view.
6 Press OK.

Renaming an expansion card
If you change the contents of an expansion card, you may at some point want to rename the card to better match its contents.

TIP Before copying information to or renaming the files or folders on an expansion card, or renaming the card itself, make sure the card is not write-protected. See the instructions that came with your card for details.

1 Insert the expansion card into the expansion card slot.
2 Press Start and select Programs.
3 Select File Explorer.
4 Select the Show list in the upper-left corner, and then select My Device.
5 Highlight the current expansion card name (Storage Card by default).
6 Press Menu (right action key) and select Rename.
7 Enter a new name for the card.
8 Press OK.
Your personal settings

Customizing is optional—but why wouldn’t you personalize your smartphone to make it match your lifestyle and work even harder for you?

You can easily customize your smartphone’s sounds, fonts, screen colors, and more. Take advantage of various levels of security. Lock the keyboard to prevent making an accidental (and expensive) phone call. Some preference settings can help extend the life of your smartphone’s battery. These are just a few of the ways to make your smartphone work better for you.

Benefits

- Conserve power
- Secure your data
- Make your screen easy to read
In this chapter

Today screen settings ................................................................. 191
System sound settings ............................................................... 192
Display and appearance settings ............................................... 194
Application settings ................................................................. 196
Locking your smartphone and info ............................................ 200
Using Auto-Keyguard and touchscreen lockout .......................... 201
System settings ........................................................................ 204
Connection settings .................................................................. 210
Today screen settings

Selecting your Today screen background

1. Press Start  and select Settings.

2. On the Personal tab, select Today.

3. On the Appearance tab, check the Use this picture as the background box.

4. Select Browse.

5. Select the picture you want to use.

6. Press OK.

TIP To change the color theme for your smartphone, select a new theme from the Appearance tab in Today Settings.

Selecting which items appear on your Today screen

1. Press Start  and select Settings.

2. On the Personal tab, select Today.

3. Select the Items tab.

4. Check the boxes next to the items you want to appear on your Today screen, and uncheck any items that you want to hide.

5. (Optional) Change the Today timeout setting to adjust the period of inactivity that passes before the Today screen reappears.

6. (Optional) Select Options (if available) to configure the settings for the current item. Press OK to return to Today Settings.
7 Press **OK**.

**DID YOU KNOW?** There are lots of third-party applications available for your Today screen. For clocks, calculators, MP3 players, weather guides, and much more, visit the Handango for Verizon Wireless download site: press **Start**, select **Programs**, and then select **Downloads**.

### System sound settings

In certain situations, such as meetings and theaters, you need to turn off all sounds on your smartphone. You can immediately silence all sounds on your smartphone, including phone ringtones, Calendar notifications, and system sounds. This does not mute the speaker during phone calls.

**Setting the Ringer switch**

1. Slide the **Ringer switch** to the **Sound Off** position.

2. To hear all sounds again, slide the **Ringer switch** to the **Sound On** position.

When you slide the Ringer switch back to the Sound On position, it restores the previous sound settings. For example, if the smartphone ring volume is set to the loudest setting and you slide the Ringer switch to the Sound Off position, you do not hear the smartphone ring. When you move the Ringer switch back to the Sound On position, the smartphone ring volume is still set to the loudest setting.

**TIP** If the Ringer switch is in the Sound Off position, the Ringer switch setting overrides the sound settings and all sounds are turned off, including any music you may be playing.

**DID YOU KNOW?** Your smartphone includes a silent alarm that can vibrate even when the Ringer switch is in the Sound Off position.
Selecting Sounds & Notifications

1. Press Start ℹ️ and select Settings.
2. On the Personal tab, select Sounds & Notifications ☀️.
3. On the Sounds tab, set any of the following options:
   - **Events**: Turns sounds on/off for system warnings and error messages.
   - **Programs**: Turns sounds on/off in the applications on your smartphone.
   - **Notifications**: Turns alarms and reminders on/off in the applications on your smartphone.

**Screen taps**: Turns sounds associated with tapping the screen on/off, and sets the volume level when this sound is turned on.

**Hardware buttons**: Turns sounds associated with pressing buttons on/off, and sets the volume level when this sound is turned on.

4. Turn your phone off.

**NOTE** If your phone is on, the notification tab changes to allow you to select phone notification settings. See Selecting ringtones and vibrate settings.
5 Select the **Notifications** tab and set any of the following options:

**Event:** Specifies which action you want to change the settings for. The remaining options vary based on the action you select.

**Play sound:** Lets you turn the sound on/off for the selected event. To select a different sound, select the list to the right of this setting, and then select a different sound. To preview the sound, select **Play Sound** and then select **Play**.

**Repeat:** Indicates whether the sound plays more than once, if turned on.

**Display message on screen:** Indicates whether a notification message appears onscreen for the selected event.

**Vibrate:** Indicates whether your smartphone vibrates to notify you about the selected event.

6 Press **OK**.

**TIP** To record, preview, delete, and send sounds on your smartphone, select the **Manage** tab. To record a sound, press **Menu** and select **New Sound**. To play a sound, select it and press **Play**. To delete a sound, highlight it and press **Backspace**. To send a sound, highlight it, press **Menu**, and select **Send Sound**.

### Display and appearance settings

#### Adjusting the brightness

1. Press **Option**, and then press **P**.
2. Press **Left ▲** and **Right ▼** to adjust the brightness.
3. Press **OK**.

#### Changing the text size

1. Press **Start** and select **Settings**.
2 Select the **System** tab, and then select **Screen**.

3 Select the **Text Size** tab.

4 Press **Left** and **Right** to adjust the text size.

5 Press **OK**.

---

**TIP** If text looks rough around the edges, open the Screen Settings screen and select **Clear Type**. Check the **Enable Clear Type** box, and then press **OK**.

---

**Setting display formats**

1 Press **Start** and select **Settings**.

2 Select the **System** tab, and then select **Regional Settings**.

3 On the Region tab, select a region from the list. The region selection sets the default format settings.

4 (Optional) Select any of the following tabs to customize the format settings:

   **Number**: Sets the decimal symbol and number of decimal places, the digit grouping symbol (thousands separator) and group size, list separators, negative number sign symbol and format, leading zero display, and measurement system (metric or U.S.).

   **Currency**: Sets the currency symbol and position, the decimal symbol and position, digit grouping symbol and group size, and negative number format.

   **Time**: Sets the time style, separators, and AM and PM symbols.

   **Date**: Sets the short date style, separators, and long date style.

5 Press **OK**.

---

**Aligning the screen**

Occasionally, your screen can move out of alignment, causing the wrong feature to
become activated when you tap the screen. If this occurs, you need to align your smartphone screen.

1. Press **Start** and select **Settings**.
2. Select the **System** tab, and then select **Screen**.
3. On the General tab, select **Align Screen**.
4. Tap the screen where indicated.
5. Press **OK**.

**Changing the system color scheme**

1. Press **Start** and select **Settings**.
2. On the Personal tab, select **Today**.
3. On the Appearance tab, select a theme in the list.
4. Press **OK**.

**Tip** You can also set the background for your Today screen (see Selecting your Today screen background).

### Application settings

#### Arranging the Start menu

You can select which applications appear in the top level of the Start menu. You can still access the remaining applications by selecting Programs from the Start menu and then selecting the application’s icon.

1. Press **Start** and select **Settings**.
2. On the Personal tab, select **Menus**.
3. Check the boxes next to the applications you want to see in the Start menu.
4. Press **OK**.
Reassigning buttons

Buttons Settings lets you select which applications are associated with many of the buttons and key combinations on your smartphone.

1. Press Start and select Settings.
2. On the Personal tab, select Buttons.
3. On the Program Buttons tab, highlight the button or key combination you want to change in the Buttons list. The hardware buttons are mapped to the following buttons:
   - Start = Start Menu
   - OK = OK/Close
   - Option + Phone/Send = Internet Explorer
   - Option + Start = Calendar
   - Option + OK = Task Manager
   - Hold Side button = Windows Media

4. Select the Assign a program list, and then select the application you want to assign to the button or key combination you selected in step 3.
5. Press OK.

Setting up voice commands

Microsoft Voice Command software enables you to use speech to execute some commands on the Start menu and the Programs menu.

1. Assign the Hold Side button option to Voice Command. See Reassigning buttons for details.
2. Press Start and select Settings.
3. On the Personal tab, select Voice Command.
4. Check the Enabled box.
5 (Optional) Uncheck the **Password Protected** box if you want to be able to use voice commands without entering a password when your smartphone is locked.

6 Select the items you want to enable. If an item is highlighted and its box is checked, select **Options** to choose the features you want enabled for the highlighted item.

### Using voice commands

**BEFORE YOU BEGIN** Set the **Ringer switch** (on the top of your smartphone) to the **Sound On** position.

1 Hold your device about nine inches away from your mouth, and then press and release the Voice Command button. A tone plays and a microphone icon appears at the top of your screen.

2 In a clear voice say the command. For example:

- To access Help, say, “Help.” After Voice Command finishes speaking, a microphone icon appears at the top of your screen. Say your answer. For example, say, “General” to access general Help topics.
- To access your Calendar, say, “Start Calendar.”
- To access your music, say, “Start Windows Media.” After Voice Command finishes speaking, a microphone icon appears at the top of your screen. Say your answer.

### Setting input options

**TIP** You can also press the Voice Command button to interrupt during a question. Once the microphone icon is visible you may say your answer.

1 Press **Start** and select **Settings**.

2 On the Personal tab, select **Input**.
3 Select the **Word Completion** tab and set any of the following options:

**Suggest words when entering text:** Indicates whether word suggestions appear as you enter text. You can also specify how many letters you want to enter before a suggestion appears, how many suggestions you want to see, and whether a space appears after you insert a suggested word.

**TIP** To enter a suggested word, press **Down** on the 5-way to highlight it, and then press **Center**. You can also tap the suggested word.

**Replace text as you type:** Indicates whether the text you type adds to existing text or replaces it. This is similar to the Insert function on a computer keyboard.

4 Select the **Options** tab and set any of the following options:

**Voice recording format:** Sets the format in which you save voice notes.

**Default zoom level for writing:** Sets the initial size of text entered using onscreen writing methods.

**Default zoom level for typing:** Sets the initial size of text entered using the keyboard.

**Capitalize first letter of sentence:** Sets whether the first letter of a sentence automatically appears in
Locking your smartphone and info

Your smartphone includes several features that help you protect your smartphone from inadvertent use and keep your information private. The built-in security software lets you use your smartphone for emergency calls, such as dialing 911, even if it is locked.

**Keyguard:** Manually disables all buttons and the screen’s touch-sensitive feature to prevent accidental presses in your briefcase or pocket.

**Auto-Keyguard and touchscreen lockout:** Automatically enables Keyguard after a period of inactivity and lets you disable the screen’s touch-sensitive feature during an active call.

**Phone Lock:** Requires a lock code to make calls.

**System password lock:** Requires a password to see any information on your smartphone.

Using Keyguard

By default, your keyboard locks so that you don’t accidentally press buttons or activate screen items while your smartphone is in a pocket or bag.

- To disable Keyguard, press **Center**.
- To manually turn on Keyguard when your smartphone screen is on, press **Option** and **Power/End** to enable Keyguard.

DID YOU KNOW? If you’re using a headset or hands-free device and your smartphone is in a pocket or bag, you can manually turn on Keyguard during a call to prevent accidental key presses. Press **Option** and **Power/End** to manually turn on Keyguard.
Using Auto-Keyguard and touchscreen lockout

Auto-Keyguard lets you automatically lock the keyboard after a period of inactivity.

1. Press **Start** and select **Settings**.
2. On the Personal tab, select **Keyguard**.
3. Set any of the following options:
   - **Auto-Keyguard**: Sets the period of inactivity that passes before the keyboard automatically locks, or disables the auto-keyguard feature.
   - **Disable touchscreen**: Indicates whether the screen’s touch-sensitive feature is enabled during a call. When the screen’s touch-sensitive feature is disabled, you must use the 5-way navigator to access items on the screen.
4. Press **OK**.

Using Phone Lock

You can lock your smartphone to prevent unauthorized use of your mobile account. When your smartphone is locked, you must enter a lock code to place calls, except for emergency numbers.

1. Press **Start** and select **Settings**.
2. On the Personal tab, select **Phone**.
3. Select the **Security** tab and set any of the following options:
**Auto-lock:** Sets whether your smartphone locks automatically and when this occurs.

**Change Lock Code:** Lets you assign or change the lock code used to unlock your smartphone. Your default lock code is the last four digits of your mobile phone number. If you change the lock code, select **OK** to accept your new code.

4 Press **OK** to finish.

**TIP** When Phone Lock is on, you can unlock your smartphone by going to the Today screen, entering your lock code, and then selecting **Enter**. You do not need to enter your password to answer a call.

---

Using system password lock

To protect your personal information, you can lock the system so that you need to enter your password to access any of your information or use other features of your smartphone.

**IMPORTANT** If you lock your system, you must enter the exact password to unlock it. If you enter an incorrect password, you are given another chance. Each time an incorrect password is entered, you are given progressively longer time periods between your chances to enter the password. If you forget the password, you need to perform a hard reset to resume using your smartphone. Performing a hard reset deletes all the entries in your smartphone. However, you can restore all previously synchronized info the next time you sync (see Synchronizing information).

1 Press **Start** and select **Settings**.
2 On the Personal tab, select **Lock**.
3 On the Password tab, check the **Prompt if device unused for** box to turn on the password feature.
4 Select the first list, and then select how long a period of inactivity must pass before you are prompted to enter a password to unlock the system.

5 Select the **Password type** list, and then select a format for your password.

6 Select **Password**, tap the keyboard icon at the bottom of the screen, and use the onscreen keyboard to enter your password. Then tap the keyboard icon again to dismiss the onscreen keyboard.

7 Select **Confirm**, tap the keyboard icon, and enter the password again. Then tap the keyboard icon again to dismiss the onscreen keyboard.

8 (Optional) Select the **Hint** tab and enter a hint to help you recall your password.

9 Press **OK**.

**Entering owner information**
You can enter personal information that you want to associate with your smartphone, such as your name, company name, and phone number. You can also set whether you want this information to appear when you turn on your smartphone. If you lose your smartphone, this feature can help the person who finds it return it to you.

**TIP** You can also display your Owner Information on your Today screen. See **Selecting which items appear on your Today screen** for details.
YOUR PERSONAL SETTINGS

1 Press **Start** and select **Settings**.

2 On the Personal tab, select **Owner Information**.

3 On the Identification tab, enter any of the contact information you want to include.

4 Select the **Notes** tab and then enter any additional text you want to include.

5 Select the **Options** tab and check the boxes to indicate which info (if any) you want to appear on the screen when you turn on your smartphone.

6 Press **OK**.

---

## System settings

### Setting the date and time

Clock & Alarms Settings lets you set the time zone, time, and date for your home location and a location that you visit.

**TIP** By default your smartphone synchronizes the date, time, and time zone with the Verizon Wireless network whenever your phone is on and you are inside a coverage area. You can disable this option in Clock & Alarms Settings by selecting **More** and then unchecking the **Enable local network time** box. If you want to keep your smartphone date and time set for your selected location, uncheck the **Use network time zone** box.

**TIP** To set the display format for the date and time, see **Setting display formats**.

1 Press **Start** and select **Settings**.
2 Select the **System** tab, and then select **Clock & Alarms**.
3 On the Time tab, select **Home**.
4. Select the first list, and then select the time zone for your home location.

5. Select the hour, and then press Up ▲ or Down ▼ to increase or decrease the hour setting. Repeat this process for the minute, seconds, and AM/PM settings.

6. (Optional) Select Visiting and set the info for a location that you visit often.

7. Press OK.

8. If prompted, select Yes to accept your changes.

**Setting system alarms**

System alarms let you set alarms that are not associated with a task or appointment. For example, you can use your smartphone as an alarm clock when you travel, or set alarms to remind you when it’s time to take medication or pick up the kids.

1. Press Start and select Settings.

2. Select the System tab, and then select Clock & Alarms.

3. Select the Alarms tab.

4. Check a box to turn on that alarm.

5. Select the description next to the box you checked, and enter a description for the alarm.

6. Select the days of the week you want the alarm to go off. You can select multiple days for each alarm.

7. Select the time you want the alarm to go off, and then press OK.
8 Select the alarm icon, check the boxes to select how you want the alarm to go off, and then press OK.

**TIP** To change the alarm sound, select the alarm icon, select the Play Sound list, and then select the alarm sound you want to use.

9 Press OK to finish.

10 If prompted, select Yes to accept your changes.

**Managing identity certificates**

Your smartphone may include preinstalled certificates. Certificates are digital documents that are used to authenticate and exchange information on networks. Certificates can be issued for a user, a device, or a service.

1 Press Start and select Settings.

2 Select the System tab, and then select Certificates.

3 Select any of the following:

**Personal:** Displays certificates that establish your identity when you log in to a secured network, such as a corporate network.

**Root:** Displays certificates that identify the computers, such as servers, that you connect to. These certificates help prevent unauthorized users from accessing your smartphone and information.

4 Press OK to finish.

**TIP** To delete a certificate, tap and hold the certificate in the list and then select Delete from the shortcut menu.

**Enabling error reporting**

Error Reporting sends info that helps diagnose application errors for devices running Windows Mobile® software. When an error is detected, a text file is created. You can review the file and choose whether you want it delivered to technical support. The information is used by programming groups at Microsoft for quality control and is not used for tracking individual users or installations for any marketing purpose. The info that is collected is technical info about the state of your system when the error occurred. No documents (or any info contained in them) are intentionally sent with the report. To
ensure further security, the report is transmitted by means of a secure connection and is kept confidential and anonymous in a limited-access database.

If your smartphone is connected to your computer when you send the error report, you are not billed for sending error reports—provided that your computer is connected to the Internet. If you use the Verizon Wireless network to send an error report, data transfer charges apply.

1. Press **Start** and select **Settings**.
2. Select the **System** tab, and then select **Error Reporting**.
3. Select whether you want to enable or disable error reporting.
4. Press **OK** to finish.

**TIP** This error-reporting method meets the privacy regulations of the European Union (EU) as well as the Fair Information Practice Principles of the Federal Trade Commission. To view the Fair Information Practice Principles, visit the Federal Trade Commission website at www.ftc.gov/reports/privacy3/fairinfo.htm.

### Setting up a GPS device

If you purchased an optional Global Positioning System (GPS) receiver, your smartphone can show your exact location on a map.

1. Press **Start** and select **Settings**.
2. Select the **System** tab, and then select **GPS**.
3. On the Programs tab, select the **GPS program port** list, and then select the port for applications to use to access GPS info. This port must also be selected in your GPS application’s configuration settings.
4. Select the **Hardware** tab.
5. Select the **GPS hardware port** list, and then select the port to which your GPS receiver is connected. This must be a different port from the one you set in step 3 as your program port. To connect to the GPS device using a Bluetooth® wireless technology connection, you must first set up a partnership between the two devices (see Setting up a Bluetooth connection.)
6. Select the **Access** tab and check the **Manage GPS automatically** box. This
setting lets more than one application simultaneously access your GPS info.

7 Press **OK** to finish.

**Viewing memory usage**

1 Press **Start** and select **Settings**.

2 Select the **System** tab, and then select **Memory**.

3 Select any of the following tabs:

   **Main**: Displays the amount of memory assigned to your applications and info, as well as the amount of memory in use versus the available memory.

   **Storage Card**: Displays the amount of memory available on an expansion card that is inserted into the expansion slot on your smartphone.

   **Running Programs**: Lists the applications that are in use on your smartphone. To switch to an application, highlight it and select **Activate**. To close an application, highlight it and select **Stop**. To close all open applications, select **Stop All**.

4 Press **OK** to finish.
Viewing and optimizing power settings

1. Press Start and select Settings.
2. Select the System tab, and then select Power.
3. On the Battery tab, view the power remaining in your battery.
4. Select the Advanced tab and set whether your smartphone’s screen turns off automatically after a specified period of inactivity. You can assign different intervals for battery power and external power.
5. Press OK to finish.

TIP To conserve additional battery power, adjust the display backlight setting. Press Start and select Settings. Select the System tab, and then select Backlight. On the Battery Power tab, set whether the display backlight turns off automatically after a period of inactivity.

Turning wireless services on/off

1. Press Start and select Settings.
2. Select the Connections tab, and then select Wireless Manager.
3. Turn your smartphone’s wireless features on/off. Select All to turn all wireless features on/off.
4. Press OK to finish.
You can also turn wireless services on and off by tapping the signal-strength icon at the top of the screen and then selecting Wireless Manager.

Connection settings

Setting up a Wi-Fi® connection
Many corporate organizations and public environments, such as coffee shops, airports, and libraries, offer access to a Wi-Fi® network. A Wi-Fi network is a wireless local area network (WLAN) based on the 802.11 standard. When you purchase an optional Wi-Fi SDIO card, you can use your smartphone’s built-in software to set up a Wi-Fi connection and quickly connect your smartphone to a Wi-Fi network when you’re within range of an accessible Wi-Fi network.

Some Wi-Fi networks are known as open networks because they broadcast their name (SSID) and do not require a password. Other Wi-Fi networks broadcast their name but do require a password. Networks that do not broadcast their name are known as closed networks. Follow the instructions for the type of network you want to connect to.

NOTE See Important safety and legal information for additional guidance on using a Wi-Fi card with your Palm® Treo™ 700wx smartphone.
**IMPORTANT** Depending on where you are on a network and certain coverage conditions, you might experience interruptions with your phone operation while using a Wi-Fi card. Palm recommends that you turn off the phone radio when using any Wi-Fi card, or remove the Wi-Fi card when not in use, to ensure that you can always make and receive phone calls. For emergency calls, always remove the card from your smartphone to ensure optimal connectivity.

**TIP** Turning off the Bluetooth feature may improve your Wi-Fi card performance. To turn the Bluetooth feature off, go to your Today screen, tap the **Bluetooth** icon, and then uncheck the **Turn on Bluetooth** box.

**DID YOU KNOW?** You can conserve battery power by removing the Wi-Fi card or turning off a Wi-Fi connection when you are not planning to use it for an extended period.

**Connecting to a network that broadcasts its name**

Wi-Fi networks in public places often broadcast their network name. Your smartphone automatically attempts to detect some network settings, so you can connect to this type of network with minimal configuration.

1. Wake up your smartphone’s screen (see Waking up the screen and turning it off).
2. Insert the Wi-Fi card into the expansion slot (see Removing and inserting expansion cards).
3. If the Multiple Networks Detected dialog box appears, select the network you want to connect to.
4. When the New Network Detected dialog box appears, select the type of network you want to connect to.
5. Press **Connect** (left action key) to connect to the network.
6. If prompted, enter the password provided by the system administrator.

**Connecting to a closed network**

Because closed networks have additional security features, your smartphone cannot detect the network’s settings; you must obtain the settings from the system administrator and enter the settings manually. You can also use these steps to
manually create a connection with an open network.

1. Wake up your smartphone’s screen (see Waking up the screen and turning it off), and then insert the Wi-Fi card into the expansion slot (Removing and inserting expansion cards).

2. Tap **Wi-Fi** in the title bar.

3. Select the **Settings** link.

4. Select **Network Cards**.

5. Select **Add New**.

6. On the General tab, set the following:

   - **Network Name**: Specifies the SSID provided by the system administrator.
   - **Connects to**: Specifies whether this connection connects to the Internet or to Work. You may need to select Work to access a corporate intranet.

   **This is a device to device (adhoc) connection**: Indicates whether you’re connecting to another device or to an access point (network).

7. Select the **Network Key** tab, and then set the following:

   - **Authentication**: Sets the method used to identify devices that connect to the network.
     - **Open**: Indicates that the network uses open authentication.
     - **Shared**: Indicates that the network uses shared authentication.

   - **Network Key**: Enter the network key.
   - **Key Index**: Enter the key index.
• **WPA:** Indicates that the network is a WPA network that uses 802.1x protocols.

• **WPA-PSK:** Indicates that the network is a WPA network that requires a preshared key. A preshared key is a password that is used by all users on the network. In other words, all users have the same password.

**Data Encryption:** Sets the encryption method. The options in this list vary based on your Authentication setting.

• **Disabled:** Turns data encryption off.

• **WEP:** Turns on the wired equivalent privacy encryption method.

• **TKIP:** Turns on the temporal key integrity protocol encryption method. This method is often used to encrypt WPA and WPA-PSK connections.

**The key is automatically provided:** Indicates whether you need to specify the Network key and Key index provided by your system administrator, or whether the network provides this information. The availability of these options varies based on your Authentication and Data Encryption settings.

8 Select the **802.1x** tab, and then set the following, if available (the settings vary based on your settings on the other tabs and on the supported features of your Wi-Fi SDIO card):

![Configure Network Authentication dialog box]

**Use IEEE 802.1x network access controls:** Lets you set these parameters if required by the network.

**EAP type:** Specifies the extensible authentication protocol type.

9 Press **OK**.

**Selecting a Wi-Fi network**

After you set up a Wi-Fi connection, it’s easy to connect to that network. If you
have access to multiple Wi-Fi networks, you can select which network you want to connect to.

1. Wake up your smartphone’s screen (see Waking up the screen and turning it off), and then insert the Wi-Fi card into the expansion slot (Removing and inserting expansion cards).
2. Tap Wi-Fi in the title bar.
3. Select the Settings link.
4. Select Network Cards.
5. Highlight the network you want to connect to.
6. Press and hold Center to open the shortcut menu, and then select Connect.

Managing ISP settings
Your smartphone is already set up to connect to the Internet using a high-speed data connection on the Verizon Wireless network. To connect to the Internet, simply start Internet Explorer Mobile.

TIP To manually start a data connection on the Verizon Wireless network or another network, go to Connections Settings. On the Tasks tab, select Manage existing connections. Tap and hold the connection you want to start, and then select Connect from the shortcut menu.

For special situations, such as connecting to your ISP (Internet service provider) or a remote access server (RAS), you can set up another connection. Before you begin, obtain the following information from your ISP or system administrator:

- ISP server phone number or access point
- Username
- Password

1. Press Start and select Settings.
2 Select the **Connections** tab, and then select **Connections**.

3 On the Tasks tab, select **Manage existing connections**.

4 Select the **Modem** tab.

5 Highlight the connection you want to view or change, and then select **Edit**, or to create a new connection, select **New**.

6 Follow the onscreen instructions to edit or create the connection.

**Connecting to a VPN**

If you want to use your smartphone to access your corporate email account or other files on your corporate server, you may need to set up a VPN (virtual private network). A VPN enables you to log in to your corporate server through the company’s firewall (security layer).

You need to set up a VPN to access a corporate server in either of the following situations:

- Your company’s wireless local area network (LAN) is outside the firewall.
- Your company’s wireless LAN is inside the firewall, but you are accessing the network from outside the firewall (for example, from a public location or at home).

Check with your company’s system administrator to see if a VPN is required to access the corporate network. If you need a VPN, you must purchase and install a third-party VPN client to use this feature.

| TIP | Some VPN servers require that you install specific VPN software (sold separately) on your smartphone. For more information go to [www.palm.com/mytreo700wxVerizon](http://www.palm.com/mytreo700wxVerizon). |

Before you begin setting up a VPN, ask your system administrator for the following information:

- Your username and password
- Your server’s domain name
- Your server’s TCP/IP settings
- Your server’s host name or IP address
1 Install your third-party VPN client (see Installing applications).
2 Press Start and select Settings.
3 Select the Connections tab, and then select Connections.
4 On the Tasks tab, select Add a new VPN server connection.
5 Follow the onscreen instructions to enter the settings provided by your corporate system administrator.

Setting up a proxy server
1 Press Start and select Settings.
2 Select the Connections tab, and then select Connections.
3 On the Tasks tab, select Set up my proxy server.
4 Check both the boxes near the top of the screen.

5 Select Proxy server and enter the proxy server name.
6 Press OK.

TIP To change settings such as the port number, proxy server type, or credentials, select Advanced.

Ending a data connection
If your service plan includes minutes-of-use fees for data connections, you can reduce costs by ending the data connection when you’re done browsing the web.

1 Use the stylus to tap the 1x connection icon or the EV connection icon on the title bar.
2 Select Disconnect from the shortcut menu.
Common questions

Although we can’t anticipate all the questions you might have, this chapter provides answers to some of the most commonly asked questions. For additional information and answers to other common questions, visit www.palm.com/treo700wx-support.
In this chapter

Transferring info from another device ........................................... 219
Trouble installing the desktop software? ...................................... 219
Resetting your smartphone ............................................................. 220
Performance .................................................................................. 224
Screen ............................................................................................ 225
Network connection ........................................................................ 226
Synchronization (ActiveSync software) ......................................... 229
Email ............................................................................................. 233
Web ................................................................................................ 236
Camera .......................................................................................... 237
Third-party applications ................................................................. 238
Making room on your smartphone .................................................. 239
Voice quality .................................................................................. 240
Transferring info from another device

For information on transferring your info from a previous Windows Mobile® device or from a Palm OS® device to your new Palm® Treo™ 700wx smartphone, visit www.palm.com/treo700wx-support for instructions.

**IMPORTANT** Do not use a backup utility to transfer your info from another device to your new smartphone. This can cause your smartphone to malfunction.

**DID YOU KNOW?** You can purchase a third-party application that lets you run Palm OS applications on your Treo 700wx smartphone.

**DID YOU KNOW?** If you have questions about Windows Mobile, you can go to the Microsoft Windows Mobile website. Search for Palm devices or Pocket PCs for information.

Trouble installing the desktop software?

The Getting Started CD installs the software and drivers that let you synchronize with Microsoft® Office Outlook® for Windows. If you want to synchronize with a different personal information manager (PIM), you must install a third-party solution. Contact the PIM’s author or vendor to learn whether software is available for your Treo 700wx smartphone.

1. Shut down your computer, and then turn it on again.
2. On your computer, click **Start > Control Panel > Add or Remove** Programs.
3. Remove Microsoft® ActiveSync® if it is on your computer.
4. Quit any active applications, including virus scanners and Internet security applications.
5. Make sure you’re installing the version of the software that came with your smartphone on the Getting Started CD.
Other versions may not work with this smartphone.

6 Make sure your computer profile includes administrator rights to install software. In large organizations, these are usually granted by the system administrator.

Resetting your smartphone

Performing a soft reset
A soft reset is similar to restarting a computer. If your smartphone is not responding or you have trouble synchronizing with your computer, a soft reset may help.

1 Use one hand to press the battery door release and use the other hand to slide the battery door downward to remove it from your smartphone.

2 Use the stylus tip to gently press the reset button on the back of your smartphone.

3 Wait for the progress bar on the Treo logo screen to fill before continuing to use your smartphone.
Performing a hard reset

A hard reset erases all personal information, such as appointments, contacts, and tasks, as well as programs you have added, such as third-party software on your smartphone. Never do a hard reset without first trying a soft reset. You can restore previously synchronized information the next time you sync.

IMPORTANT Synchronize to restore your Outlook information, such as Outlook email, Calendar, Contacts, Notes, and Tasks. You can use a backup and restore solution (make sure it’s an application that’s approved by Palm) to restore configurations and preferences such as speed-dials, SMS entries, call log information, and personal settings.

A hard reset can tell you whether a problem stems from your smartphone or from an application installed on it. If you do not experience the problem after you perform a hard reset, the problem may be related to software you installed. See Third-party applications for suggestions on diagnosing third-party software issues.

1 Use one hand to press the battery door release and use the other hand to slide the battery door downward to remove it from your smartphone.

2 If the screen is off, press Power/End ♪ to wake up the screen.
3. While pressing and holding **Power/End** (.Points), use the tip of the stylus to gently press and hold the **reset** button on the back of your smartphone.

4. Continue pressing and holding both buttons until the “Erase all data?” prompt appears.

5. Press **Up ▲** to confirm the hard reset.

6. Wait for the progress bar on the Treo logo screen to fill before continuing to use your smartphone.

7. (Optional) Sync your smartphone with your computer to restore your previously synchronized info. Connect your smartphone to your computer, press **Menu →** (right action key), and then select **Programs > ActiveSync > Sync**. If you use a backup utility, you may need to also restore a backup to recover additional info and settings.

**Performing a device reset**

A device reset erases all the info that has been added on your smartphone. This function complements the hard reset by formatting your smartphone and erasing all third-party applications, personal info, and settings. If you simply want to clean out your smartphone so that someone else in your family can use it, or to troubleshoot an issue, a hard reset should meet your needs.

**BEFORE YOU BEGIN** You need to install the Device Reset application on your smartphone. On your computer, point your web browser to **www.palm.com/treo700wx-support**, download the **Device Reset** application into your **WM_<device name>_My Documents** folder, and then sync to install the file on your smartphone.

**NOTE** If you don’t have the **WM_<device name>_My Documents** folder, open the ActiveSync window, select **Tools**, select **Options**, and then check the **Files** box.

1. Press **Start oubles** and select **Programs**.
2. Select **File Explorer oubles**.
3. Go to the **My Documents** folder in File Explorer.
4. Select **Device Reset** to start the formatting process.
5. When you see a message warning you of what the application does, select
Next, and then select **OK** when the next warning message appears.

6 Wait for your smartphone to restart and complete the formatting sequence, which may take several minutes.

All third-party applications, personal info, and settings that were added to your smartphone have now been removed.

**IMPORTANT** Personal data removal and personal data retention from the memory system is the responsibility of the owner of a Palm device. Please note that advanced forensic data recovery is a possibility with any consumer device that has memory (laptop computer, handheld, music player). As such, Palm makes no warranty or claims as to the efficacy of the data removal procedures described here. Individual hardware and software conditions may interfere with the procedures described.

**Replacing the battery**

Your smartphone comes with a replaceable battery. Be sure to use a replacement battery from Palm that is compatible with Treo 700wx smartphones.

1. Press **Power/End** 📡 to turn off the screen.
2. Use one hand to press the **battery door release**, and use the other hand to slide the battery door downward to remove it from your smartphone.
3. Place a finger in the notch between the stylus and the battery, and lift up the battery at a 45-degree angle.

**TIP** Be sure to dispose of your old battery in an environmentally responsible and legal way. In some areas, disposal in household or business trash is prohibited.

**DID YOU KNOW?** Your smartphone stores all your info even when you remove the battery.
4 Align the battery contacts with the phone contacts inside the battery compartment.

5 Insert the battery into the compartment at a 45 degree angle, pressing it into place. Slide the battery door onto the back of the smartphone until it clicks into place.

6 Wait for the screen to turn on, and then enable the network time or set the date and time when prompted.

Performance

The applications are running slower than usual
1 Press Start and select Settings.
2 Select System, and then select Memory.
3 Select Running Programs.
4 Select Stop All to close all of your open applications.
5 Press OK.

If the previous steps don’t fix the problem, try doing a soft reset (see Performing a soft reset). If the problem persists, follow these steps to turn off the Microsoft® Voice Command software setting, if it is enabled:
1 Press Start and select Settings.
2 Select Personal, and then select Voice Command.
3 Uncheck the Enabled box.
4 Press OK.
**TIP** Be sure that third-party applications are compatible with Windows Mobile version 5 or later. Applications written for earlier versions can have performance problems. If you can try a free version of the software before purchasing it, you can test it first to make sure it works properly.

---

**Screen**

**The screen appears blank**

1. When the time period specified in Backlight Settings expires, the screen dims; one minute later, the screen automatically turns off. Press any key except Power/End to wake up the screen. Pressing Power/End hangs up the call.

2. Look closely at the screen. If you can see a dim image, try adjusting the screen brightness (see Adjusting the brightness).

3. If that doesn’t work, perform a soft reset (see Performing a soft reset).

4. If that doesn’t work, connect your smartphone to the AC charger (see Charging the battery) and perform a soft reset again.

5. If that doesn’t work, perform a hard reset (see Performing a hard reset).

**TIP** To find carrying cases that protect the screen and other useful accessories, visit www.palm.com/mytreo700wxVerizon

**TIP** Make sure that the third-party application supports 240x240 screen resolution. Some older applications have screen-size limits.

---

**The screen doesn’t respond accurately to taps or activates wrong features**

1. Make sure there is no debris trapped under the edges of the screen.

2. Start  and select **Settings**.

3. Select the **System** tab, and then select **Screen**.

4. On the General tab, select **Align Screen**.

5. Follow the onscreen instructions to align the screen.

6. Press **OK**.
Network connection

**Signal strength is weak**
1. If you’re standing, move about 10 feet in any direction.
2. If you’re in a building, move near a window. Open any metal blinds.
3. If you’re in a building, move outdoors or to a more open area.
4. If you’re outdoors, move away from large buildings, trees, or electrical wires.
5. If you’re in a vehicle, move your smartphone so that it’s level with a window.

**TIP** Become familiar with low coverage areas where you live, commute, work, and play, so you know when to expect signal-strength issues.

**My smartphone won’t connect to the mobile network**
1. Try the preceding suggestions for weak signals.
2. Turn off your smartphone and turn it on again (see Turning your smartphone on/off).
3. Perform a soft reset (see Performing a soft reset).
4. Depending on where you are on a network and certain coverage conditions, you might experience interruptions with your phone operation while using a Wi-Fi® card. We recommend that you turn off the phone radio when using any Wi-Fi card, or remove the Wi-Fi card when not in use, to ensure that you can always make and receive phone calls. For emergency calls, always remove the card from your smartphone to ensure optimal connectivity.

**My smartphone seems to turn off by itself**
If a system error and reset occur, the phone automatically turns on if it was on before the reset. However, if your smartphone can’t determine whether your phone was on before the reset, it does not automatically turn on the phone (see Turning your smartphone on/off).
I can’t tell if data services are available
Go to your Today screen and look at the icons in the title bar. These icons indicate whether data services are available. For info on what each icon indicates, see What are all those icons?

My smartphone won’t connect to the Internet
Your smartphone supports NationalAccess (1xRTT) or BroadbandAccess (EVDO) wireless data networks. To connect to the Internet, you must subscribe to data services with Verizon Wireless.

- Contact Verizon Wireless to verify that your subscription plan includes data services and that these services have been correctly activated. Verizon Wireless should also be able to tell you if there are any outages in your location.
- Press and hold Power/End to turn off your smartphone. Then press and hold the same button to turn it back on again.
- Perform a soft reset (see Performing a soft reset).
- Confirm that data services are correctly configured on your smartphone:
  1. Press Start and select Settings.
  2. Select the Connections tab, and then select Connections.
  3. On the Tasks tab, select Manage existing connections.
  4. If BroadbandAccess appears in the list, press OK. If not, contact Verizon Wireless for assistance.

I can’t send or receive text or multimedia messages
- Make sure your phone is on (see Turning your smartphone on/off).
- Contact Verizon Wireless to verify that your plan includes messaging services, that these services have been correctly activated, and that they are available at your location (Verizon Wireless should be able to tell you if messaging services have been experiencing transmission delays).
- If possible, contact the recipient or sender of the message, and make sure the receiving device can handle the type of message you’re sending.
If a text message arrives but does not display a notification, perform a soft reset (see Performing a soft reset).

I can’t make or receive calls using a hands-free device with Bluetooth® wireless technology
Verify all of the following:
- The Turn on Bluetooth box is checked in Bluetooth Settings.
- Your Bluetooth device is charged and turned on.
- Your smartphone is within range of the hands-free device. Bluetooth range is up to 30 feet in optimum environmental conditions. Performance and range may be reduced by physical obstacles, radio interference from nearby electronic equipment, and other factors.
- The Bluetooth Settings screen is closed.
- You are away from other devices using the 2.4 GHz radio frequency, such as cordless phones, microwaves, and Wi-Fi equipment. If this is impossible, move the phone closer to the hands-free device.

The device specifications are compatible with your smartphone.

I lost the connection between my smartphone and my Bluetooth headset
1 Press Start ( ), and then select Settings.
2 Select the Connections tab, and then select Bluetooth ( ).
3 Select Devices tab.
4 Select your headset name from the list.
5 In Partnership Settings, make sure the Hands Free box is checked.
6 Select Save.
7 Highlight the headset name.
8 Press and hold Center ( ) to open the shortcut menu, and then select Set as Hands-Free.
9 Test your headset by making or receiving a call.
If the headset still doesn’t work, delete the existing partnership and create a new one.
To delete the partnership:
1 Press Start ( ), and then select Settings.
2 Select the **Connections** tab, and then select **Bluetooth**.

3 Highlight the headset device name.

4 Press and hold **Center** to open the shortcut menu, and then select **Delete**.

5 Create a new partnership (see Setting up a Bluetooth connection.)

### Synchronization (ActiveSync software)

Synchronization lets you back up the information on your smartphone onto your computer. If you ever need to perform a hard reset or otherwise erase all your information on your smartphone, you can synchronize your smartphone with your computer to restore the info. To make sure you always have an up-to-date backup of your info, synchronize frequently.

Before you attempt to synchronize, make sure you’ve installed the desktop synchronization software from the Getting Started CD.

| DID YOU KNOW? | You can go to the Windows website for more information at www.windowsmobile.com. |
| DID YOU KNOW? | A common cause of sync problems is the presence of protective software, such as VPNs or firewalls, on your computer or network. |
| TIP | If you are synchronizing with an Exchange Server and you’re unable to change your lock settings, check with your system administrator to find out if a system-wide locking policy is in place. |

### ActiveSync Desktop does not respond to sync attempt

As you complete the following steps, synchronize after each step. If the synchronization is successful, you do not need to complete the remaining steps.

1 Verify that the USB sync cable is securely connected at all points (see Connecting your smartphone to your computer).

2 Look for the **ActiveSync** icon at the top of your smartphone’s screen and
the ActiveSync icon in the taskbar on your computer to make sure the ActiveSync software is running on your computer.

3 Double-click the ActiveSync icon in your taskbar. From the File menu, select Connection Settings. Make sure the Allow USB connections box is checked, and then click Connect.

4 Perform a soft reset (see Performing a soft reset).

5 Restart your computer and make sure ActiveSync is running.

6 If problems persist and you’re synchronizing through a USB hub, try connecting the sync cable to a different USB port or directly to your computer’s built-in USB port.

7 If you’re already synchronizing through a built-in USB port on the front of your computer, move the sync cable to a USB on the back of your computer (if your computer has USB ports in both places).

8 Uninstall the desktop software that came with your smartphone, and then insert the Getting Started CD that came with your smartphone and repeat the installation process.

9 Verify with your computer hardware vendor that your operating system supports your internal USB controller.

**Synchronization finishes but info doesn’t appear where it should**

- With the included software, your smartphone can synchronize with the root folders of Contacts, Calendar, Tasks, and Notes. If you want to synchronize with a Global Address List (GAL), you must copy the addresses to your local Contacts list in Microsoft Office Outlook (right-click the addresses and select Add to Personal Address Book).

- Microsoft Office Outlook subfolders and public folders are not accessible with the included software. You may want to use a third-party solution instead.

- If you’re trying to synchronize offline, be sure to set your Microsoft Office Outlook Calendar, Contacts, Notes, and Tasks to be available offline.
• If you’re still having problems, try the following:

1 Make sure you’re synchronizing with the intended desktop personal information manager (PIM). The Getting Started CD lets you synchronize with Microsoft Office Outlook for Windows. If you use a different PIM, you need to install third-party software to synchronize. For more information, consult the company that makes the PIM.

2 Open ActiveSync on your computer, and make sure the necessary synchronization settings are set to synchronize the files.

3 Uninstall the ActiveSync software, reboot your computer, and then insert the Getting Started CD that came with your smartphone and repeat the installation process.

**Synchronization starts but doesn’t finish**

Make sure that you installed the desktop software that came with your smartphone. If you’re not sure that this software is installed, reinstall it.

**My media files won’t sync**

1 Make sure you have Windows Media® Player 10 installed on your computer.

2 Reinstall your synchronization software from the Getting Started CD that came with your smartphone. Media file synchronization fails if you installed the synchronization software before you installed Windows Media Player 10.
My appointments show up in the wrong time slot after I sync
1 Make sure that you installed the desktop software that came with your smartphone. If you’re not sure that this software is installed, reinstall it.
2 Open Microsoft Office Outlook and correct the wrong entries.
3 Manually enter any information you’ve added to your smartphone since the last time you synchronized.
4 Synchronize your phone and your computer.

You should now be able to assign time zones to your events without encountering this problem.

My scheduled sync doesn’t work
By default, a scheduled sync does not work while you are roaming. This is to prevent roaming charges on your account. If roaming charges are not a concern, follow these steps to continue your sync schedule while roaming:
1 Press Start and select Programs.
2 Select ActiveSync.
3 Press Menu (right action key) and select Schedule.
4 Check the Use above setting when roaming box.
5 Press OK.

An alert tells me that ActiveSync encountered a problem on the server
There is a temporary problem with the server or the server may be temporarily overloaded. Try again later, and if the problem persists, contact your system administrator.

An alert tells me that there is not enough free memory to sync my info
ActiveSync ran out of storage space. Try the following:
1 Go to Memory Settings and close all running programs. See Closing applications for details.
2 If the problem persists, see Making room on your smartphone for suggestions on other ways to free up space on your smartphone.
An alert tells me that the server could not be reached
Your smartphone had to wait too long to connect to Exchange Server. The connection may have been lost, the server may be temporarily overloaded, or the server may have encountered an internal error. Check your Exchange Server name and proxy server settings (see Setting up wireless synchronization), and try again later.

An alert tells me that ActiveSync encountered a problem with [item type] [item name]
An error occurred when ActiveSync was synchronizing a single item. You can usually correct this error only by removing the item that caused the error. If you sync again to see if the error persists, be aware that items causing this type of error are skipped and do not show up again.

An alert tells me that my account information could not be detected.
When you set up the Exchange Server sync options, the credentials page was left blank. Correct the credentials (see Setting up wireless synchronization), or set up your smartphone to sync only with a computer, and try to sync again.

An alert tells me the device timed out while waiting for credentials.
The Exchange Server credentials screen was left open too long. Re-enter the Exchange Server credentials, and try to sync again.

My Today screen settings are not restored after a hard reset
Settings such as the background image and plug-in choices are not backed up during synchronization, so they can’t be restored after a hard reset. If you use a backup utility, you may be able to restore a backup to recover your Today screen setting and other additional info.

Email

I have problems using my account
Occasionally you may experience problems in using an email account after you set it
up. If you followed the account setup procedure and are experiencing problems in using the account, verify that the account complies with your email provider’s requirements by following these steps:

- Verify both your password and your username for your email account.
- Some wireless service providers require you to be on their network to use your email account. If this is the case, be sure to use your provider’s network as the connection type for the account.
- Some wireless service providers have other requirements specific to their service. For example, Yahoo! requires you to set up POP mail forwarding for your Yahoo! account to download email messages to your smartphone. Check with your service provider to see if any provider-specific requirements exist.
- Service provider settings frequently change. If your email account was working but you are currently experiencing problems, check with your service provider to see if any of the account settings have changed.

I have problems sending and receiving email

Short periods of time when email is unavailable are common due to server problems or poor wireless coverage. If you have problems in sending or receiving mail for an extended period of time, check with your ISP or email service provider to verify that the service is working properly.

Auto Sync is not working

If Auto Sync is occurring and you turn your smartphone off or the connection to your email service provider is disconnected, the Auto Sync fails.

- Check the synchronization schedule to make sure that Auto Sync is set to occur at the expected day and time. See Setting the synchronization schedule for details.
- Press Start, select Programs, and then select ActiveSync. Press Menu (right action key) and select Configure Server. Make sure the verify password setting is on. This is required for over-the-air synchronization.
I have problems sending email
If you can receive email messages but can’t send them, try these steps, in turn:

- Make sure your ISP or email provider allows you to access email on a smartphone. Some providers do not offer this option at all; other providers require an upgrade to access email on a smartphone.
- Turn on ESMTP. Many services require authenticated access, or ESMTP, to use their SMTP servers.
- Press Start, select Programs, and then select ActiveSync. Press Menu (right action key) and select Configure Server. Make sure the SSL box is checked.
- Enter the name of a different outgoing mail server for sending mail. Many ISPs, such as cable companies, require that you have an Internet connection to their network to send email through their servers. In this case, you can almost always receive email from these accounts, but if you want to send email, you must send it through another server.

I have problems synchronizing messages on my smartphone with messages on my computer
Make sure you have chosen the same settings for the account on both your smartphone and your computer. For example, if the account is set up on your smartphone to use the POP protocol, check the ActiveSync settings on your computer to make sure that POP is selected as the protocol for that account.

My vCard or vCal email attachment isn’t forwarding correctly
Microsoft Office Outlook provides several features that work with email client software on a Windows computer. For these features to work correctly, the email client software must be properly set up.

Follow these steps to check the settings:

1. Click Start on your computer, and then select Settings.
2. Select Control Panel.
3. Select Internet Options, and then click the Programs tab.
4. Make sure that the email field is set to the correct email client software.
5 Click **OK**.
6 Start the email client software and make sure it is configured as the default MAPI client. See the documentation for your desktop email app for more info.

**When I sync with Exchange Server my info is not downloading to my smartphone**

Check with your system administrator to obtain the name of the mail server that offers you wireless access to the corporate mail system. If you can’t obtain the name of this server (some companies don’t give it out, because they don’t want wireless access to their servers), you can’t use ActiveSync to sync with Exchange Server.

You can also check the following setting:

1 Press **Start** and select **Programs**.
2 Select **ActiveSync**.
3 Press **Menu** (right action key) and select **Configure Server**.
4 Make sure the **SSL** box is checked.

**Web**

**I can’t access a page**

First, make sure you have Internet access: Open Internet Explorer Mobile and try to view a web page you’ve loaded before. To ensure that you’re viewing the page directly from the Internet, press **Menu** (right action key) and select **Refresh**. After confirming your Internet connection, try to view the page in question again. If it comes up blank, press **Menu** (right action key) and select **Refresh**.

If you’re still having trouble, the page may contain elements that are not supported by Internet Explorer Mobile, such as Flash, Shockwave, VBScript, WML script, and other plug-ins.

Some websites use a redirector to their true home page (for example, if you enter the address [http://www.palm.com/support](http://www.palm.com/support) it may resolve to [http://www.palm.com/us/support](http://www.palm.com/us/support)). If Internet Explorer Mobile can’t follow the redirect, try using a desktop browser to see the landing page of the redirector, and enter that address in Internet Explorer Mobile.
An image or map is too small on my smartphone screen

Internet Explorer Mobile has several viewing modes: One Column, Default, Desktop, and Full Screen. Switch to Desktop to see the full-size image (see Viewing a web page).

A secure site refuses a transaction

Some websites don’t support certain browsers for transactions. Please contact the site’s webmaster to make sure the site allows transactions using Internet Explorer Mobile.

Camera

Here are some tips for taking good pictures with the built-in camera:

- Take pictures in bright lighting conditions. Low-light images may be grainy, due to the camera’s sensitivity.
- Hold the camera as still as possible. Try supporting your picture-taking arm against your body or a stationary object (such as a wall).
- Keep the subject of the pictures still. Exposure time is longer with lower light levels, so you may see a blur.
- Verify that you have the brightest light source coming from behind you, lighting the subject’s face. Avoid taking indoor pictures with the subject in front of a window or light.
- Make sure the subject is at least 18 inches away from the camera to ensure good focus.

Remember that when you sync, your Camera images are stored in the C:\Documents and Settings\<Username>\My Documents\Treo My Documents folder on your hard drive (see Viewing pictures and videos on your computer).
The Camera preview image looks strange

Some third-party applications overwrite your smartphone’s color settings with their own 8-bit color settings. This can affect the Camera Preview Mode. Delete third-party applications one by one until the preview image improves.

Third-party applications

Sometimes, third-party applications can cause conflicts on your smartphone. Third-party apps that modify wireless features may affect your smartphone’s performance and may require extra troubleshooting. Use caution when installing the following types of apps:

- Ringtone managers
- Caller ID applications
- Instant messaging
- Applications that modify when your phone or data connections turn on or off and how your phone behaves

If you recently installed an app and your smartphone seems to be stuck, try the following:

1 Perform a soft reset (see Performing a soft reset).
2 Make sure the third-party application is compatible with the Windows Mobile version 5.0.2. operating system on your smartphone.
3 Delete the most recently installed application from your smartphone (see Removing applications).
4 If the problem persists, perform another soft reset.
5 If possible, synchronize or use a backup utility to back up your most recent info.
6 Perform a hard reset (see Performing a hard reset).

DID YOU KNOW? Pictures are 16-bit color. Resolution settings range from 160 x 120 to 1280 x 1024 pixels (VGA to 1.3 megapixels). Video resolution settings range from 176 x 144 to 352 x 288 pixels. You can change the resolution setting by pressing Menu (right action key) and selecting Resolution (still images) or Quality (video).
7 Synchronize or restore your backup to restore the info in your built-in apps.

8 If the problem is resolved, reinstall your third-party apps one at a time.

9 If the problem recurs, delete the last application you installed and report the problem to its developer.

**Getting more help**

Contact the author or vendor of any third-party software if you require further assistance.

**TIP** Not all third-party apps were written with the Treo 700wx smartphone keyboard and 5-way navigator in mind. You may encounter strange behavior or errors in these apps if you use the keyboard and 5-way navigator.

**Making room on your smartphone**

If you store a large number of records, or install many third-party applications, the internal memory on your smartphone may fill up. Here are some common ways to clear space on your smartphone:

**Camera:** Large images take up a lot of memory. Move images to an expansion card or delete images from your smartphone (see Viewing pictures and videos on your computer).

**Messaging:** Multimedia content and email attachments can consume excessive memory. Move multimedia content and attachments to an expansion card, or delete large files from your smartphone (see Managing your messages). You may also want to empty the Deleted Items folder.

**Internet:** If you save links to pages you’ve visited in Internet Explorer Mobile, you may want to clear all recent pages (see Customizing your Internet Explorer Mobile settings).

**Third-party applications:** You can delete infrequently used applications or move them to an expansion card (see Copying or moving applications and files between your smartphone and an expansion card).
Also, remember that your smartphone includes an expansion card slot, and that you can store applications and info on expansion cards. However, you still need free memory on the smartphone itself to run applications from an expansion card.

Voice quality

**Is the other person hearing an echo?**

- Try decreasing the volume on your smartphone to avoid coupling or feedback on the other person’s end. This applies to both the speakerphone and to the handset earpiece.
- Position the smartphone closer to your ear to prevent sound leaking back to the microphone. Keep your hand away from the microphone hole, which is on the lower-right side of your smartphone.
- If you’re using the speakerphone with your smartphone lying on a flat surface, try turning the smartphone face down (screen facing the smartphone).

**Are you hearing your own voice echo?**

Ask the other person to turn down their volume or to hold the phone closer to their ear.

**Is your voice too quiet on the other end?**

Be sure to hold the bottom of the smartphone, or the hands-free microphone, close to your mouth.

Check the signal-strength indicator. If the signal is weak, try to find an area with better coverage.
Where to learn more

For a quick introduction

**Quick Tour:** The Quick Tour introduces you to many of your smartphone’s features. It is already installed on your smartphone, and you can open it at any time. Press **Start**, select **Programs**, and then select **Quick Tour**.

While using your smartphone

**On-device User Guide:** A copy of this guide is included on your smartphone. The on-device guide is specially formatted for your smartphone screen. To view the on-device guide, press **Start** and select **Help**.

**Online support from Palm:** For up-to-date downloads, troubleshooting, and support information, go to www.palm.com/treo700wx-support.

If you need more information

**Books:** Many books on Windows Mobile® devices are available in local or online book retailers (look in the computers section), or visit www.palm.com/mytreo700wxVerizon.

**Online forums:** Consult online Palm® Treo™ 700wx smartphone user discussion groups to swap information and learn about topics you may find nowhere else. Visit www.palm.com/treo700wx-support for details.

**Verizon Wireless Customer Care:** For questions about your mobile account or features available on the network, contact Verizon Wireless Customer Care or visit www.verizonwireless.com for the latest information and help.
Terms

1xRTT (Single carrier [1x] radio transmission technology)
A wireless technology that can provide fast data transfer and Internet access with average speeds of 60–80Kbps and bursts of up to 144Kbps. Also called NationalAccess.

A2DP (Advanced Audio Distribution Profile)
A technology that defines how high-quality audio (stereo or mono) is streamed from one device to another over a Bluetooth® wireless technology connection, such as music streamed from a mobile phone to a wireless headset.

ActiveSync®
The technology that exchanges and updates the information on your smartphone with the information on your computer.

Alt (alternative)  
A keyboard key. Enter a letter on the keyboard, and then press Alt  to access variations such as international characters and symbols.

Auto-off interval
The time of inactivity that passes before the screen on your smartphone turns off. The wireless features on your smartphone are unaffected by this setting.

AVRCP (Audio/Video Remote Control Profile)
A technology that enables a single device to control all the A/V equipment that a user has access to, such as TVs and audio equipment. Functions include operations that you can do with a remote control device, such as pausing, stopping, and starting playback, and adjusting volume.

Beaming
The process of sending or receiving an entry or application using the infrared port on your smartphone.

BroadbandAccess
A wireless broadband technology that is designed for very high-speed data transfer, with average download speeds of 400 to 600Kbps, and is capable of reaching
speeds up to 1.8Mbps and upload speeds up to 156Kbps. Also called EVDO.

**Desktop software**
A PIM application for computers, such as Microsoft® Office Outlook®, that helps you manage your personal information and keep your personal information synchronized with your smartphone.

**EVDO (Evolution Data Optimized)**
A wireless broadband-like technology that is designed for very high-speed data transfer, with average download speeds of 400 to 600Kbps. Verizon Wireless refers to this service as BroadbandAccess.

**Infrared (IR)**
A way of transmitting information using light waves. The IR port on your smartphone lets you transfer information between other IR devices within a short radius.

**Lithium Ion (Li-Ion)**
The rechargeable battery technology used in Palm® Treo™ 700wx smartphones.

**MMS (Multimedia Messaging System)**
An enhanced messaging system that enables you to send pictures, animations, and ringtones almost instantly.

**My Mobile Devices**
The component on your Windows computer that enables you to install applications and other information on your smartphone.

**NationalAccess**
A wireless technology that can provide fast data transfer and Internet access with average speeds of 60–80Kbps and bursts of up to 144Kbps. Also called 1xRTT.

**Option**
The keyboard button that lets you access the alternative feature that appears above the letter on each key.

**Phone Off**
The indicator that appears in the upper-left corner of your Today Screen when your smartphone is not connected to any mobile network. You can still use the organizer and other features.
Phone/Send

The button on your smartphone that provides quick access to your Today screen.

Piconet

An ad-hoc network of devices that uses Bluetooth wireless technology to connect one master device with up to seven active slave devices. The network can include up to 255 inactive, or parked, slave devices which the master device can bring into active status at any time.

PIM (personal information manager)

A genre of software that includes applications such as Microsoft Outlook, Palm® Desktop software, Lotus Notes, and ACT!. PIMs generally store contacts, schedules, tasks, and memos.

SMS

The service that exchanges short text messages almost instantly between mobile devices. These messages can usually include up to 160 characters. Treo 700wx smartphones can send and receive text messages while you are on a voice call.

SSID

The name that identifies a Wi-Fi® network. If a network does not broadcast its SSID, you must get the SSID from the system administrator in order to connect to the network.

Start

The menu on your smartphone from which you can open all applications.

Username

The name associated with your smartphone that distinguishes it from other Windows Mobile® devices. When you first synchronize your smartphone, you are asked to give it a username.

Wi-Fi® access point

A network device with an antenna that provides wireless connections to a larger network. Also called a hotspot.

Windows Mobile

The operating system of your Treo 700wx smartphone.
Important safety and
legal information

FCC Statement

This equipment has been tested and found to comply with the limits for a Class B computer peripheral, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

RF Safety Exposure to Radio Frequency Energy (SAR)

Radio transmitting devices radiate Radio Frequency (RF) energy during its operation. RF energy can be absorbed into the human body and potentially can cause adverse health effects if excessive levels are absorbed. The unit of measurement for human exposure to RF energy is “Specific Absorption Rate” (SAR).

The Federal Communications Commission (FCC), Industrie Canada (IC), and other agencies around the world have established limits that incorporate a substantial safety margin designed to assure the safety of all persons using this equipment.

In order to certify this unit for sale in the US, Canada and Europe this unit has been tested for RF exposure compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF Energy.

SAR was measured with the unit transmitting at its maximum certified RF power. Often, however, during normal operation the unit will transmit much less than maximum power. Transmit power is controlled automatically and, in general is reduced as you get closer to a cellular base station. This reduction in transmit power will result in a lower RF energy exposure and resulting SAR value.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of bodyworn accessories.

- A Palm® brand body-worn accessory that has been tested for SAR compliance and is intended for use with this product.
- An accessory that contains NO metal (snaps, clips, etc.) and provides AT LEAST 1.5 cm of separation between the user’s body and the unit.

Do NOT use the device in a manner such that it is in direct contact with the body (i.e., on the lap or in a breast pocket). Such use will likely exceed FCC RF safety exposure limits. See www.fcc.gov/oet/rfsafety/ for more information on RF exposure safety.

The Palm® Treo™ 700wx smartphone may be used with a Wi-Fi® SDIO card; however, the user must ensure that the SDIO Wi-Fi card has been approved by the FCC for use with the Treo 700wx smartphone. For a list of SDIO Wi-Fi cards approved by the FCC for use with the Treo 700wx smartphone, please go to www.palm.com/ treo700wx-support.

If using a SDIO Wi-Fi card not approved for use with the Treo 700wx smartphone by the FCC, the user must turn off the phone (CDMA radio) on the Treo 700wx smartphone.
Use of an SDIO wireless transmitter that is not approved in conjunction with the phone (CDMA radio) is not authorized by the FCC and may exceed FCC RF exposure guidelines.

**Responsible party**
Palm, Inc.
950 W. Maude Ave.
Sunnyvale, CA 94085
USA
www.palm.com

**Antenna Care/Unauthorized Modifications**
Use only the supplied integral antenna. Unauthorized antenna modifications or attachments could damage the unit and may violate FCC regulations. Any changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

**Declaration of Conformity**
Treo 700wx Model
Palm declares that the above model of Treo 700wx smartphone is compliant with the regulations below. The declaration applies to the smartphone and its associated accessories (power supply, headset, and USB cable) where applicable.

<table>
<thead>
<tr>
<th>Maximum Scaled SAR Values (W/kg)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Band</strong></td>
<td><strong>CDMA Cellular</strong></td>
</tr>
<tr>
<td>Head SAR (Held to Ear)</td>
<td>(W/Kg) 1.26</td>
</tr>
<tr>
<td>Body SAR (Worn)</td>
<td>(W/Kg) 1.01</td>
</tr>
</tbody>
</table>

For SAR values when used with a SDIO Wi-Fi card go to:
www.palm.com/treo700wx-support.
FCC OET Bulletin 65 Supplement C

**Using TTY**
A TTY (also known as TDD or text telephone) is a telecommunications device that allows people who are deaf or hard of hearing, or who have speech or language disabilities, to communicate by telephone.

Your Palm Treo 700wx smartphone is compatible with select TTY devices. You can connect a TTY/TDD machine to your smartphone through the headset jack, but you cannot use your headset jack with a headset or hands-free kit while this mode is enabled. Please check with the manufacturer of your TTY device for connectivity information and to ensure that the TTY device supports digital wireless transmission.

To use TTY, you may need to make additional arrangements with your network operator. Please contact your network operator’s customer service department for more information.

1. Press the **Start** button and select **Settings**.
2. On the **Personal** tab, select the **Phone** icon.
3. On the **Phone** tab, select the **TTY/TDD** list, and then select either **TTY Full**, **TTY + Talk**, or **TTY + Hear**.
4. Press **OK**. A keyboard icon appears at the top of your Today screen whenever TTY is enabled.

To disable TTY, repeat these steps and select **Off** in step 3.

FCC ID: O8FJIMI
IC ID: 3905A-JIMI
FCC Hearing Aid Compatibility

Your Treo is compliant with the FCC Hearing Aid Compatibility (HAC) requirements. For additional HAC information, including the HAC rating of this product, please refer to www.palm.com/treoHAC.

Operational Warnings

IMPORTANT INFORMATION ON SAFE AND EFFICIENT OPERATION. Read this information before using your integrated multi-service portable radio.

For the safe and efficient operation of your radio, observe these guidelines:

Potentially Unsafe Areas / Potentially explosive atmospheres Obey all signs and instructions regarding turning off your smartphone. In particular, turn off your smartphone when you are in any areas with a potentially explosive atmosphere, such as fueling areas (gas or petrol stations, below deck on boats), storage facilities for fuel or chemicals, blasting areas and areas near electrical blasting caps, and areas where there are chemicals or particles (such as metal powders, grains, and dust) in the air.

Interference to Medical and Personal Electronic Devices Most but not all electronic equipment is shielded from RF signals and certain electronic equipment may not be shielded against the RF signals from your smartphone.

Pacemakers The Health Industry Manufacturers Association recommends that a minimum separation of six inches (6") be maintained between a smartphone and a pacemaker to avoid potential interference with the pacemaker. These recommendations are consistent with the independent research by the recommendations of Wireless Technology Research.

Persons with pacemakers should:

- ALWAYS keep the smartphone more than six inches from their pacemaker when the smartphone is turned ON.
- Not carry the smartphone in a breast pocket.
- Use the ear opposite the pacemaker to minimize the potential for interference.
- Turn the smartphone OFF immediately if you have any reason to suspect that interference is taking place.

Audio Safety Some hearing aids may be affected by some digital smartphones. You may want to consult your doctor in the event of you experience interference with your hearing aid while using your smartphone. When using the speakerphone feature, it is recommended that you place your smartphone at a safe distance from your ear.

Other Medical Devices If you use any other personal medical device, consult the manufacturer of your device to determine if it is adequately shielded from external RF energy. Your physician may be able to assist you in obtaining this information.

Turn your smartphone OFF in health care facilities when any regulations posted in these areas instruct you to do so. Hospitals or health care facilities may be using equipment that could be sensitive to external RF energy.

Interference to Other Electronic Devices RF energy may affect improperly installed or inadequately shielded electronic operating and entertainment systems in motor vehicles. Check with the manufacturer or representative to determine if these systems are adequately shielded from external RF energy. Also check with the manufacturer of any equipment that has been added to the vehicle.

Repetitive Motion Injuries When using the keyboard or playing games on your smartphone, you may experience discomfort in your neck, shoulders, hands, arms, of other parts of the body. To avoid any injury, such as tendonitis, carpal tunnel syndrome, or other musculoskeletal disorder, make sure to take necessary breaks from use, take longer rests (such as several hours) if discomfort or tiring begins, and see a doctor if discomfort persists.

Blackouts and Seizures Blinking lights, such as those experienced with television or playing video games, may cause some people to experience blackout or seizure, even if never experienced before. In the event a smartphone user should experience any disorientation, loss of awareness, convulsion, eye or muscle twitching or other involuntary movements, stop use immediately and consult a doctor. Individuals with personal or family history of such events should consult a doctor before using the device. To limit the possibility of such symptoms, wherever possible every hour take a minimum of 15...
minutes, use in a well lighted area, view the screen from the farthest distance and avoid exposure to blinking lights if you are tired.

**Aircraft** While in aircraft, follow all instructions regarding the operation of your smartphone. Use of your smartphone while on board on aircraft must be done in accordance in compliance with airline instructions and regulations.

**Vehicles with Air Bags** Your smartphone should not be placed in a position that would affect the operation of air bag deployment or in a position that, should the air bag inflate, could propel the smartphone. Air bags will inflate with great force and care should be taken to protect within a vehicle that has air bags.

**Battery** Your smartphone includes an internal lithium ion battery. Please note that use of certain data applications can result in heavy battery use and may require frequent battery charging. Any disposal of the smartphone must comply with laws and regulations pertaining to lithium ion batteries.

**Driving Safety Tips Overview**
Always obey all laws and regulations on the use of smartphones in your driving area.

**Safety — Your most important call.** The Wireless Industry reminds you to use your smartphone safely when driving.

1. Get to know your smartphone and its features, such as speed dial and redial.
2. When available, use a hands-free device.
3. Position your smartphone within easy reach.
4. Let the person you are speaking to know you are driving; if necessary, suspend the call in heavy traffic or hazardous weather conditions.
5. Do not take notes or look up phone numbers while driving.
6. Dial sensibly and assess the traffic; if possible, place calls when you are not moving or before pulling into traffic.
7. Do not engage in stressful or emotional conversations that may divert your attention from the road.

8. Dial 9-1-1 to report serious emergencies—it’s free from your smartphone!
9. Use your smartphone to help others in emergencies.
10. Call roadside assistance or a special non-emergency wireless number when necessary.

**Driving Safety Tips Details**

1. Get to know your smartphone and its features such as speed dial and redial. Carefully read your instruction manual and learn to take advantage of valuable features most smartphones offer including, automatic redial and memory dial-most smartphones can store up to 99 numbers in memory dial. Also, work to memorize the smartphone keypad so you can use the speed dial function without taking your attention off the road.

2. When available, use a hands-free device. A number of hands-free smartphone accessories are readily available today. Whether you choose an installed mounted device for your smartphone or a speaker phone accessory, take advantage of these devices if available to you.

3. Position your smartphone within easy reach. Make sure you place your smartphone within easy reach and where you can grab it without removing your eyes from the road. If you get an incoming call at an inconvenient time, let your voice mail answer it for you.

4. Suspend conversations during hazardous driving conditions or situations. Let the person you are speaking to know you are driving; if necessary, suspend the call in heavy traffic or hazardous weather conditions. Rain, sleet, snow and ice can be hazardous, but so is heavy traffic. As a driver, your first responsibility is to pay attention to the road.

5. Do not take notes or look up phone numbers while driving. If you are reading an address book or business card while driving a car, or writing a “to do” list, then you are not watching where you are going. It’s common sense. Don’t get caught in a dangerous situation because you are reading or writing and not paying attention to the road or nearby vehicles.

6. Dial sensibly and assess the traffic; if possible, place calls when you are not moving or before pulling into traffic. Try to plan your calls before you begin your trip, or attempt to coincide your calls
with times you may be stopped at a stop sign, red light or otherwise stationary. But if you need to dial while driving, follow this simple tip-dial only a few numbers, check the road and your mirrors, then continue.

7 Do not engage in stressful or emotional conversations that may be distracting. Stressful or emotional conversations and driving do not mix-they are distracting and even dangerous when you are behind the wheel. Make people you are talking with aware you are driving and if necessary, suspend phone conversations which have the potential to divert your attention from the road.

8 Use your smartphone to call for help. Your smartphone is one of the greatest tools you can own to protect yourself and your family in dangerous situations-with your smartphone at your side, help is only three numbers away. Dial 9-1-1 in the case of fire, traffic accident, road hazard, or medical emergencies. Remember, 9-1-1 is a free call on your smartphone!

9 Use your smartphone to help others in emergencies. Your smartphone provides you a perfect opportunity to be a “good Samaritan” in your community. If you see an auto accident, crime in progress, or other serious emergency where lives are in danger, call 9-1-1, as you would want others to do for you.

10 Call roadside assistance or a special wireless non-emergency assistance number when necessary. Certain situations you encounter while driving may require attention, but are not urgent enough to merit a call to 9-1-1. But you can still use your smartphone to lend a hand. If you see a broken-down vehicle posing no serious hazard, a broken traffic signal, a minor traffic accident where no one appears injured, or a vehicle you know to be stolen, call roadside assistance or other special non-emergency wireless number.

NOTICE FOR CONSUMERS WITH HEARING DISABILITIES

Digital Wireless Phones to be Compatible with Hearing Aids On July 10, 2003, the Federal Communications Commission (FCC) modified the exemption for wireless phones under the Hearing Aid Compatibility Act of 1988. This means that wireless phone manufacturers and service providers must make digital wireless phones accessible to individuals who use hearing aids.

For more information, please go to the FCC’s Consumer Alert on accessibility of digital wireless phones at http://www.fcc.gov/cgb/consumerfacts/accessiblewireless.html.

Wireless telephones are hand-held phones with built-in antennas, often called cell, mobile, or PCS phones. These phones are popular with callers because they can be carried easily from place to place.

Wireless telephones are two-way radios. When you talk into a wireless telephone, it picks up your voice and converts the sound to radio frequency energy (or radio waves). The radio waves travel through the air until they reach a receiver at a nearby base station. The base station then sends your call through the telephone network until it reaches the person you are calling.

When you receive a call on your wireless telephone, the message travels through the telephone network until it reaches a base station close to your wireless phone. Then the base station sends out radio waves that are detected by a receiver in your telephone, where the signals are changed back into the sound of a voice.

The Federal Communications Commission (FCC) and the Food and Drug Administration (FDA) each regulate wireless telephones. FCC ensures that all wireless phones sold in the United States follow safety guidelines that limit radio frequency (RF) energy. FDA monitors the health effects of wireless telephones. Each agency has the authority to take action if a wireless phone produces hazardous levels of RF energy.

FDA derives its authority to regulate wireless telephones from the Radiation Control provisions of the Federal Food, Drug, and Cosmetic Act (originally enacted as the Radiation Control for Health and Safety


Hands-Free Capability All CTIA Certified portable products provide the consumer with a toll-free number for the purchase of a compatible hands-free device. 1-800-881-7256

STATIC ELECTRICITY, ESD, AND YOUR PALM DEVICE

Electrostatic discharge (ESD) can cause damage to electronic devices if discharged into the device, so you should take steps to avoid such an occurrence.

Description of ESD Static electricity is an electrical charge caused by the buildup of excess electrons on the surface of a material. To most people, static electricity and ESD are nothing more than annoyances. For example, after walking over a carpet while scuffing your feet, building up electrons on your body, you may get a shock—the discharge event—when you touch a metal doorknob. This little shock discharges the built-up static electricity.

ESD-susceptible equipment Even a small amount of ESD can harm circuitry, so when working with electronic devices, take measures to help protect your electronic devices, including your Palm® device, from ESD harm. While Palm has built protections against ESD into its products, ESD unfortunately exists and, unless neutralized, could build up to levels that could harm your equipment. Any electronic device that contains an external entry point for plugging in anything from cables to docking stations is susceptible to entry of ESD. Devices that you carry with you, such as your Palm device, build up ESD in a unique way because the static electricity that may have built up on your body is automatically passed to the device. Then, when the device is connected to another device such as a docking station, a discharge event can occur.

Precautions against ESD Make sure to discharge any built-up static electricity from yourself and your electronic devices before touching an electronic device or connecting one device to another. The recommendation from Palm is that you take this precaution before connecting your Palm device to your computer, placing the device in a cradle, or connecting it to any other device. You can do this in many ways, including the following:

- Ground yourself when you’re holding your device by simultaneously touching a metal surface that is at earth ground. For example, if your computer has a metal case and is plugged into a standard three-prong grounded outlet, touching the case should discharge the ESD on your body.
- Increase the relative humidity of your environment.
- Install ESD-specific prevention items, such as grounding mats.

Conditions that enhance ESD occurrences Conditions that can contribute to the buildup of static electricity in the environment include the following:

- Low relative humidity.
- Material type (The type of material gathering the charge. For example, synthetics are more prone to static buildup than natural fibers like cotton.)
- The rapidity with which you touch, connect, or disconnect electronic devices.

While you should always take appropriate precautions to discharge static electricity, if you are in an environment where you notice ESD events, you may want to take extra precautions to protect your electronic equipment against ESD.
## Specifications

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| **Radio** | • CDMA 800 (Digital Cellular), 1900 (PCS), and 1400 (GPS)  
• EVDO and 1XRTT |
| **Phone features** | • Personal speakerphone  
• Hands-free headset jack (2.5mm, 3-barrel connector)  
• Microphone mute option  
• TTY compatible  
• 3-way calling |
| **Processor technology** | • Intel XScale™ processor, 312MHz |
| **Expansion** | • SD/MultiMediaCard/SDIO card slot |
| **Battery** | • Rechargeable Lithium Ion  
• Removable for replacement  
• Up to 4.7 hours talk time  
• Up to 15 days standby  
• 3.5 hours full charge time |
| **Operating system** | • Windows Mobile® Edition 5.2.2.0 (Phone Edition) |
| **Camera** | • Still image capture resolution: 1280 x 1024, 1.3 megapixel  
• Automatic light balance |
| **Size** | • 5.08 in. x 2.28 in. x 0.89 in. (129mm x 58mm x 22.5mm) with antenna |
| **Weight** | • 6.4 ounces (180 grams) |
| **Connectivity** | • Infrared (1.2 compliant)  
• Bluetooth® wireless technology (1.2 compliant) |
| Display                  | • Touch-sensitive LCD screen (includes stylus)  
|                         | • 65,536 colors (16-bit color)  
|                         | • User-adjustable brightness  
| Keyboard                | • Built-in QWERTY keyboard plus 5-way navigator  
|                         | • Backlight for low lighting conditions  
| Included software       | • Today/Phone (includes Speed Dial and Dial Pad)  
|                         | • Messaging (text, multimedia, and email)  
|                         | • Internet Explorer Mobile (web browser)  
|                         | • Camera  
|                         | • Pictures & Videos  
|                         | • Windows Media® Player Mobile  
|                         | • File Explorer  
|                         | • Contacts  
|                         | • Calendar  
|                         | • Tasks  
|                         | • Notes  
|                         | • Calculator  
|                         | • ActiveSync®  
|                         | • Excel® Mobile  
|                         | • Word Mobile  
|                         | • PowerPoint® Mobile  
|                         | • Pocket MSN  
|                         | • Solitaire  
|                         | • Bubble Breaker  
|                         | • Voice Command  
|                         | • Downloads application  
|                         | • Quick Tour  
|                         | • Search  
|                         | • Terminal Services  
|                         | • Picsel PDF Viewer  
|                         | • Cubis (available on the Getting Started CD)  
|                         | • Sprite Backup (available on the Getting Started CD)  

| System requirements          | • Windows 2000 or XP with USB port. Later versions may also be supported  
|                            | • Some wireless features require Microsoft 2003 Exchange Server with Service Pack 2 |
| Operating and storage temperature range | • 32°F to 104°F (0°C to 40°C)  
|                            | • 5% to 90% RH |
Index

SYMBOLS
! icon 9

NUMERICS
1xRTT technology 243
411 phone calls 33
5-way navigator 15, 17
911 phone calls 33, 56, 60, 200

A
A2DP technology 111, 243
abbreviated dialing 54–55
AC charger 7
accented characters 23
access points (Wi-Fi) 245
accessing
address books 82, 95
alternate characters 22
corporate networks 215
documentation 241
Excel spreadsheets 167
information 26
instant messages 102
media files 133
menu items 19, 20
secure networks 206
secure websites 237
shortcut menus 20
the Internet 214
voicemail 39
web pages 103, 105, 108, 236
Word documents 159
accessories 5, 247
accounts
See also email accounts
accessing Internet and 227
creating Pocket MSN 102
getting help with 241
preventing unauthorized use of 201, 206
requirements for 1
action keys 5, 18
activating items onscreen 17
active calls. See phone calls
ActiveSync
installing 64, 65, 219
restrictions for 236
setting options for 77
setting up Bluetooth devices for 113
sharing files and 184
starting 69
synchronizing with 63, 64, 68, 74
troubleshooting 229–233,
234, 235
ActiveSync icon 69, 70
ActiveSync Plug-in for Bluetooth 75
ActiveSync technology 243
Add Contact prompt 41
adding
a second call 42, 43
appointments 143, 145
attachments 95
bookmarks 105
caller ID pictures 141
contacts 41, 141
d expansion cards 184, 185
folders 164
My Text phrases 84
signatures 99
speed-dial buttons 46
tasks 149
untimed events 144–145
address books 230
See also online address books
addresses
contacts and 141
e mail and 17, 94, 96
messaging options for 100
multimedia messages 83
multiple recipients 82, 84
synchronizing 230
text messages 82
web sites 103, 107
adhoc connections 212
Advanced Audio Distribution
Profile (A2DP) technology 243
Agenda View (calendar) 143
alarm clock 205
alarm sounds 206
alarms
adding to events 145
adding to tasks 149
setting system 205–206
setting vibrating 52, 194
turning on or off 193
alert tones. See ringtones
alerts 232, 233
aligning the screen 195
alphabetical index 142
Alt key 243
alternate characters 23, 24
alternate phone numbers 34
animation 131, 166
Answer button 38
antenna 6, 248
appearance settings 194–
196
application buttons 197
applications
See also third-party
applications
accessing menus in 19, 20
adding to Start menu 196
closing 25, 208
copying 187
customizing 196–200
deleting 183
displaying 208
downloading 106, 181
getting help with 217, 241
included with smartphone
254
installing 180–183, 238
moving 187
opening 25, 186, 196
reinstalling 221
running 9, 41, 186, 240
switching 40, 208
synchronizing information
in 63, 65
troubleshooting 206, 224
turning off sounds for 193
viewing memory usage for
208
appointments
See also events
adding 143
deleting 147
entering multiple 144
marking as private 146
scheduling repeating 145
setting options for 148
setting reminders for 148
troubleshooting 232
viewing 143
area codes 142
arrow icons (navigator) 15
attachments
adding 95
downloading 97
embedded objects in 98
opening 97
receiving 97
saving 97, 101
sending files as 180, 184
sending sounds as 84, 194
sending videos or pictures
as 126
troubleshooting 235
audio 130, 243
audio files 131, 134
See also media files; music
Audio/Video Remote Control Profile (AVRCP) 243
authentication 212
Auto Sync 234
auto-completion options 198–200
Auto-Keyguard 200, 201
auto-lock settings 202
auto-off interval 243
AVRCP technology 111, 243
B
backgrounds 128, 191
backing up information 61, 221, 229
backlight (keyboard) 22, 209
Backspace key 21
backup and restore applications 71
backup utilities 219, 222
backups, restoring 222
battery charging 8–9
conserving 9, 209
disposing of 223
installing 7
removing 220, 223
replacing 223
viewing status of 59, 209
battery contacts 7
battery door release 6
battery icons 8, 59
beaming 114–115, 180, 184, 243
billing information 45
blank web pages 236
Bluetooth devices communicating with 109
compatibility with 109
connecting to 109–112
disconnecting from 114
discovering 113
entering passkeys for 111, 118
sending and receiving information over 112–113
synchronizing over 75–76, 113–114
troubleshooting 113, 228
turning on 110
viewing status of 112
working with 50
Bluetooth icon 60, 110, 112
Bluetooth Settings screen 110, 112
Bluetooth status indicator 60
Bluetooth technology 117, 119, 120
bookmarks 105
border highlight 17
brightness, adjusting 194
broadband technology 243
BroadbandAccess networks 227, 243
browsing files and folders 180, 188
browsing the web. See web browsing
built-in applications 183, 254
built-in camera. See camera
bulleted lists 163
burst mode 124
buttons activating menus and 19
assigning applications to 197
assigning media files to 136
assigning voice commands to 197
creating speed-dial 46
disabling 200
editing speed-dial 48
on 5-way navigator 15
opening applications and
reassigning 197
selecting or activating 17
turning off sounds for 193
Buttons Settings screen 197

calculations 154, 167, 170
Calculator 154–155
calculator buttons 155
Calculator icon 154
calendar
adding items to 143, 144, 145, 146
customizing 147–148
displaying 143
moving through 143
organizing events on 147
removing events 147
Calendar application 143–148
calendar icons 143
Calendar Options screen 147
calendar views 143
call forwarding 45
Call Log 36, 45
call waiting 43
caller ID applications 238
caller ID blocking 42
caller ID pictures 53, 141
calling plans 45
calls. See phone calls
camcorder icon 123
camera
adjusting contrast for 128
battery life and 9
capture resolution for 253
capturing videos with 124–125
changing resolution settings for 124, 125
taking pictures with 53, 123, 124
troubleshooting 237–238
turning on 123
Camera icon 123
camera lens 6
Camera Preview Mode 238
camera settings 129–130
capitalization 22, 199
Caps Lock 22
captions 84
car kits. See hands-free car kits
carrying cases 5
case-sensitive searching 175
certificates 109, 181, 206
changing
alarm sounds 206
connections 215
contact information 141
date and time settings 204
lock codes 202
speed-dial buttons 48
classic burn 6
character sets 108
characters
capitalizing 22, 199
entering 22
phone calls and 33, 47
setting input options for 198–200
text messages and 81, 82
typing alternate 23
charging
smartphone 7
the battery 8–9
charging status 8
charts 168, 174
chat rooms 241
check boxes 17
chronological phone lists 36
Clear Type setting 195
Clock & Alarms Settings screen 204, 205
closed networks 210, 211
<table>
<thead>
<tr>
<th>Topic</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>closing applications</td>
<td>25, 208</td>
</tr>
<tr>
<td>Internet Explorer Mobile</td>
<td>105</td>
</tr>
<tr>
<td>lists in fields</td>
<td>21</td>
</tr>
<tr>
<td>menus</td>
<td>19</td>
</tr>
<tr>
<td>screens</td>
<td>17</td>
</tr>
<tr>
<td>color settings</td>
<td>196, 238</td>
</tr>
<tr>
<td>color themes</td>
<td>191</td>
</tr>
<tr>
<td>command buttons</td>
<td>197</td>
</tr>
<tr>
<td>See also menus</td>
<td></td>
</tr>
<tr>
<td>company names</td>
<td>37</td>
</tr>
<tr>
<td>company phone lists</td>
<td>37, 142</td>
</tr>
<tr>
<td>completed tasks</td>
<td>150</td>
</tr>
<tr>
<td>components (smartphone)</td>
<td>1</td>
</tr>
<tr>
<td>compressed files</td>
<td>181</td>
</tr>
<tr>
<td>computers. See personal computers</td>
<td></td>
</tr>
<tr>
<td>Conference button</td>
<td>43</td>
</tr>
<tr>
<td>conference calls</td>
<td>43, 44</td>
</tr>
<tr>
<td>Confidential setting</td>
<td>146</td>
</tr>
<tr>
<td>configurations, restoring</td>
<td>221</td>
</tr>
<tr>
<td>Configure Network</td>
<td></td>
</tr>
<tr>
<td>Authentication screen</td>
<td>212, 213</td>
</tr>
<tr>
<td>Configure Wireless Network screen</td>
<td>212</td>
</tr>
<tr>
<td>configuring</td>
<td></td>
</tr>
<tr>
<td>email accounts</td>
<td>87, 92, 94</td>
</tr>
<tr>
<td>TTY devices</td>
<td>53</td>
</tr>
<tr>
<td>connecting to</td>
<td></td>
</tr>
<tr>
<td>Bluetooth devices</td>
<td>109–112</td>
</tr>
<tr>
<td>GPS devices</td>
<td>111</td>
</tr>
<tr>
<td>hands-free devices</td>
<td>111</td>
</tr>
<tr>
<td>headsets</td>
<td>111</td>
</tr>
<tr>
<td>personal computers</td>
<td>69</td>
</tr>
<tr>
<td>the Internet</td>
<td>214, 227</td>
</tr>
<tr>
<td>VPNs</td>
<td>215–216</td>
</tr>
<tr>
<td>Wi-Fi networks</td>
<td>210–214, 245</td>
</tr>
<tr>
<td>connection icons</td>
<td>227</td>
</tr>
<tr>
<td>connections</td>
<td></td>
</tr>
<tr>
<td>adding</td>
<td>214, 216</td>
</tr>
<tr>
<td>changing</td>
<td>215</td>
</tr>
<tr>
<td>checking status of</td>
<td>227</td>
</tr>
<tr>
<td>ending</td>
<td>216</td>
</tr>
<tr>
<td>losing</td>
<td>228</td>
</tr>
<tr>
<td>manually starting</td>
<td>214</td>
</tr>
<tr>
<td>precautions for</td>
<td>252</td>
</tr>
<tr>
<td>selecting wireless band settings for</td>
<td>56</td>
</tr>
<tr>
<td>sending email and</td>
<td>88</td>
</tr>
<tr>
<td>setting up</td>
<td>210–216</td>
</tr>
<tr>
<td>troubleshooting</td>
<td>226–229, 236</td>
</tr>
<tr>
<td>Connections Settings screen</td>
<td>214, 216</td>
</tr>
<tr>
<td>consumption (battery)</td>
<td>9</td>
</tr>
<tr>
<td>contacts</td>
<td></td>
</tr>
<tr>
<td>adding</td>
<td>41, 141</td>
</tr>
<tr>
<td>assigning ringtones to</td>
<td>53, 127, 141</td>
</tr>
<tr>
<td>changing information for</td>
<td>141</td>
</tr>
<tr>
<td>dialing alternate phone numbers for</td>
<td>34</td>
</tr>
<tr>
<td>entering multiple</td>
<td>141</td>
</tr>
<tr>
<td>linking speed-dial buttons to</td>
<td>46</td>
</tr>
<tr>
<td>looking up</td>
<td>96, 141, 142</td>
</tr>
<tr>
<td>removing</td>
<td>142</td>
</tr>
<tr>
<td>saving information for</td>
<td>41</td>
</tr>
<tr>
<td>selecting communication method for</td>
<td>35</td>
</tr>
<tr>
<td>sending meeting requests to</td>
<td>145</td>
</tr>
<tr>
<td>sending messages to</td>
<td>82, 83, 94, 95</td>
</tr>
<tr>
<td>setting messaging options for</td>
<td>100</td>
</tr>
<tr>
<td>transferring to car kits</td>
<td>51</td>
</tr>
<tr>
<td>viewing information about</td>
<td>35</td>
</tr>
<tr>
<td>Contacts application</td>
<td>141–143</td>
</tr>
<tr>
<td>Contacts list</td>
<td>142</td>
</tr>
</tbody>
</table>
INDEX

context-sensitive menus 19
cookies 108
copying
  addresses 230
  applications 187
  items in folders 180
  numbers 154
  phone numbers 37, 107
  pictures and videos 127
  text 107, 162
copyrighted items 127
corporate email accounts 87, 89, 215, 236
corporate networks 179, 206, 215
coverage areas 31, 226
creating
  appointments 143, 145
  bookmarks 105
  contacts 41
  document templates 161
  documents 160, 161
  email messages 94–95
  folders 164
  meeting requests 145, 146
  message templates 86
  multimedia messages 83, 84
  My Text phrases 84
  notes 151, 152
  playlists 134–135
  speed-dial buttons 46
  spreadsheet templates 169
  spreadsheets 167, 171
  tasks 149
  text messages 81, 82
  untimed events 144–145
  video ringtones 127
  workbooks 168, 169
  credentials 233
  cropping pictures 128
  currency symbols 195
customer support 241
customizing
  applications 196–200
  calendar 147–148
  camera 129–130
  Contacts application 142
  display settings 194–196
  Excel Mobile 176
  format settings 195
  Internet Explorer Mobile 107–109
  Media Player Mobile 135
  messages 100–101
  notes 153
  phone 51–58
  smartphone 189
system settings 204–210
tasks 151
Today screen 191–192
voicemail 47
Word Mobile 165
cutting. See deleting

D
daily schedules 143
data encryption 213
data entry 168, 171
data service icons 227
data services 1, 2, 57, 227
data transfers 243, 244
date formats 195
date separators 195
dates 171, 204
  See also calendar
Day View (calendar) 143
day-planner formats 143
decimal formats 195
decompression utility 181
default buttons 197
delays 227
Deleted Items folder 99, 101
deleting
  applications 183
certificates 206
contacts 142
cookies 108
documents 165
e-mail accounts 94
events 147
files 180
items from playlists 135
items in folders 180
messages 99, 100
notes 153
partnerships 112
pictures 128
sounds 52
speed-dial buttons 48
tasks 150
text 18
workbooks 176
worksheets 176
desktop software 244
See also software
Device Setup Wizard 132
devices
See also Bluetooth
deVICES; smartphone beaming to 114
cautions for storing 6
enabling TTY/TTD 53, 248
getting help with 241
identifying 212
setting up GPS 207
transferring information from 69, 219
troubleshooting 206, 228
unsafe areas for 249
device-to-device connections 212
diagnostic information 206
Dial Lookup list 11
Dial Pad 35, 36, 37
dial pad tones 53
dialing 33–35, 42, 46, 47, 54
dialing preferences 54–55
digit grouping symbols 195
dim images 225
Direct Push Technology 71, 87
directory services 100
discovery setting 113
Dismiss button 39
display. See screen
display settings 194–196
displaying alternate characters 23
animated images 131
available applications 25
calendar 143
events 144, 147
items in folders 164, 175
memory usage 208
multimedia messages 86
notifications 194
on-device documentation 241
personal information 204
pictures 126, 130
slide shows 126
tasks 150
videos 126, 130, 136
web pages 103–105, 107
Word documents 161
workbooks 167, 168, 169
document file types 159
document templates 161, 165
documentation 1, 241
documents See also Word Mobile
creating 160, 161
deleting 165
displaying 161
find and replace
operations in 161
formatting text in 162–163
moving or copying in 162
opening 161
organizing 164
saving 159, 161, 162, 165
setting margins for 163
spell-checking 164
documents list 165
down arrow in fields 20
downloading
applications 106, 181
attachments 97
email 73
files 106
images 106, 131
multimedia messages 85
ringtones 51, 106
videos 124
drafts 95
drawing 151
driving safety tips 250
dummy expansion card 185

E
earpiece 5
eBooks 9
echoes 240
editing. See changing
electronic devices 249, 252
electrostatic discharge 252
email
adding attachments to 95
addressing 94, 96, 141
checking status of 98
creating 94–95
dialing from 37
downloading 73
forwarding 98
getting from corporate
servers 215
receiving attachments
with 97
replying to 100
requirements for 1
saving attachments 97,
101
selecting addresses in 17
sending 95, 104
troubleshooting 234–236
email accounts
configuring multiple 94
deleting 94
selecting 94
setting up 87–94
synchronizing 92, 96
troubleshooting 233
email applications 237
email formats 96
email providers 235
e-mail services 1
embedded images 98
e-mailing phone calls 33,
56, 60, 200
Empty Deleted Items
command 99
encoding 108
encryption 109, 213
entering
passkeys 111, 118
error messages 193
error reporting 206
errors 206, 226, 233
EVDO connections 117
EVDO technology 244
event icons 148
events
categorizing 147
creating 144
customizing 194
deleting 147
marking as private 146
selecting sounds for 194
setting alarms for 145
setting reminders for 148
silencing sounds for 194
Evolution Data Optimized
(EVDO) technology 244
Excel 157, 167
See also Excel Mobile
Excel Mobile 167–176
Excel Mobile icon 168
Exchange ActiveSync 71, 88
Exchange Address Books 230
Exchange Server
  installing 88
  sending email and 87
  setting up accounts 88–90
  synchronizing with 64, 71–73, 74, 89, 90
  troubleshooting 229, 233, 236
  upgrading 87
expanding lists in fields 21
expansion card slot 6, 185
expansion cards
  freeing memory and 239, 240
  inserting 185
  installing applications on 182
  moving information to 187, 188
  opening items on 186
  purchasing 184, 185
  removing 185
  renaming 188
  searching on 179
  storing attachments on 97, 101
  storing documents on 164
  storing spreadsheets on 175
transferring media files to 131–132
  viewing available space on 187, 208
  viewing files on 180, 188
  extensions (phone) 47, 54
external power sources 209
Extra Digits button 47

F
factory-installed applications 183, 254
favorites (web pages) 105–106
features 1, 241
fields 16, 20
File Explorer 179, 180
File Explorer icon 180, 222
file lists 180
file names 161
file types 83, 131, 159
files 180, 184, 215
filtering
  contacts 142
  spreadsheets 168, 173
tasks 150
finding
  contacts 96, 141, 142
  information 27, 175, 179
  text 161
  firewalls 215, 229
First Synchronization dialog box 91
first-letter capitalization 22
Flash mode 44
folders
  accessing Outlook 230
  arranging pictures and videos in 127
  browsing 180, 188
  creating 164
  displaying contents 164, 175
  moving items to 175
  opening items in 180
  organizing web favorites in 106
  sorting contents 175, 180
fonts 163, 167, 172
forgetting passwords 202, 203
formatting
  information 195
  spreadsheet data 167,
  172–173
  text 162–163
forwarding
  messages 98
  phone calls 45
forwarding codes (phone) 45
freeing memory 183, 239
freeware 225
full charge (battery) 8
G
games 9
getting started 3
Getting Started CD 180, 219
Global Address Lists. See
  online address books
Global Address Lookup 179
Global Positioning System. See GPS
Glossary 243
GPS car kits 50
GPS devices 111
GPS receivers 207
H
hands-free car kits 49, 50, 51
hands-free devices 50, 109,
  111, 228, 252
hard resets 221–222
hardware 1
headset button 49
headset jack 5
headsets 49–50, 111, 228
hearing aids 249, 251
hearing disabilities 53
heat sources 10
help 217, 241
hiding
  appointments 146
  contact information 142
  events 146
  pictures 104
  speed-dial buttons 34
highlighting
  alternate characters 23
  items in folders 180
  items in lists 21
  items on screen 15, 17
  links 104
  menu items 19, 20
  text 17
high-speed data transfers
  243, 244
hints (passwords) 203
History list 107, 108
Hold Side button setting 197
home locations 204
home page 107
Hotmail accounts 87, 102
hotspots 245
I
image files 83, 130
images 98, 106, 237
  See also pictures
IMAP accounts 87, 92–94,
  97
Inbox 98
incorrect passwords 202
indicator light 5, 8, 31
information
  accessing 26
  backing up 61, 221, 229
  entering 22, 168, 171,
  199
  formatting 195
  losing 221
  organizing 139, 177
  protecting 200, 206
  restoring 221, 222
  saving 186
  searching for 27, 161,
  175, 179
  sharing 183–184
sorting 173
storing 184
synchronizing 64, 77
transferring 61, 187, 219
updating 61, 63
infrared port. See IR port
infrared transmissions 115, 244
input options 198–200
Input Settings screen 198
installations, troubleshooting 221, 238
installing
ActiveSync 64, 65, 219
applications 180–183, 238
desktop software 219, 220
Exchange Server 88
synchronization software 68
VPN clients 215
instant messages 81, 102
instant messaging applications 238
interference 110, 247, 249
international dialing prefix 54
Internet Connection Speed setting 136
Internet connections
closing 216
opening 214
phone calls and 117
setting up 214
troubleshooting 227, 236
Internet email accounts 92, 97
Internet Explorer Mobile
closing 105
customizing 107–109
installing applications and 181
starting 103
troubleshooting 236, 237
viewing web pages and 103
Internet service provider. See ISPs
interruptions 226
IR port 6, 76, 114, 244
ISP settings 214–215
ISPs 87, 235
items
highlighting 15, 17
opening shortcut menus for 20
selecting or activating 17, 21
K
key combinations 197
keyboard
accessing alternate characters on 22
dialing from 33
displaying alternate characters list for 23
entering text from 22–23
locking 200
pressing keys on 22
scrolling with 16
selecting menu items from 19
keyboard backlight 22, 209
Keyguard 200
L
LANs 215
leading zeros 195
LED 5, 8, 31
Legacy Pocket Word 160
libraries (media) 133–134
Library list 132
Library screen 132, 133, 136
lightening bolt 8
Li-Ion battery 244
See also battery
accessing media files and
accessing web pages and
activating
selecting
sending
troubleshooting
list separators
Listen button
Listen to music
lists
closing
creating
highlighting items
scrolling through
selecting items in
selecting options on
loading media files
local area networks
locating
contacts
information
text
Location Privacy icon
Location Privacy setting
location-specific information
lock codes
Lock icon
locking
smartphone
spreadsheet rows and
columns
the keyboard
logging in to
corporate servers
looking up contacts
losing
connections
information
passwords
Treo smartphone
low coverage areas
low lighting conditions
lowercase letters
magnet
magnification. See zooming
MAPI clients
maps
measurement units
media file formats
media files
accessing
playing
troubleshooting
media libraries
Media Player
Media Player Mobile
media players
medical devices
meeting requests
entering addresses for
receiving
sending
setting sensitivity options
for
memory
freeing
viewing usage
memory buttons
Memory Settings screen
memos. See notes; voice
notes
Menu button
menu items, selecting
menus
Menus Settings screen
messages
See also notifications;
voice commands
adding contacts and
adding signatures 99
addressing 82, 83
checking status of 98
customizing 100–101
deleting 99, 100
dialing from 37
entering invalid characters in 82
forwarding 98
receiving notifications for 85
saving as drafts 95
selecting links in 98
selecting multiple 99
sending 79, 81
sorting 98
spell-checking 82, 95
troubleshooting 235
Messaging and Security Feature Pack (MSFP) 87
Messaging application 81–101
messaging applications 238
Messaging icon 81
Messaging Options screen 100
messaging services 1, 227
messaging systems 244, 245
microphone 5, 40, 130
microphone icon 198
Microsoft applications. See specific application
microwaves 110
mirror 6, 125
MMS messaging 81, 244
mobile accounts. See accounts
Mobile Device folder 69, 182
Mobile Favorites folder 63
mobile networks 31, 226
See also network connections
Mobile to Market certificates 181
Modem Link application 116
Modem Link icon 116
modems 116–120
Month View (calendar) 143
most recently dialed numbers list 36
moving
pictures and videos 127
speed-dial buttons 48
workbooks 175
moving around the screen 15–16
MSFP (Messaging and Security Feature Pack) 87
MSN Hotmail 87, 102
MSN Messenger 102
multi-connector 5
multimedia file types 83
multimedia messages
adding items to 84
addressing 83
attaching files to 126
creating 83, 84
customizing 101
displaying 86
downloading 85
phone numbers in 37
playing 86
previewing 84
receiving 85
requirements for 2
saving 86
sending 83, 85
troubleshooting 227
Multimedia Messaging System. See MMS messaging
MultiMediaCard cards 184
multiple recipients 82, 84
music
adjusting volume 52, 133
creating playlists for 134–135
pausing 132, 133, 136
playing 132, 133, 136
receiving phone calls and 38
repeating current song 133
music files 131, 134
See also media files
mute icon 40
My Device folder 180
My Device library 133
My Documents folder 179
My Mobile Devices folder 244
My Pictures folder 123, 125
My Playlists category 134
My Storage Card library 133
My Text phrases 81, 82, 84, 95

N
naming
document files 161
folders 164
groups of pictures 130
speed-dial buttons 46

INDEX

spreadsheet templates 169
workbooks 169, 175
worksheets 172
NationalAccess networks 227
NationalAccess technology 244
navigating the screen 15–16
navigator. See 5-way navigator
negative numbers 195
Network Cards icon 212
network connections
opening 31
setting up 211, 215
troubleshooting 226–229
network keys 213
Network Preferences screen 57
notes
See also voice notes
adding templates for 152
creating 151, 152
customizing 153
deleting 153
saving 153
Notes application 151–154
Notes icon 151
Notes list 153
notification options 85
notification screens. See notifications
notifications
customizing 194
muting 192, 193
receiving information and 113
receiving messages and 39, 85
selecting ringtones for 51
troubleshooting 228
turning off 194
Now Playing screen 134, 135
number pad 33
number sign symbol 195
numbered lists 163
numbers
copying 154
entering 22, 171
formatting 172, 195

O
Office 157, 159
offline synchronization 230
OK button 5
online address books 82, 95–96, 101, 142
online forums 241
online support 241
open networks 210, 211
opening
  alternate characters list 23
  applications 25, 186, 196
  attachments 97
Calculator 154
Dial Pad 36
drafts 95
File Explorer 180, 222
Help screen 241
items in folders 180
media files 132
Quick Tour 241
shortcut menus 20
spreadsheet templates 169
  spreadsheets 167
Today screen 26
Word documents 161
operating system 245, 253
Option button 16, 244
Option key 5, 21, 23
Option Lock 23
options 19, 20, 147
organizer features 9
OTA synchronization 149
Outbox 95, 98

Outlook
  changing information in 92
  copying addresses from 230
  downloading from 97
  entering information in 63, 141, 144
  sending attachments from 184
  setting up clients for 235
  synchronizing with 71, 219
  troubleshooting 230
  upgrading Exchange Server for 88
overdue tasks 150
owner information 203
Owner Information screen 204

P
pacemakers 249
pairing 110
Palm OS applications 181
Palm OS devices 69, 219
partial battery icon 8
partnerships 110, 112, 113
passkeys 111, 118, 119
Passport (IM) accounts 102
Password Settings screen 202
passwords
  corporate email accounts and 73
  disabling 198
  entering 202
  forgetting 202
  locking smartphone and 200, 202
  losing 202, 203
  opening spreadsheets and 167
  retrieving voicemail and 39
  saving 89, 93
  setting up email accounts and 89, 91, 93
  pausing media files 132, 133, 136

PCs. See personal computers
performance 211, 224, 238
Personal Address Books 230
personal computers
  connecting to 69
  installing from 182
  synchronizing with 67–70, 77
transferring media files from 131–132
personal information 203
See also information
personal information manager. See PIM applications
personalizing smartphone. See customizing phone
See also phone calls;
phone numbers
adjusting volume 11, 52
answering 38, 43
customizing 51–58
defining speed-dial buttons for 45–48
downloading ringtones for 51, 106
enabling as modem 116–120
getting forwarding codes for 45
hanging up 41, 43, 44
monitoring status 58–60
overview 29, 32, 40
previewing ringtones 52
running applications and 40, 41
silencing ringer for 38, 192
troubleshooting 226, 228
turning on or off 11, 31
viewing minutes usage for 45
waking up screen for 41
phone calls
See also phone numbers
adding a second 42, 43
ending 11, 41, 43, 44
entering extra digits for 47
forwarding 45
making 32–37
managing 44
placing on hold 40
receiving 38
selecting ringtones for 51–52
sending to voicemail 38
transferring 50
viewing information about 40, 45
phone contacts 7
Phone dialog box 37
phone headsets 49–50
phone icons 58
Phone Lock 200, 201
phone numbers
See also phone; phone calls
adding contacts and 41, 42, 141
adding prefixes to 54
assigning to speed-dial buttons 46
checking 11
copying 37, 107
dialing 33–35, 42, 46, 47, 54
entering manually 35
redialing most recent 36
saving 41–42
selecting 17
Phone Off indicator 59, 244
phone services 1
Phone Settings screen 11, 53, 54, 55, 56, 201
Phone/Send button 5, 11, 245
phone-off icon 31
phone-to-computer connections 69, 119
photo albums 126
picture files 83
picture formats 123, 130
picture resolution 123, 124
picture speed-dial buttons 45, 46
pictures
  adding voice captions to 84
  as backgrounds 128, 191
  as screensavers 129
  assigning to contacts 53
  creating caller ID 141
  deleting 128
  editing 128
  hiding 104
  naming groups of 130
  organizing 127
  previewing 124, 238
  saving 130
  sending 84, 126–127
  setting default size 130
  taking 123–124, 237
  viewing 126, 130
Pictures & Videos application 50, 123–131
PIM applications 219, 245
Play button 132
Play Sound list 206
playback icons 132
Playback screen 135
playing
  media files 132–133, 136
multimedia messages 86
PowerPoint presentations 165–166
videos 124, 125
voice notes 152
voicemail messages 39
playlist files 131
playlists 133, 134–135
Pocket MSN application 102
POP accounts 87, 92–94
portable radio. See radio ports. See IR port; USB ports
Power Settings screen 209
Power/End button 5
PowerPoint 157
PowerPoint Mobile 165–166
PowerPoint Mobile icon 165
predefined passkeys 111, 118
preferences 221
presentation modules 165
presentations 165
  See also PowerPoint Mobile
preset passkeys 111, 118
previewing
  multimedia messages 84
  multimedia messages 86
pictures 124, 238
sounds 52, 194
priority levels (tasks) 149
priority settings (messages) 95
privacy settings 55
processor 253
Programs menu 197
Programs screen 25
programs. See applications; software
protecting
  expansion card slot 185
  information 200, 206
  smartphone 200–204
proxy servers 216
punctuation marks 22
push technology 71, 87
Q
Quick Keys 34, 46
Quick Tour 241
QuickTime Player 124
R
radio 249
radio frequency emissions 247, 249
RAS connections 214
receiving
  attachments 97
  beamed information 115
  email messages 96
  meeting requests 98
  multimedia messages 85
  text messages 81, 85
Receiving Data message 115
recording
  ring tones 52
  videos 124–125
  voice commands 199
  voice notes 151–152
recording toolbar 152
records 114
recurring appointments. See repeating appointments
recurring tasks. See repeating tasks
redialing 36
redirector (websites) 236
regional settings 195, 204
Regional Settings screen 195
reminders
  events and 145, 148
  system alarms and 205
  tasks and 149, 151
  turning on or off 193
remote access servers 214
Remove Programs screen 183
removing. See deleting
Rename/Move command 187
renaming
  expansion cards 188
  items in folders 180
  workbooks 175
  worksheets 173
repeating appointments 145
repeating sounds 194
repeating tasks 149
replacing
  information 175
  text 161
reset button 220
resetting smartphone 220–222, 226
resizing text 104, 194
resolution settings 123, 124, 125, 225
restoring information 222
Return key 21
reverse type 17
right-click menus 19
ringer, silencing 38
Ringer switch 6, 192
ringer volume 52
ringtone files 83
ringtone IDs 53
ringtone managers 238
ring tones
  assigning to contacts 53, 127, 141
  creating video 127
  downloading 51, 106
  previewing 52
  selecting 51–52
  silencing 192
roaming 74, 232
roaming icon 57
roaming preferences 57–58
rotating pictures 128, 129
Running Programs screen 26
S
Save to list 186
saving
  attachments 97, 101
  information 186
  multimedia messages 86
  notes 153
  passwords 89, 93
  phone numbers 41–42
  pictures and videos 130
  ringtones 127
  voice commands 199
Word documents 159, 161, 162, 165
workbooks 167, 169, 176
Schedule screen 74
scheduled syncs 232
schedules. See calendar scheduling synchronization 74–75
screen
activating items on 17
adjusting brightness 194
adjusting display interval for 32
aligning 195
caring for 5
customizing 194–196
disabling touch-sensitivity features for 200–201
displaying personal information on 204
moving around on 15–16
selecting items on 17
selecting themes for 196
setting auto-scroll option for 200
troubleshooting 225
turning on or off 31, 32, 209
waking up 31–32, 41
screen resolution 225
screens, returning to previous 17
screensavers 129
scroll arrows 16
scroll bar 16
scrolling 15, 104, 147, 200
SD cards 184
SDHC cards 184
SDIO expansion cards 185
SDIO presentation modules 165
SDIO Wi-Fi cards 247, 248
Search for list 179
Search icon 179
Search screen 179
searching
   spreadsheets 175
   web pages 27, 105
   Word documents 161
searching for files 179
searching for information 27, 161, 175, 179
searching for signal 10
secure connections 88
secure websites 237
security features 109, 200, 206
self-portrait mirror 6, 125
sending
   email 95, 104
   meeting requests 145, 148
   multimedia messages 83, 85
   pictures 84, 126–127
   ringtones 52
   text messages 38, 43, 81
   videos 84, 126–127
Sent folder 95, 100
service contracts 1
service packs 87
sharing information 183–184
Shift key 21
Short Messaging Service. See SMS messaging
shortcut icons 25
shortcut menus 19
Show list 126, 127
side button 5, 197
signal, searching for 10
signal strength 58, 226
signal-strength icon 31, 210
signatures 99
silencing ringer 38
silent alarm 52, 192, 194
single carrier (1x) radio transmissions 243
sketching 151
skins 136
slide show icons 126
slide show toolbar 126
slide shows 126, 129, 165
slider 16
slides 84, 126, 166
smartphone
cautions for resetting 221
cautions for storing 6
charging 7
compatibility with third-party applications 219, 225, 239
components of 1, 5–6
connecting to PCs 69
disposing of 250
features of 1, 241
freeing space on 183, 239, 239–240
getting help with 217, 241
locking 200–203
losing 71, 203
low light and 22
not responding 220
operating 13, 247, 249
personalizing 189
required items for 2
resetting 220–222, 226
specifications for 253
transferring information to 219
troubleshooting 217
turning on or off 31, 249
unlocking 202
SMS list view 85
SMS messaging 81, 245
SMTP servers 235
soft resets 7, 220, 221
software
See also applications included with smartphone 1, 254
installing 219, 220
losing 221
purchasing 225
sorting
folder items 175, 180
information 173
messages 98
notes 153
pictures and videos 128
tasks 150
sound clips 83
sound settings 31, 38, 51, 192, 193
sounds
changing alarm 206
deleting 52
previewing 52, 194
recording 194
selecting 193
sending 84, 194
turning on or off 192, 193, 194
Sounds & Notifications screen 51, 193, 194
speaker 6, 131
speakerphone 40, 249
speakerphone icon 40
special characters. See alternate characters
specifications 253
Speed Dial Options command 48
speed-dial buttons 33, 45–48
spell-checking 82, 95
spreadsheet templates 167, 169, 176
spreadsheets
See also Excel Mobile; workbooks
adding charts to 168, 174
calculating data in 167, 170
comparing data in 174
creating 167, 171
entering data in 168, 171
filtering data in 168, 173
formatting data in 167, 172–173
opening 167
searching 175
sorting in 173
SSIDs 245
Start button 5, 25
Start menu 25, 196, 197, 245
starting
ActiveSync 69
Calendar application 143
Contacts application 141
Excel Mobile 168
Internet Explorer Mobile 103
Media Player Mobile 132, 137
Messaging application 81, 94
Notes application 151, 154
Pictures & Videos application 50, 123
Pocket MSN 102
PowerPoint Mobile 165
Quick Tour 241
Tasks application 149
Word Mobile 160
static 252
status icons 58, 98
stereo adapters 131
stereo headphones 131
stereo headsets 111
stopping synchronization 78
Storage Card screen 187, 188
storage card symbol 180
storing
information 184
smartphone 6
streaming 243
stylus 6, 18
support 241
symbols 22, 47, 168
sync cable 67, 69, 70, 230
sync conflicts 73, 89
synchronization
email accounts 92, 96
hard resets and 221
installing ActiveSync for 219
media files 131
Office files 159
offline 230
over Bluetooth connections 75–76, 113–114
over infrared connections 115
over IR ports 76
overview 61, 63
performing manual 75
personal computers and 67–70, 77
restoring information and 221
scheduling 74–75, 90
stopping 78
tasks 149
troubleshooting 220, 229–233, 234, 235
web files 108
wireless 64, 71, 72, 75, 76
with sync cable 70
with third-party applications 67, 219, 221
synchronization alerts 232, 233
synchronization options 63, 77
opening 26
restoring 233
Today Settings screen 191
Today timeout setting 191
tones. See ringtones; sounds
touchscreen. See screen
touchscreen lockout 200,
201
touch-sensitive options 200
transparency levels 128
Treo smartphone. See
touchscreen
Treo700wx Verizon web
page 241
troubleshooting 217, 241
TTY devices 53, 248
TTY/TDD settings 53
turning smartphone on or off
31, 249

U
unauthorized users 201, 206
unavailable time slots 146
unlocking smartphone 202
unread messages 98
unretrieved voicemail 39
unsafe areas 249
untimed events 144–145
updating information 61, 63

V
vCal attachments 235
vCard attachments 235
Verizon Wireless accounts.
See accounts
Verizon Wireless Customer
Care 241
vibrating alarm 52, 192, 194
video albums 126
video files 83, 131, 134
video formats 123, 131
video options 130, 136
video resolution 123, 125
video ringtones 127
videos
adding sounds to 84, 130
adjusting volume for 52
downloading 124
organizing 127
playing 124, 125
recording 124–125
saving 130
sending 84, 126–127
viewing 126, 130, 136
viewing
alternate characters 23
animated images 131
available applications 25
calendar 143
events 144, 147
items in folders 164, 175
memory usage 208
multimedia messages 86
notifications 194
on-device documentation
241
personal information 204
pictures 126, 130
slide shows 126
tasks 150
videos 126, 130, 136
web pages 103–105, 107
Word documents 161
workbooks 167, 168, 169
virtual private networks. See
VPNs
voice captions 84
Voice Command Settings
screen 197
voice commands 197–198, 199
voice mail buttons 47
voice notes 151–152
Voice Privacy setting 55
voice quality 240
voice recording formats 199
voicemail
  customizing 47
  listening to 39
  retrieving 39
  sending calls to 38, 43
  setting ringtones for 52
  setting up 39
  troubleshooting 53
  viewing minutes usage for 45
voicemail icon 39, 40
voicemail playback controls 47
Volume button 5, 52
volume, adjusting 11, 52, 133, 193
VP icon 60
VPN applications 88
VPN connections 97, 215–216
VPNs 215, 229
VZAccess application 117
W
  waking up the screen 31–32, 41
  warnings 193
  warranty 2
web addresses 103, 107
  See also links
web browser. See Internet Explorer Mobile
web browsing 79, 103, 105, 109
web forms 105
web links. See links
web pages
  accessing 103, 105, 108, 236
  bookmarking 105
  copying from 107
dialing from 37
display options for 103
downloading from 106, 181
  enlarging images on 237
playing media files from 132, 133, 136
refreshing 104
returning to recently viewed 105, 107
searching 27, 105
setting as home 107
troubleshooting 236, 237
viewing 103–105, 107
Web search field 27
web services 1
websites 236, 237
Week View (calendar) 143, 148
Wi-Fi access points 245
Wi-Fi cards 210, 214, 226, 247, 248
Wi-Fi connections
  setting up 210–214
  turning off 211
Wi-Fi icon 212
Wi-Fi networks 213, 245
Wi-Fi routers 110
Windows Mobile 181, 245
Windows Mobile devices 69, 219
Windows Mobile website 219
wireless band setting 56
wireless features 9, 209
Wireless Manager screen 209
wireless modem
connections 116–120
wireless networks 210, 227
wireless phones 110
Wireless Sync accounts 87, 91–92
wireless synchronization 64, 71, 72, 75, 76, 92
wireless transmitters 248
WLANs. See wireless networks
Word 157
   See also Word Mobile
Word Completion screen 199
Word Mobile 159–165
Word Mobile icon 160
word-processing features 160
workbook list 169, 176
workbooks
   See also spreadsheets
accessing 167
adding worksheets to 172
changing order of worksheets in 172
creating 168, 169
deleting 176
display options for 169
displaying 167, 168, 169
entering defined names in 172
entering formulas and functions in 170–171
moving around in 170
naming 169, 175
organizing 175
removing cells, rows, or columns in 176
replacing data in 175
resizing columns and rows in 172
saving 167, 169, 176
setting default template for 176
viewing formulas and functions in 167, 168, 176
worksheet list 170
worksheets. See spreadsheets; workbooks
WPA connections 213
WPA-PSK connections 213
Y
Year View (calendar) 143
Z
ZIP files 181
zoom icons 124
zooming 124, 199